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Before you start

Thank you for purchasing Pinnacle Studio. We
hope you enjoy using the software.

This manual covers all versions of Studio,
including Studio Plus. Differences between
versions will be noted as applicable. Most of the
time, the word “Studio” will be used generically to
refer to all versions.

If you have not used Studio before, we recommend
that you keep the manual handy for reference even
if you don’t actually read it all the way through.

In order to ensure that your Studio experience gets
off on the right foot, please review the three topics
below before continuing to Chapter 1: Using
Studio.

Also highly recommended to new users is the
Studio Tutorial. To launch the Tutorial, click its
link on the “splash” screen when you start Studio,
or use the Help » Guided Tour menu command
within the application itself.
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Equipment requirements

In addition to your Studio software, an efficient Studio
editing system requires certain levels of hardware
performance as noted in this section. Remember too
that while specifications are important, they do not tell
the whole story: the proper functioning of hardware
devices can also depend on manufacturer-supplied
driver software. Checking the maker’s web-site for
driver updates and support information can often be
helpful in solving problems with graphics cards, sound
cards and other devices.

Note: Some features mentioned here require free or
paid “activation” via the Internet, depending on your
version of Studio.

Computer

e Intel Pentium or AMD Athlon 1.4 GHz or higher
(2.4 GHz or higher recommended). Intel Pentium HT
or AMD Athlon 2.4 GHz or 1.6 GHz Dual core
required for Windows Vista.

e 512 MB of RAM (1 GB recommended). 1 GB
required for HD and/or Vista (2 GB recommended).
1.5 GB required for AVCHD (2 GB required on
Vista).

e Windows XP with SP2, or Vista.

e DirectX 9 or higher compatible graphics card with
64 MB (128 MB recommended); 128 MB required
for use with Vitascene filters; 128 MB required for
Vista (256 MB ATI Radeon 9600+ or NVIDIA
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GeForce 6 recommended); 256 MB required for HD
and AVCHD editing (ATl Radeon 9600+ or
NVIDIA GeForce 6 recommended).

e DirectX 9 or higher or compatible sound card.

e 1 GB of disk space to install software and 3+ GB to
install bonus content.

e DVD-ROM drive to install software.

The following items are optional:
e CD-R(W) burner for creating VideoCDs (VCDs) or
Super VideoCDs (SVCDs).

e DVD-/+R(W) burner for creating DVD, HD DVD
and AVCHD discs.

e Blu-ray burner for creating Blu-ray discs (BDs).

e Sound card with surround-sound output for preview
of surround-sound mixes.

A microphone, if you want to record voice-overs

The hard drive

Your hard drive must be capable of sustained reading
and writing at 4 MB/sec. Most drives are capable of
this. The first time you capture, Studio will test your
drive to make sure it is fast enough. Video in the DV
format occupies 3.6 MB of hard drive space per
second, so just four and a half minutes of DV video
will consume a full gigabyte on the drive.

Tip: We recommend using a separate hard drive
dedicated to video capture. This avoids competition
between Studio and other software, including
Windows, for use of the drive during capture.
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Video capture hardware

Studio can capture video from a variety of digital and
analog sources. Please see “Capture hardware” on page
23.

Video output hardware
Studio can output video to:

e Any HDV, DV or Digital8 camcorder or VCR. This
requires an OHCI-compliant IEEE-1394 (FireWire)
port (as provided by Pinnacle Studio DV). The
camcorder must be set up to record from DV Input.

e Any analog (8mm, Hi8, VHS, SVHS, VHS-C or
SVHS-C) camcorder or VCR. This requires Pinnacle
Studio USB-700, PCI-500, PCI-700, or another
Pinnacle device with analog outputs. Output to
analog camcorders or VCRs is also possible using a
Pinnacle Studio DV or other OHCI-compliant 1394
port if your DV or Digital8 camcorder or VCR can
pass a DV signal through to its analog outputs (see
your camcorder manual and Chapter 15: Making
your movie, for more information).

]
Abbreviations and conventions

This guide uses the following conventions to help
organize the material.

Terminology

Studio: “Studio” and “Studio Plus” refer to the editing
software.

DV: The term “DV” refers to DV and Digital8
camcorders, VCRs and tapes.
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HDV: A *“high-definition video” format that allows
video in frame sizes of 1280x720 or 1440x1080 to be
recorded in MPEG-2 format on DV media.

1394: The term “1394” refers to OHCI-compliant
IEEE-1394, FireWire, DV or i.LINK interfaces, ports
and cables.

Analog: The term *“analog” refers to 8mm, Hi8, VHS,
SVHS, VHS-C or SVHS-C camcorders, VCRs and
tapes, and to Composite/RCA and S-Video cables and
connectors.

Buttons, menus, dialog boxes and windows

Names of buttons, menus and related items are written
in italics to distinguish them from the surrounding text,
whereas window and dialog names are written with
initial capital letters. For example:

Click the Edit menu button to open your menu in the
Title Editor.

Choosing menu commands

The right arrowhead symbol (>) denotes the path for
hierarchical menu items. For example:

Select Toolbox » Generate Background Music.

Keyboard conventions

Key names are spelled with an initial capital and are
underlined. A plus sign denotes a key combination. For
example:

Press Ctrl+A to select all the clips on the Timeline.

Mouse clicks

When a mouse click is required, the default is always a
left-click unless otherwise specified:

Right-click and select Go to Title/Menu Editor.
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On-line help

Two kinds of immediate help are always available
while you are working in Studio:

o Help file: Click the help button [? in the Studio
main menu bar, or select the Help > Help topics
menu, or press F1 to open Studio’s help file.

e Tool tips: To find out what a button or other Studio
control does, pause your mouse pointer over it. A
“tool tip” appears explaining its function.

Xvi Pinnacle Studio



CHAPTER 1:

Using Studio

Creating movies with Studio is a three-step process:

1. Capture: Import source video material — your “raw
footage” — to your PC hard drive. Possible sources
include analog videotape (8mm, VHS etc.), digital
videotape (HDV, DV, Digital8), and live video from a
video camera, camcorder or webcam.

Capture mode is covered in Chapter 2: Capturing
video.

Availability: HDV capture is supported in Studio Plus only.

2. Edit: Arrange your video material as desired by
reordering scenes and discarding unwanted footage.
Add visuals, such as transitions, titles and graphics, and
supplementary audio, such as sound effects and
background music. For DVD and VCD authoring,
create interactive menus that give your audience a
customized viewing experience.

Edit mode is the arena for most of your work in Studio.
See “Edit mode” later in this chapter (page 4) for a
fuller introduction.

3. Make movie: When your project is complete,
generate a finished movie in your choice of format and

Chapter 1: Using Studio 1



storage medium: tape, VCD, S-VCD, DVD, AVI,
MPEG, RealVideo or Windows Media.

Make Movie mode is covered in Chapter 15: Making
your movie.

Setting the mode

Select which step of the movie-making process you
want to work on by clicking one of the three mode
buttons at the top left of the Studio window:

towe |i— oo |

When you switch modes, the Studio screen changes to
display the controls needed for the new mode.

Undo, Redo, Help, Support and Premium

The Undo, Redo, Help, y D C @
Support and  Premium =i s )
buttons are always to be found in the top right corner
of the Studio window, no matter which of the three
modes you are currently working in.

e Undo allows you to back out of any changes you
have made to your project during the current session,
one step at a time.

e Redo reinstates the changes one by one if you undo
too far.

e The Help button launches Studio’s built-in help
system.

e The Support button opens Studio’s technical support
site in your web browser.
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e The Premium button lets you expand Studio by
purchasing and installing premium content. (See
page 11 for details.)

All other controls on the Studio screen are dedicated
to tasks within the current mode.

Setting options

Most options in Studio are set using two tabbed dialog
boxes.

The first lets you control options related to Capture
mode and Edit mode. It has four tabs:

Pinnacle Studio Plus Setup Options

| Capture source ] Capture fomat ] Project preferences ] Video and audio preferences ] —‘

The other dialog box is concerned with options relating
to Make Movie mode. It has three tabs, one for each of
the three movie output types:

Pinnacle Studio Plus Setup Options

Make Disc | Make File | Make Tape| . |

Each panel of both dialog boxes can be opened
individually with a corresponding command on the
Setup menu (e.g. Setup » Capture Source). Once either
dialog box is open, however, all of its panels are
available through the tabs.

For simplicity, we generally refer to the different
options panels independently, as in “the Capture source
options panel”.

Detailed explanations of the options in both dialog
boxes are contained in Appendix A: Setup Options.

Chapter 1: Using Studio 3
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¢ EDIT MODE

Studio opens in Edit mode each time it is launched,
because that is the mode you use most often. The Edit
mode display includes three main areas.

The Album stores resources you will use in your
movies, including your captured video scenes.

The Movie Window is where you create your edited
movie by arranging video and sound clips, and by
applying transitions and effects.

The Player provides playback and previewing for
whichever item is currently selected in Studio. That
may be an Album resource — such as a video scene, title
or sound effect — or your edited movie, complete with
transitions, titles, effects and several audio tracks. The
Player is covered below.

See Chapter 3: The Album and Chapter 4: The Movie
Window for detailed information on those topics.

a!\II:lum_| Movie Window

=3

Mﬂﬂm

Player

A

‘ GQQEAEEEE
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The Player

The Player displays a preview of your edited movie, or
of the item currently selected in the Album.

It consists of two main areas: a preview window and
playback controls. The preview window displays video
images. The playback controls allow you to play the
video, or go to an exact position within it. These
controls come in two formats: standard and DVD.

Standard mode

The standard playback controls are similar to those on a
camcorder or VCR. They are used for viewing ordinary

video.
B c
i 85
i 22
Preview | I =
window arir i
wn
[
25
0 =
a5
o O
= ° o
Transport ——————. ' Cno015 10 -‘) T
f PRI - o
controls ‘-:)”f) olw i 8
\ ¥ ) |
[
| >
[
Master volume and mute
DVD mode

The DVD playback controls emulate the navigation
controls on a DVD player or remote control. Use them
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for previewing your DVD, VCD or S-VCD disc
productions, including menu interaction.

|l =

o2

. =

=

. s
Preview L
window = il
=
o
=
=
0
A
Transport : -
controls 8
[a)
>
fa)

Disc navigation controls

The preview window

This is a point of focus in Studio because you use it so
often, especially for previewing your movie. It can also
be used to display:

Any type of Album content.
Still images or titles from your movie.

Changes to video effects in real time while you
adjust the parameter controls for the effects.

Still frames from your video.

While viewing a still frame, you can step by as little
as a single frame in either direction with the *“jog”
controls.

Resizing the video preview

If your screen dimensions permit, Studio lets you
enlarge the Player — and therefore the video preview —
by means of the Player size slider. This control appears
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above the Player to the left of the Undo button when
reorganizing the display is possible.

Y

>

Drag the control knob rightwards to increase the Player
size, or leftwards to decrease it. The leftmost knob
position corresponds to the smallest size, which is also
the default.

TR
T N e
L NP oW B
- sl TV

Resizing the Player optimizes your use of screen “real
estate” to obtain a larger video preview.

The DVD toggle button

Switch between the two playback modes with
the DVD toggle button at the bottom right-hand
corner of the Player. This button is only available when
your edited movie contains at least one menu.

|
Playback controls

The Player presents either of two sets of playback
controls depending on the playback mode you choose.

When you play your movie back as ordinary video, you
will be using the standard playback controls. If your
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movie uses disc menu navigation, you can play it back
as an optical disc with interactive on-screen menus by
using the DVD playback controls. Both groups of
controls are covered below.

The full-screen preview button: This button, just
above the top right-hand corner of the preview window,
switches to a full-screen preview. It is available in both
playback modes. On a single-monitor system, the full-
screen display ends when your movie ends, or you
double-click the screen or press the Esc key. See the
Video preview options in the Video and Audio
Preferences panel (page 294) for settings that apply to
multiple-monitor systems.

The Video preview options on the Video and audio
preferences options panel let you direct the full-screen
preview to the secondary monitor on your system if
there is one. In Studio Plus, you can simultaneously
send your preview to an external device, if desired.

Standard playback controls

These buttons control playback in the Player.

Play / Pause: The Play button previews the
movie from the current position. Once preview /
begins, Play becomes Pause. When playback

is paused, the Album scene or Movie Window @
clip at which previewing stopped remains
selected. The [Space] key can also be used to start and
stop playback.

Go to beginning: This button halts playback and (i)
skips back to the first frame of the material being —
previewed.

Fast reverse, Fast forward: These buttons let [*4)
you preview your movie at two, four or ten times
the normal speed, in either direction. Use them to

| 4
-
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scan for a particular piece of video you want to work
with. Click the buttons repeatedly to loop through the
speed factors.

Loop: This button causes the currently-selected ()
clips in the Movie Window to play back
repeatedly. This feature is especially convenient whilst
selecting and editing add-on effects and transitions.
Click any playback button to halt looping. The loop
button lights up while looping is active. Looping is
maintained even if you switch playback speeds.

Jog buttons: This pair of controls normally steps /a
your movie forward and backward by one frame ¥
at a time. To step by seconds, minutes or hours instead
of frames, select the corresponding field in the counter
(see below), then use the jog buttons to modify it.

The Player scrubber

Use the Player scrubber to quickly traverse your
captured video or edited movie in either direction. The
scrubber position corresponds to the position of the
current frame in the captured video file (not just the
current scene) or in the edited movie (not just the
current clip). Thus the scrubber bar always represents
the entire length of the content being viewed.

As you move the scrubber, the preview window shows
the current frame. If you have activated the audio
scrubbing button in the Movie Window, you will also
hear snatches of your movie’s audio as you scrub. See
page 64 for details.

The ability of the preview to keep up with the scrubber
depends on the speed of your computer. If you move
the Player scrubber slowly, the preview display
responds smoothly. As you increase the rate at which
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you move the scrubber, the preview will jump frames.
The point at which it does so depends on your
hardware. The smoothness of the preview also
diminishes as the overall length of the material being
scrubbed increases.

The counter
The counter displays the current (g.00.0s .28

playback position in hours, minutes, l

: Frames
seconds and frames. You can directly ki
modify the counter fields to select an Minutes

exact frame to view or at which to U™

start playback. Simply click on the number you wish to
change and type a new value. To move to a different
field, click again or use the Left and Right arrow keys.
You can also modify the value in a selected field by
using the jog buttons beside the counter or the Up and
Down arrow keys.

The master volume slider
{1

This control sets the overall audio volume during
preview playback. It is equivalent to turning up the
master volume on your sound card using the system
volume tool. It does not affect the volume of the final
movie Studio creates in Make Movie mode. The small
loudspeaker icon at the right of the control serves as a
master mute button during playback.

DVD playback controls

These controls include the four o
standard transport buttons detailed i
above (Play/Pause, Fast reverse,
Fast forward, Go to beginning) plus
the DVD Player Control, which is described under
“The DVD Player Control” on page 198.

I« i s
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Further editing topics

Please see the following for details on specific editing
topics:

e Chapter 5: Video clips

e Chapter 6: Themes and theme editing

e Chapter 7: Video effects

o Chapter 8: Two-track editing with Studio Plus
e Chapter 9: Transitions

o Chapter 10: Still images

o Chapter 11: Disc menus

e Chapter 12: The Title Editor

e Chapter 13: Sound effects and music

o Chapter 14: Audio effects

Expanding Studio

One way to add pizzazz to your productions is to use a
variety of video and audio filters, animated transitions,
titles, VCD and DVD menus, themes and sound effects.

Studio includes an extensive selection of hundreds of
content items and special effects, but it’s also designed
to grow along with your needs. When you want a
particular filter, transition, menu or effect that isn’t part
of the basic set, an easy-to-use upgrade mechanism lets
you find, purchase and install the materials you need
without even leaving the program.
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Sk Premium content items, like the Hollywood
Bl FX transition whose icon appears at left, are

listed in Studio with a small treasure chest
symbol in the top-left corner of the icon. Such items
can be upgraded by purchasing a code called an
activation key. Each key activates a small group or

theme pack of related content.

You can easily try out bonus content before purchase to
make sure that it meets your needs. Until you actually
purchase your activation code for the item, it will
produce “watermarked” output when you preview or
when you make your finished movie.

New tools, new media, new frontiers

You can purchase additional media and filters in any of
three ways from within Studio:

e With the Help » Purchase activation keys @
menu command (or the premium shortcut
button at the top right of the Studio screen).

This opens a special browser window in which you
can access a catalog page for any type of premium
content that interests you.

e With the Album commands More transitions, More
themes, More sound effects and More menus.

These commands are found on the dropdown lists in
the corresponding sections of the Album. They will
enable you to download, try out and purchase
additional premium content that was not included
with the program installation.

e By clicking the activate buttons found in some parts
of Studio.

%; Activate Effect Pack
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These buttons can be found whenever premium
content is on display within Studio. The one above,
when seen in the Audio effects tool and the Video
effects tool, would let you activate a pack of audio or
video filters. You may encounter similar buttons in
the Album that let you purchase all the media on a
particular Album page as a theme pack.

How activation works

“Activating” premium content for Studio means to
obtain a license allowing you unrestricted use of the
content on the single machine where Studio is installed.
The licensing mechanism employs two distinct but
mutually related codes:

e An activation key for each premium content item you
purchase;

e Your Passport, which is a number generated the first
time you install Studio on your computer. You can
view your Passport by selecting the Help > My
Passport menu command.

Because the Passport is specific to one computer, you
will need to obtain new activation keys if you install
Studio on a different machine. These will be provided
at no charge, but your user licenses for both Studio and
any premium content you have obtained then apply to
the new machine only.

Note: Although your Passport is specific to an
individual computer, it is not affected by ordinary
hardware modifications such as adding or removing
expansion cards, drives or memory.
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If you don’t have an Internet connection...

You can purchase and apply premium content
activation keys even if you don’t have an Internet
connection on the computer where Studio is installed.
When you click one of the unlock links within Studio, a
dialog will be displayed showing information needed
for ordering the specific content you want, including:

e An Internet URL where you can activate the content

e Numeric identifiers for the Studio program and the
item you want to activate

e Your Passport and your Serial Number

Navigate to the given URL from another computer,
enter the information, and complete the purchase as
directed. You will then be given an activation key with
which you can activate the content on the original
computer by using the Help > Enter Activation Keys
menu command.

Hiding and showing premium content

If you would prefer not to view the premium content
and features available in Studio, open the Project
preferences options panel and uncheck either or both of
Show premium content and Show premium features.
(See page 290.)

Importing content from past Studio versions

If you are an owner of a past version of Studio, the
chances are that you already own content items,
whether on a “Bonus Content” or “Premium Pack”
disc, or on a hard drive attached to your system. The
Studio “Transfer Content” wizard walks you through
the process of locating all such materials that are
available to you, and importing them for use in the
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current version of the software. Among the item types
handled by the wizard are:

e Titles

Disc menus

Sound effects

Hollywood FX 3D transitions

RTFx video effects

To launch the wizard, look in the Studio group on your

Start » All Programs menu, and select Tools »
Transfer Content.
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CHAPTER 2:

Capturing video

Capture is the process of importing video from a video
source such as a camcorder to a file on your PC’s hard
drive. Clips from this “capture file” can then be used in
Studio as ingredients of your edited movies. You can
open capture files into the Album in Studio’s Edit
mode (see Chapter 3: The Album).

Footage Capture files Video scenes Video clips
in the camera ”“’ on hard drive ""» in the Album ”"» in your movie

Capture is the first step in using your video footage.

Studio is able to capture from both digital (DV,
Digital8, HDV) and analog video sources. See
“Capture hardware” on page 23 for details on
configuring Studio to capture from your equipment.

Availability: Capturing video from HDV camcorders is supported in
Studio Plus only.

Switching to Capture mode

The very first step in capturing is to switch into
Studio’s Capture mode by clicking the Capture button
at the top of the screen.

Ie— - - |
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This opens the Capture mode interface, enabling you to
set up and carry out video capture. The details of the
interface are somewhat different for analog than for
digital video sources.

Topics in this chapter

e “The Capture mode interface” (below) introduces
the controls and displays for both analog and digital
captures.

e “The Capture Process” (page 22) covers setting up
your hardware, gives step-by-step capturing
instructions, and describes the automatic scene
detection feature.

o “Digital capture” (page 28) and “Analog capture”
(page 30) cover topics specific to each type of
source.

e Besides video capture, Studio supports two other
methods of bringing in video material. These are
accessed with commands on the File menu. Import
DVD Titles (see page 33) lets you import files from a
DVD disc or image. Import Media From Device
(page 34) imports files from auxiliary devices with
onboard storage, including many camcorders and
digital still cameras.

€ THE CAPTURE MODE INTERFACE

The tools and controls you see in Capture mode are
different depending on whether your capture hardware
is digital or analog.
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Digital capture

If your video source is digital, your Capture mode
screen will look like this:

Album —

_m [32meee
Dol e

g

~ Pinnacle Studio Plus 2

i—Calrncorder controller Diskometer

The Album, at the top left of the screen, displays icons
representing the video scenes as they are captured. The
Player, at top right, lets you view the incoming video
while cueing for capture, and monitor the capture itself.
Readouts on the Player tell you the exact length of the
captured video, and the number of frames dropped
during the capture (normally zero).

The Camcorder Controller, at bottom left, provides a
tape counter display and a set of transport controls for
operating the playback device. Finally, the Diskometer,
at bottom right, displays the capture space remaining
on the drive. It also provides the Start Capture button
and buttons for setting capture options.

The Diskometer and the Camcorder Controller are
described in detail beginning on page 20.
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Analog capture

Both the Album and the Player are used in analog as
well as digital captures, so when you capture from an
analog source the top half of the screen is the same as
shown and described above for digital sources.

Not the bottom half of the screen, however. It now
features a second version of the Diskometer, with two
fly-out panels for adjusting audio and video levels
during capture. (The panels are described under
“Audio and video levels — analog” on page 31.)

[rs— G
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Digital vs. analog
To summarize, the digital and analog setups reflect two
major differences in capability:

e The digital setup lets you control the tape transport
of the camcorder or VCR using the Camcorder
Controller.

e The analog setup lets you modify audio and video
levels dynamically during capture.

]
The Diskometer

The Diskometer displays, both numerically and
graphically, the amount of space available on your
capture drive. It also indicates the approximate duration
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of video that can be accommodated, which depends on
both the available space and the configured capture
quality. Capture quality settings are selected using the
preset buttons that are displayed on the Diskometer for
some capture devices, or by entering custom settings.
See “Capture source settings” (page 284) and “Capture
format settings” (page 287) for information on capture
settings.

D% Camearder - Pinnacle 1334 Pinnacle 700-5B

(=)

(Q D7 e o ) [ 4] Capture MAIFEG Easl}
) \\ s

C’_ ) MPEG caplure

( Start Capture ) ( Settings ) { Start Capture ) [ Settings... )

The Diskometer when capturing from a digital
source (L) and an analog source (R). Click the side
tabs on the analog version to open fly-out panels for
adjusting video and audio levels during capture.

The Start capture button on the Diskometer begins and
ends the capture process. The caption changes to Stop
capture while the operation is in progress.

The default save location for captured video is your
system’s Shared video directory.

Setting the capture directory: To save captured video
to a different location, click the file folder button [C3).
This displays the Select Folder And Default Name For
Captured Video dialog. The folder you assign will be
used to store captured video during this and future
sessions. The file name you enter will be offered as the
default file name on your next capture.
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The Camcorder Controller

This panel of transport controls is shown in Capture
mode if you are capturing from a digital video source.
(Analog devices must be cued and operated manually.)

LTy
Fs SIS

sanes PO®®
>

The Camcorder Controller and a close-up of the
transport controls. The counter window above the
control buttons displays the current source tape
position, and the camcorder’s transport mode.

From left to right, the transport buttons are: Stop,
Rewind / Review, Play, Fast forward / Cue and Pause.

The Frame reverse and Frame forward buttons (second
row) let you locate an exact frame. These two buttons
are available only when the device is in pause mode.

€ THE CAPTURE PROCESS

Studio lets you capture video from a variety of analog
and digital hardware types. Choose the device you wish
to use on the Capture source options panel. See
“Capture hardware” (below) for more information.
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Performing the actual capture is a straightforward step-
by-step procedure (see page 24). As the capture
proceeds, Studio automatically detects the natural
breaks in the incoming video and divides the material
into “scenes”. Upon detection, each scene is added to
the Album, where it is represented by an icon of its first
frame. Automatic scene detection is described starting
on page 26.

Some capture options apply to digital captures only or
to analog captures only. These are covered in their own
sections, “Digital capture” (page 28) and *“Analog
capture” (page 30).

0000000000000
Capture hardware

Studio can capture digital and analog video from the
following sources, depending on your hardware:

e Digital: A DV or Digital8 camcorder connected to
an IEEE-1394 (FireWire) port. Capturing from HDV
sources is additionally supported in Studio Plus.

e Analog: A camcorder or VCR with analog outputs
connected to a DirectShow-compatible capture board
or external device.

e Analog: A USB video camera or webcam.

Pinnacle Systems offers a complete line of DV, analog,
and combination capture boards and devices. For more
information see your dealer or visit our web-site:

www.pinnaclesys.com
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To select a capture device:

1. Click the Setup » Capture Source menu command.
The Capture source options panel appears.

2. Select the devices you want to use from the Video
and Audio dropdown lists in the Capture devices
area, and click OK.

Capturs source ] Capture format ] Project preferences ] Video and audio preferences ]

Capture devices
Videa TV Standard Aspect Ratio

Pinnace 700-USE x| fwTsc =l a3 =l
Audio [~ VCR Input
|Pinnacle 700-USB j [v Capture preview

See “Capture source settings” on page 284 for
detailed information about the Capture source
options panel.

Standard vs. widescreen capture

Studio can capture in both the standard (4:3) and the
widescreen (16:9) frame-aspect ratios. With digital
hardware, the frame format is detected automatically.
With analog hardware, you use the Aspect ratio
dropdown on the Capture source options panel to select
the format that matches the source material. You can’t
use this setting to change one format to another: it
simply lets Studio know how to display the video at the
correct aspect ratio.

I——_—_—_——
Capture step-by-step

Here is a step-by-step outline of the capture process.
The instructions apply to both digital and analog
captures, with differences noted as required.
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Further information relating to some of the steps can be
found elsewhere in this chapter. Also see Appendix A:
Setup Options (page 283) for detailed descriptions of
the Capture source and Capture format options panels.

To capture video:

1. Verify that your equipment is properly connected.

For a digital capture, your camcorder or VCR must
be connected to your PC’s 1394 port.

For an analog capture, connect the source video to
the Composite or S-Video input of your capture
hardware. Connect your source audio to the audio
input of the capture hardware, if there is one;
otherwise, connect the audio to the audio input of
your PC’s sound card.

2. Click the Capture button at the top of the screen if
you are not already in Capture mode. The Capture
mode interface is displayed (see page 18).

3. Click the desired capture setting on the Diskometer.
If you need to make detailed adjustments, click the
Diskometer’s Settings button, which opens the
Capture format options panel (page 287).

Keep in mind that DV capture uses much more disk
space than does MPEG. If you are planning to
output your finished movie to disc (VCD, S-VCD
or DVD), you may choose to capture in MPEG
rather than DV format.

For an analog capture, keep in mind that the higher
the quality setting, the larger will be your captured
video file.

See “Digital capture” (page 28) and “Analog
capture” (page 30) for further explanation of these
options.
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4. Click the Start capture button on the Diskometer.
The Capture Video dialog box is displayed.

5. Type in a name for the video capture file you are
about to create, or accept the default name. You can
optionally also enter a limiting duration for the
capture.

6. If you are capturing from an analog camcorder or
VCR, start playback now. This step is unnecessary
with a digital-source capture, as Studio will control
the playback equipment automatically when
needed.

7. Click the Start capture button in the Capture Video
dialog box. The button caption changes to Stop
capture.

Capture begins. The Player displays the incoming
digitized video that is being saved to your hard
drive (unless you have unchecked Capture preview
on the Capture source options panel).

During capture, Studio performs automatic scene
detection based on the current setting in the
Capture source options panel.

8. Click the Stop capture button to end capture at a
point you select.

Studio automatically stops capturing if your hard
drive fills up or the maximum duration you entered
is reached.

Scene detection

Automatic scene detection is a key feature of Studio.
As video capture proceeds, Studio detects natural
breaks in the video and divides it up into scenes. A new
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icon is created in the Video Scenes section of the
Album for each scene detected.

Depending on which capture device you are using,
automatic scene detection is carried out either in real
time during capture, or as a separate step immediately
after capture is completed.

You can configure scene detection using the options
under Scene detection during video capture on the
Capture source options panel (Setup » Capture
Source). Not all scene detection options are available
with every type of video source. Options that do not
apply to your setup are disabled in the dialog.

The four possible options are:

e Automatic based on shooting time and date: This
option is available only when you are capturing from
a DV source. Studio monitors the time stamp data on
the tape during capture, and starts a new scene
whenever a discontinuity is found.

e Automatic based on video content: Studio detects
changes in the video content, and creates a new
scene wherever there is a large change in the images.
This feature might not work well if the lighting is not
stable. To take an extreme example, a video shot in a
nightclub with a strobe light would produce a scene
each time the strobe flashed.

e Create new scene every X seconds: Studio creates
new scenes at an interval you choose. This can be
useful for breaking up footage that contains long
continuous shots.

o No automatic scene detection: Select this option if
you want to monitor the entire capture process and
decide for yourself where scene breaks should occur.
Press the [Space] key each time you want to insert a
scene break during capture.
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€ DIGITAL CAPTURE

This section covers aspects of capturing from a DV
source deck (camcorder or VCR) and a 1394 port. To
read about capturing from analog hardware, please see
“Analog capture” on page 30.

You have two choices for the way the video data is
encoded and compressed in full-quality captures. For
most purposes, DV format is the logical choice, but if
you are planning to output your finished movie to disc
(VCD, S-VCD or DVD), you may prefer the MPEG-1
or MPEG-2 format instead.

Because of the intensive computation required for
MPEG-2 encoding, older computers may not be fast
enough to achieve a satisfactory MPEG-2 capture. The
type of capture hardware you have and the capture
quality you choose also help determine the minimum
CPU speed needed. In cases where Studio is able to
estimate that your computer is not fast enough to carry
out a particular capture, it will advise you of the
problem and give you a chance to cancel the operation.

DV

DV is a high-resolution format with correspondingly
high storage requirements.

Your camcorder compresses and stores video on the
tape at 3.6 MB/s, at a quality equivalent to broadcast
video. During capture, the video data is transferred
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directly from the camcorder tape to your PC hard drive
with no changes or additional compression. Capturing
DV video does consume a lot of drive space, so you
may want to pick and choose small segments to capture
instead of the entire tape if space is an issue on your
system.

You can calculate the amount of disk space you will
need by multiplying the length of your video in seconds
by 3.6, which gives the number of megabytes required.
For example:

1 hour of video = 3600 seconds (60 x 60)
3600 seconds x 3.6 MB/s = 12,960 MB (12.7 GB)
Hence 1 hour of video uses 12.7 GB of storage.

To capture DV video, your hard drive must be capable
of sustained reading and writing at 4 MB per second.
All SCSI and most UDMA drives are capable of this.
The first time you initiate a capture, Studio will test
your drive to make sure it is fast enough.

MPEG

DVD and S-VCD discs both use files in MPEG-2
format, an extension of the MPEG-1 format used for
VCDs. MPEGs intended for use on the Internet will be
at lower resolutions and in MPEG-1 format.

The Capture format options panel (Setup > Capture
Format) includes a variety of options to control the
quality of MPEG captures. Refer to “Capture format
settings” on page 287 for detailed information about
MPEG quality options.
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Audio and video levels — digital

With digital captures, you are using audio and video
that have been encoded digitally during recording, right
in the camera. When you transfer the footage through a
1394 port to your computer, the data remains in the
compressed digital format throughout, so you cannot
adjust the audio or video levels during the capture. This
is in contrast to analog captures, where the audio and
video can be adjusted as capturing takes place.

With digital captures, you defer any needed adjustment
of audio and video levels until Edit mode, where Studio
provides plug-in video effects for adjusting the visual
balance of a clip, and audio effects to enhance the
sound. These effects allow you to adjust individual
clips rather than having to make global adjustments
affecting all the video in a capture file.

For more information see “Analog capture” (below),
“Using video effects” (page 125), and “Audio effects”
(page 255).

0‘0 ANALOG CAPTURE

¢

The topics in this section relate to capture with analog
equipment, such as:

e A camcorder or VCR with analog outputs connected
to a DirectShow-compatible capture board or
external device.
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e A USB video camera or webcam.

If you are using a digital camcorder connected to your
computer via a 1394 port, please refer instead to “DV
capture” on page 28.

Capture quality options

With most analog capture hardware, Studio offers three
preset quality choices — Good, Better and Best — plus a
Custom option. Your hardware’s capabilities determine
how the presets translate into particular settings for
picture size, frame rate, compression characteristics and
quality. Keep in mind that the higher the quality, the
more disk space is required. Choose the Custom preset
to configure your own video capture settings. For more
information on video capture settings, see Appendix A:
Setup Options (page 287).

Audio and video levels — analog

Studio provides fly-out panels for controlling video and
audio levels during capture. This feature is especially
useful when you need to compensate for differences in
video captured from multiple sources.

Although you can also adjust these levels with the
appropriate Video effects in Edit mode, setting them
correctly for capture can save you from having to
worry about color correction later on.

Setting your audio options correctly as you capture will
help in achieving consistent volume levels and quality.
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Video input: Audio capture:

Video (L) and audio (R) panels for
setting levels during analog capture.

Particular capture devices may offer fewer options than
are shown and discussed here. For instance, with
hardware that doesn’t support audio captures in stereo,
a balance control will not appear on the audio panel.

Video

Choose the type of video you are going to digitize by
clicking the appropriate Source button (Composite or
S-Video). The five sliders allow you to control the
brightness (video gain), contrast (black level),
sharpness, hue and color saturation of the incoming
video.

Note: The Hue slider does not appear when capturing
from PAL equipment.

Audio

Use the Audio capture buttons to control whether
Studio should capture the audio along with the video.
Select the Off button if your source is video only. The
sliders on the tray let you control the input level and
stereo balance of the incoming audio.
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® IMPORTING VIDEO FROM DVD

Although it isn’t capture in the strict sense, you can
also bring video into Studio by importing it from a non-
protected DVD disc or a DVD disc image on your hard
drive. The File > Import DVD Titles menu command
opens a dialog that lets you locate and preview the
DVD material of interest, then import it as an MPEG-2
file to the folder of your choice.

Note: If the audio on the DVD is in AC3 format, it
may be necessary to purchase an activation code for the
AC3 codec software.

Import DVD Titles B=]

Chaoss & diss or imags: Chooss & destination folder:
[ &) FrogramFie[a]  Fi\Documents a.. My \/\dens\@

#{2) Psfonts
5 RECHCLER Type & name for this disc:

Preview

() System olu Mammalia
#3 Temp
& () WINDOWS Check the tiies to import
) WuTemp Title 01 1320207 [~
oo TRCE  Goasons |
L DVD- 15 |
(L DVD-RW Drive g =
845 DVOT 1) Title 05 0.00.29413 |
&) % DISKEPARTOZ (¢ Title 06 0.00:05.15
Title 07 0000615
Title 06 0:00:35.06 [,

< Local Disk (H | |
&) Documents

ORI CIEIE
=
5
o
=

{5 Tharkney's Docu P ~
# 4 My Network Places * Import.. [;\y ]
() Unused Desktop She|_|
il
< m [

Cancel )

To import DVD video:

1.

Select the DVD disc or image using the folder
explorer controls under Choose a disc or image.

Studio lists the “titles” (video files) available at the
location under Check the titles to import.

Use the folder browser button [ to select a
destination folder for the imported files.
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3. Enter a name for the DVD. This will be used as part
of the imported file names. For example, if you
name the DVD or image “My DVD”, and import
Title 12, the resulting file name will be:

My DVD_Title_12.mpg

4. Select the title or titles you wish to import by
checking the boxes next to the names. You can use
the player controls on the right side of the dialog to
preview the content of the currently-selected title.

5. Click the Import button.

Studio displays a progress bar to let you monitor
the progress of the import operation. When it is
complete, you can access the contents of the file for
editing from the Album as with an ordinary capture
file (see next chapter).

¥ IMPORTING MEDIA FROM

EXTERNAL DEVICES

The Import Media dialog (File > Import Media From
Device) makes it easy to locate still images and movies
stored on auxiliary devices plugged into your system,
and copy selected items onto a local hard drive for
access through the Album.

Selecting files to import

Begin by choosing a device from those on the Source
dropdown list. To appear on the list, a device must
offer the widely-supported Mass Storage Devices
interface. Those requiring TWAIN or other protocols
must be accessed with appropriate third-party software.
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Source:| It} ~| ¥ show video ¥ Show Photos
Select the files o import: View: (¢ Detalls " Thumbnails
File [ Size | Type | Created [~
Day out.mpg 59.1Mb dip 211112007 6:23:42 PM
Disagrae with assessment,gif 0.1Mb Graphic  9)7/2005 10:56:17 PM
Evolution. g 1.2Mb  Graphic  10/20/2007 4:39:26 FM
Flamingos avi 96Mb Cip 3/3(2007 413318 AM
Geneve Frozen.jpg 0.2Mb  Graphic  12{17/2005 %:05:48 &AM
Gerome - Pelt merchant of Cairo.jpa 0.1Mb Graphic  9/1/2004 3:41:41 PM
Grandma basks.mpg 51.3Mb Clip 5{12/2002 15141 AM
Hogarth - An election entertainmen. .. 0.1Mb Graphic  9/1/2004 3:5%:07 PM
Iceberg.jpa 0.2Mb  Graphic  6/5/2001 §:24:32 PM
Koalas.ipg 0.2Mb Graphic | 4/19j2006 2184z PN |
LBlackJoint.jpg 0.1Mb Graphic  10/12/2000 5:36:12 AM
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Devices that often contain importable media include:

e External optical disc drives, hard drives and flash
memory drives

o Camcorder or digital camera on-board drives of any
of these types

The Show Video and Show Photos checkboxes let you
specify which kinds of media files to list. By default,
both video and photos are shown.

The View buttons select either of two listing types:

e Thumbnails view provides a miniaturized image for
each file, along with the file name and datestamp.
With video files, the image is the first frame.

o Details view omits the thumbail but lists additional
data such as size and and duration along with each
file name. Click at the head of any column of data to
sort the listing by the text in that column; click again
to reverse the sort. The sort order chosen applies to
Thumbnails view as well.
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You can select multiple files to import by using
standard Windows mouse and keyboard commands,
along with the Select All and Deselect All buttons as
required.

Import options

Check Rename Files and type into the provided edit
box if you would like the names of all the imported
files to share a common stem. For instance, if you
check Rename Files, enter the word “Monday”, then
import some JPEG files, the imported files will be
called “Monday 1.jpg”, “Monday 2.jpg”, and so on.

Iv Rename Files

| Monday

Choose destination folders for your imported videos
and photos using the folder browser buttons [
provided under Put Videos Here and Put Photos Here.

Finally, click the Import button to commence the
import operation.
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The Album
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The Video Scenes section of the Album. Click the
tabs down the left side of the Album to access the
materials in the other sections.

The source materials you need for making a movie are
stored in the various sections of the Album, each of
which is accessed by its own tab as follows:

Video Scenes: This section contains your |,
video footage. The supported video file formats

are: avi, mpg, mpeg, mod, mp2, mp4, m2ts, tod,
mlv, m2v, mpv and wmv. You can access and preview
files directly, or you can load one into the Album,
where its scenes are represented by thumbnail icons. To
use some of the scenes in your movie, just drag their
icons into the Movie Window. See “The Video Scenes
section”, page 41.
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Transitions: This Album section contains | g
fades, dissolves, slides, and other transition ~—
types, including the elaborate Hollywood FX
transitions. To use a transition, position it next to or
between video clips and graphics in the Movie
Window. See “The Transitions section”, page 55.

Themes: A Theme in Studio is a set of | g
matching templates. You can use the templates ~——
to create effective sequences that combine your video
and still images with built-in animations and effects.
See “The Themes section”, page 57.

Titles: This section contains editable titles, | p
which you can use as overlays or as full-screen =
graphics. You can create your own titles from scratch,
or use or adapt the supplied ones. Studio supports rolls,
crawls, and many typographical effects. See “The
Titles section”, page 58.

Photos and Frame Grabs: This is a section of | sz
photographs, bitmaps and grabbed video -
frames. You can use these images full-screen or as
overlays on the main video. Most standard image file
formats are supported: gif, jpg, jpeg, pcx, psd, tga, tif,
wmf and png. See “The Photos and Frame Grabs
section”, page 59.

Disc Menus: Studio has an extensive |
collection of chapter menus to use in DVD,
VCD and S-VCD authoring. You can use these as they
are, modify them, or create your own. See “The Disc
Menus section”, page 59.

Sound Effects: Studio comes ready with a | ge
wide range of high-quality sound effects. You

can also use files that you have recorded yourself or
obtained from other sources. The formats supported
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are: wav, mp3, mpa, m4a, wma, avi and ac3. See
“The Sound Effects section”, page 61.

Music: In this Album section you can locate |

and use music files stored on your hard drive. =
The formats supported are: wav, mp3, avi, mpa and
wma. See “The Music section”, page 62.

Using the Album

Each section of the Album contains as many pages as
are necessary to hold the icons representing the items in
that section. At the top right of each Album page,
Studio shows the current page number and the total
page count for the section. Click the arrows to move
forward or back through the pages.

Page 2 of 3 @[%0

All types of Album content can be previewed simply
by clicking on the icons.

This chapter introduces each of the Album sections in
turn, beginning with a detailed discussion of the all-
important Video Scenes section. Actually using the
contents of the Album to create your edited movie will
be the subject of chapters 4 through 13.

Source folders for Album content

The scene icons in the Scenes mode of the Video
Scenes section come from a captured video file, while
the Transitions section is filled from resource files
associated with the Studio program.

The icons in each of the other five Album sections, like
the Files mode of the Video Scenes section, are
different: they represent the files contained in a
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particular disk folder. Each of these sections — Titles,
Images, Disc Menus, Sound Effects and Music — has a
default folder assigned to it, but you can select a
different folder if desired.

L | Skandard Titles

-mn

T
— I . e

The icons in the Titles section represent files stored
in a selected source folder on your hard drive. The
dropdown list at the top of the Album page lets you
select either ““Standard Titles” or “My Titles” from
the installed “Titles folder. Other folders of
installed titles may also be listed. The folder button
beside the list lets you look elsewhere on your hard
drive. The Disc Menus section works similarly.

The source folder for the section’s content is listed at
the top of the left Album page, next to a small Folder
button (3. To change the source of the current section,
either select a folder from the dropdown list, or click
the button, browse to another folder on your system,
and select any file. The file you select will be
highlighted in the repopulated Album section.

Some Album sections also provide a Parent folder
button to facilitate moving around within a group
of folders containing appropriate media.

In the Video Scenes and Still Images section of the
Album you will find one further button | -], which
links to the Import Media dialog. See page 34 for full
information.
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"0 THE VIDEO SCENES SECTION

¢

= , This is where the editing process really begins
== —in the Video Scenes section of the Album
with your captured raw footage. In a typical production,
your first step will probably be to drag some scenes
from the Album down into the Movie Window (see
Chapter 5: Video Clips).

In the Album, scenes are displayed in the order in
which they were captured. This order cannot be
changed, since it is determined by the underlying
capture file, but scenes can be added to your movie in
any order you choose. Similarly, while you can’t trim
(edit) Album scenes, you can use any desired portion of
a scene when it appears as a clip in your movie.

Files mode and Scenes mode

Choosing a particular video scene to use in a movie is a
two-step process. First, you must select the video file
containing the required scene by browsing for it on a
storage device — usually a hard drive — attached to your
system. Second, you choose the scene you want from
amongst those the selected file contains.

sy ) [y videos ~| [ | & Fies ¢ Scanss 607 Page 1 of 2 ]

\
| TP e triompg

Browse folders and video files on your computer by
selecting Files mode in the Video Scenes section of
the Album. Double-click a video file or select the
Scenes radio button to switch into Scenes mode.
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To browse for a video file in the Video Scenes section
of the Album, select the Files radio button at the top of
the right-hand Album page.

View options

Both the Files and Scenes modes support multiple view
options that let you tailor the display to your needs by
showing more or less information about each Album
item.

Studio provides several methods of accessing these
view options:

e Through commands on the View menu.

e Through the right-button context menu on the Album
page.

e Through the pop-up menu button that appears |&c”

when you click the View button at the top of
the right-hand Album page.

5 |Capturedwdeo j 5 |Capturedwdeo j r:l ‘{}
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|
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In Files mode, the Video Scenes section supports
three views at varying levels of detail: @ Icon view,
@® Details view and ® Thumbnail view.
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The two view options available in Scenes mode are:
© Thumbnail view and @& Comment view.

Interface features

The Video Scenes section offers several special
interface features:

e Scenes that have been added to the Movie Window
are distinguished in the Album by a green
checkmark. The checkmark remains as long as any
clip in the Movie Window originates with that scene.

e To see how a particular Album scene is used in your
current project, use the Album > Find Scene in
Project menu command. Studio highlights any clips
in the Movie Window that originate in the selected
scene (or scenes). To go the other way, use the Find
Scene in Album command, which is on the right-
click menu for Movie Window clips.

Nearly all menu commands that apply to scenes are
available both on the main Album menu, and on the
pop-up menu that appears when you right-click a
selected scene. When this documentation calls for a
menu command like Album > Combine Scenes,
remember that an equivalent command is usually
available on the pop-up “context” menu as well.
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Summary of operations

Because of its central role, the Video Scenes section of
the Album provides an extensive set of operations.
These are covered below in the following topics:

e Opening a captured video file

e Viewing captured video

o Selecting scenes and files

e Displaying scene and file information

o Comment view

e Combining and subdividing scenes

e Redetecting scenes

Opening a captured video file

The default locations for your video files are the
Windows default capture folder and the My videos
folder. When you are viewing the Video Scenes section
in Files mode, both of these locations always appear on
the dropdown list at the top of the Album.

You can also choose other hard drive folders to access
stored video files. Studio lets you navigate to the folder
where your files are located by clicking the icons in the
Album’s Files mode. You can also select a file directly
by clicking the Browse for file button in either Files or
Scenes mode. Both the current and previous folders are
also listed, if they are different from the two standard
locations, making four different folders that may appear
in the list at any one time.

Under Windows XP, the system capture folder is
located in the Windows’ “all users” documents folder.
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The capture folder’s real name is My videos, but
Windows Explorer and Studio customarily call it by an
alias, Shared videos. This distinguishes it from My
videos in the user’s personal documents folder.

= |Travel j Y
S——, Travel

Family video ,\
N My Wideos

Shared Yideno

See The Video Scenes Section (page 41) for details
about modes and view options when working with
video scenes in the Album.

Opening a folder

Folder contents are displayed in the Album’s Files
mode. Both the subfolders and the digital video files
within the current folder are shown.

= |Family'v'ideo j |_:| 3}
d
& D Christmas
D wacation

Three ways to open a folder:

o With the Video Scenes section in Files mode, select
the folder name on the dropdown list, or double-click
any listed folder.

e Click the parent folder button in either Files or
Scenes mode.

o Click the browse for file button (3 and use the Open
dialog to locate a digital video file in either Files or
Scenes mode. When Studio opens the video file,
switch to Files mode to display the contents of its
parent folder.
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Opening afile

When you open a video file, icons are displayed that
represent the scenes in the file:

= h |FamilyFunDay.mpg ﬂ [ T

Three ways to open a digital video file:

e Select the file name on the dropdown list when the
Video Scenes section is in Scenes mode.

e Double-click a file listed in Files mode.

e Click the browse for file button |3 and use the Open
dialog to locate a digital video file of any supported
type on your hard drive.

Scene detection and thumbnails

When you open a video file, the Album fills with the
file’s detected scenes (see “Scene detection” on page
26). Each scene is denoted by a thumbnail frame — an
icon of the scene’s first frame. It may be that the first
frame doesn’t make a good icon for the scene, so
Studio lets you pick a different one if desired.

To change thumbnails in the Album:

1. Select the scene to be changed.

2. Use the Player to find the frame you want used for
the thumbnail.

3. Click the Album > Set Thumbnail menu command.
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Video aspect ratios

Most digital video files provide format information that
allows Studio to detect the frame aspect ratio of 4:3 or
16:9 automatically. If the file does not provide aspect
ratio information, Studio defaults to the standard 4:3
format.

The Aspect Ratio 4:3 and Aspect Ratio 16:9 commands
on the Album menu let you manually set whichever
ratio you need. These commands also appear on the
right-button context menu for video in the Album.
Their method of operation is to stretch the original
frames to the new frame size. If you set the ratio of a
4:3 movie to 16:9, for example, people and objects will
appear widened relative to their height.

This is different from the frame-size conversion that
occurs when you add a scene to a movie project with
the “opposite” aspect ratio. In that case, the scene is
scaled in both dimensions equally to fit within the
target frame, and excess area appears as black.

e b el (e} [}

-

> > >

(L) Original 4:3 frame; (C) Same frame with black
sidebars on adding to 16:9 project; (R) Same frame
after Aspect ratio 16:9 command is used.

Note: The movie project’s frame format, which cannot
be changed after the project is created, can be set for
new projects in the Project preferences options panel.
See page 290 for more information.
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_________________
Viewing captured video

Individual or multiple scenes in the open captured
video file can be viewed at any time.

To view captured video starting at a selected scene:

1. Click on the scene’s icon in the Album.

The Player displays the first frame of the selected
scene.

2. Click the Play button in the Player.

The Player now plays the selected scenes and any
subsequent ones. Progress is indicated in three
ways.

e The scenes highlight successively as they are
played.

e The Player scrubber shows the current point of
play relative to the entire movie.

e Scene thumbnails display a progress bar during
preview. As you continue to view your captured
video, the progress bar moves from one
thumbnail to the next.
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Previewing digital video files

When a video file is selected in the Album’s Files
mode, you can use the Player to preview the video
without actually opening the file into the Album.

|?E]_' ! ]Family videno _:J O %
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Selecting scenes and files

Studio offers a variety of ways to select scenes and
other items in the Video Scenes section of the Album.
Selected video scenes are indicated by a highlighted
border. Selected folders and video files are shown with
text highlighting.

Selected scenes have a highlighted border (center).

Selection techniques follow standard Windows
conventions. Use any of the following, separately or in
combination:

e Choose the Edit » Select All menu command or
press Ctrl+A to select all the scenes (or files and
folders) currently displaying in the Album, including
those on other pages.

o Shift-click to select a range of neighboring items.
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o Citrl-click to add or remove individual items from the
selection.

e Starting with the mouse pointer over a blank area of
the Album page, click and drag to “marquee” an
area, selecting all the items that intersect the area.

e Use the arrow keys to navigate the Album grid. Use
the arrows in combination with Shift to select items
as you go.

D ‘acation

Bert scales wall
@ Grandma hasks
I histler smother

Selected folders and video files have highlighted text.

|
Displaying scene and file information

As you move the mouse pointer over
video scenes, the pointer changes to a
grabber symbol. If you pause
Prate ship- insignia| - momentarily on the scene, the start
P22 time and length is displayed in a pop-
up box. If you leave the grabber on the scene, the
display persists for several seconds. The start time
shown is the timecode from the original source video,
in minutes, seconds, and frames.

m FeiL UL, g For information regarding video
i 720450, MPEG-2, 29.97 fps . .
Duration = 1:40.19 files when the Video Scenes

section is in folder view mode, select Details view in
the Album’s right button context menu. The file name,
resolution, aspect ratio, duration and frame rate are
displayed. Switch back to a more compact listing with
Icon view.
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Comment view

In the default view for the Scenes mode of the Video
Scenes section, known as Thumbnail view, each scene
is represented by a thumbnail frame icon. To see more
information about each scene, switch to Comment view
using any of the methods described on page 42.

In comment view, editable captions are displayed for
Album scenes. The usage of these captions is up to
you: they might be search keywords, or scene names,
or text comments describing the scene content. The
default caption is generated from the scene’s sequence
number and duration (e.g. “Scene 3, 7:217).

Ty { |Family Fur Diay.mpg ﬂ MO o
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If you click on a video scene icon, an in-place text field
appears. Use it to enter the custom name or comment.

n Chroma t'rtle|
Duration = 4 28

Selecting scenes by name

A related option lets you select video scenes by
scanning for keywords in the comments. Use Album >
Select By Name to open the Select Scenes by Name
dialog box.
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Select Scenes by Name

Kepwords:

[ Mot ™ And
&

Chroma

ok ) Cancel

Enter a keyword into the text field and click OK to
highlight all Album scenes whose caption contains the
keyword. The default captions are not searched — only
the ones you have customized.

m Scene 27
ESLEF | Duration=4.00
“ Buccaneer

| Duration = 3,00

Combining and subdividing scenes

After previewing your scenes, you might want to
combine or subdivide some into larger or smaller units.
Such adjustments are easily made.

To combine scenes in the Album:

1. Select the scenes to be combined.
2. Select Album » Combine Scenes.
The selected scenes are combined into one.

Only selected adjacent scenes can be combined.
Furthermore, they are joined in the order in which
they appear in the Album, regardless of the order in
which they were selected. (Album order proceeds
across rows and then down the page.) To revert,
press Ctrl+Z, or click the undo button.
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If the scenes you selected were not all neighbors,
each set of adjacent scenes is combined, but the

1T =

1,2

4

6-9

Several selected scenes (black) are merged into two
longer scenes. Having no neighbors, scene 4 is
unaffected, even though it was part of the selection.

To subdivide scenes in the Album:

1. Select the scenes to be subdivided.
2. Select Album > Subdivide Scenes.

The Subdivide Selected Scenes dialog box appears.

Subdivide Selected Scenes

o

Ok

How many seconds per scene?

Cancel

3. Choose the length of the subdivided scenes by

typing in a value.

The smallest allowed subdivision is one second.
Any video remaining after subdivision is added to

the last scene.
4. Click OK.

A progress bar appears, the scene is subdivided, and
new scenes are added to the Album. To revert,
press Ctrl+Z, or click the undo button.
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You can subdivide these scenes still further, if
desired, down to the minimum duration of one
second.

1 2 3 la 1b 2
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Three selected scenes are subdivided to a duration
of five seconds. The vertical stripes indicate five-
second divisions within each scene. The uneven clip
timings at right occur because time left after
subdivision is added to the final divided scene; that
is also why scene 2 is ultimately unaffected by the
subdivision operation.

Redetecting scenes

If you combine or subdivide scenes and later decide
that you’d prefer to restore them to their original state,
you may redetect any scene or selection of scenes. The
detection results are identical to those obtained after
capturing, provided the same scene detection technique
is used.

If you have subdivided scenes, you must first
recombine them. Even if you cannot exactly recall the
initial state and so recombine more than is necessary,
the detection process will restore the original scene
sequence.
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To redetect scenes:

1. If you need to recombine any scenes, first select the
subdivided scenes, then apply the Album >
Combine Scenes menu command.

Select the scenes you wish to redetect.

3. From the Album menu, select either Detect Scenes
by Video Content or Detect Scenes by Shooting
Time and Date.

A progress window appears as Studio detects the
scenes and repopulates the Album.

0‘0 THE TRANSITIONS SECTION

¢

i.Lﬂ . The Transitions section of the Album provides
== alarge set of drag-and-drop clip transitions. To
keep things manageable, the transitions are divided into
groups. Use the dropdown list to select which transition
group you want to view. All the transitions in the group
are displayed, on as many Album pages as necessary.

To learn about transitions, and how you can use them
in your movies, see Chapter 9: Transitions.

Fanmily Fun 1 j
STAMDARD TRAMNSITIONS s
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Flying Windows
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wines and Fades

Studio’s transitions collection includes 74 standard
transitions, more than 50 Alpha Magic transitions, and
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a starting set of unrestricted Hollywood FX 3-D
transitions.

Obtaining more transitions

Besides those installed with Studio, additional packs of
Hollywood FX transitions are available for purchase
through the Pinnacle web-site.

For more information about purchasing premium
content for Studio, see “Expanding Studio” on page 11.

Displaying the transition name

As you move the mouse pointer over the transition
icons in the Album, the pointer changes to a grabber
symbol (indicating that the transition can be dragged
from the Album to the Movie Window). If you pause
momentarily on the icon, the name of the
"_ transition is displayed. The display persists
mﬁ for several seconds or until your mouse
pointer moves off the transition.

Previewing transition effects

When you click on a transition icon, the Player
demonstrates the transition using the convention that
“A” represents the original clip and “B” the new clip.
The demonstration cycles for as long as the icon
remains selected.

To see a detailed view, stop the Player and use the jog
buttons (Frame reverse and Frame forward) to step
through the transition one frame at a time.
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THE MONTAGE® THEMES SECTION

g . Editing based on Montage® Themes is a
== powerful feature unique to Studio. Each theme
is a set of matching templates. Use the dropdown list to
select the Theme whose templates you want to view.

|Star j
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More Montage Themes. ..

The templates available for each theme provide slots
for your video, photos, captions and settings. When you
create a theme clip from the template (by dragging it to
the Movie Window), the Theme Editor opens to accept
your customizations. It can be reopened at any later
time by double-clicking the clip. Templates give you a
fast, easy way to craft visually effective sequences that
combine your own materials with built-in animations
and effects. For information on using themes in your
movies, see Chapter 6: Themes and theme editing.

Obtaining more themes

Besides those installed with Studio, additional themes
are available for purchase through the Pinnacle web-
site. For more information about purchasing premium
content for Studio, see “Expanding Studio” on page 11.
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® THE TITLES SECTION

. This section of the Album contains a collection
of text titles in a variety of styles. They can be
used in your movie as either full-screen or overlay
titles. The difference is that in an overlay title the
transparent background is replaced by other material
(usually a video clip), whereas in a full-screen title, the
background is replaced with black.

In the Album, a gray checkerboard is used
wfieves | to indicate the portion of a title that will be

treated as transparent in overlays. (If you
prefer a black background, use the Album > Black
background menu command.) As with video scenes,
titles that have been added to your current project are
indicated in the Album by a green checkmark symbol.

With Studio’s powerful built-in Title Editor, you can
readily create your own titles when needed. However,
you may find it easier still to start with one of the
supplied titles and customize it in the Title Editor.

The Titles folder: The icons in the Titles section
represent files in the folder named at the top of each
left-hand page in the section. Titles that you have
created or modified can be added to the section by
saving them into this folder from the Title Editor. You
can also select a different folder to be the source of the
section (see “Source folders for Album content” on
page 39).

For information on using titles in your movie, see
Chapter 10: Still images.
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& THE STILL IMAGES SECTION

@ 5 This section of the Album displays thumbnail
’ icons of image files, which may include
grabbed video frames, photographs and bitmapped
drawings. Most standard image file formats are
supported. As with video scenes, images that are in use
in your current movie are indicated by a green
checkmark symbol.

The Still Images folder: The icons in the Still Images
section represent files in the folder named at the top of
each left-hand page in the section. Images can be added
to the section by storing them in this folder. For
instance, you can save grabbed video frames into the
folder from the Frame grabber tool, or save a title from
the Title Editor. You can also select a different folder
to be the source of the section (see “Source folders for
Album content” on page 39). For information on using
still images in your movie, see Chapter 10: Still
images.

€ THE DisCc MENUS SECTION

; - This section of the Album contains a collection
S of artist-designed menus for VCD, S-VCD and
DVD authoring. Menus in Studio are really specialized
titles: they can be created and edited in the Title Editor,
and either saved from the editor into a disk folder or
incorporated directly into your movie.
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As with video scenes and other visual resources, disc
menus that are in use in your movie are distinguished in
the Album by a green checkmark symbol.

For information on using disc menus in your movie,
see Chapter 11: Disc menus.

The Disc Menus folder: The icons in the Disc Menus
section represent files in the folder named at the top of
each left-hand page in the section. Menus can be added
to the section by storing them in this folder. You can
also select a different folder to be the source of the
section (see “Source folders for Album content” on
page 39).

The motion background symbol: Some of the menus
supplied with Studio incorporate a background of
moving video rather than a static picture, and you can
also create such menus vyourself. This “motion
background” can help give a professional look to your
finished disc.

Availability: The motion background feature is
available in Studio Plus only. See “Adding a motion
background” on page 224 for information on creating
or editing a moving video background.

Menus with motion backgrounds are indicated by a
small symbol &g in the bottom right-hand corner of the
Album icon.

Obtaining additional disc menus

Besides those installed with Studio, additional disc
menus are available for purchase through the Pinnacle
web-site. For more information about purchasing
premium content for Studio, see “Expanding Studio”
on page 11.
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€ THE SOUND EFFECTS SECTION

¢ Studio comes with a wide range of ready-to-
’ use sound effects. These wav files are installed
into a number of folders, covering categories such as
“animals”, “bells” and *“cartoons”.

The Sound Effects folder: This section of the Album
displays the sound files contained in one disk folder,
named at the top of each left-hand page in the section.
You can display the sounds in a different folder — not
necessarily one of those installed by Studio — by
selecting that folder to be the source for the section (see
“Source folders for Album content” on page 39).

Besides wav (Windows “wave”) files, files in mp3
format and avi animation files are also displayed in this
section of the Album, and may be drawn upon for
supplemental audio in your productions.

Any sound clip can be previewed simply by clicking its
name or icon.

For information on using sounds in your movie, see
Chapter 13: Sound effects and music.

Obtaining more sound effects

Besides those installed with Studio, additional sound
effects are available for purchase through the Pinnacle
web-site.

For more information about purchasing premium
content for Studio, see “Expanding Studio” on page 11.
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€ THE MuUSIC SECTION

i. &  This section of the Album displays the music
=== files in a folder on your hard drive. To use a
file drag it onto the Music track or another audio track
on the Movie Window Timeline,

The Music folder: The wav, mp3 and other audio files
come from the folder named at the top of each left-hand
page in the section. Other music files can be added to
the section by storing them in this folder. You can also
select a different folder to be the source of the section
(see “Source folders for Album content” on page 39).

For information on using background music in your
movie, see Chapter 13: Sound effects and music.

Pinnacle Studio



CHAPTER 4:

The Movie Window

The Movie Window, where you build your movie from
the raw materials in the Album, occupies the bottom
half of the screen in Studio’s Edit mode. To access the
Movie Window, first switch to Edit mode if you are not
already there:

b — e |

The Movie Window title bar contains several important
controls and displays. The toolbox buttons at the left of
the title bar open the Video toolbox and the Audio
toolbox, which are discussed on page 74.

e ol A

The Add Marker button (top) creates a new clip
marker at the Timeline scrubber position. After you
add a marker to your project, controls for naming
and selecting them become visible (bottom). See
“Clip markers™ on page 71 for full information.

Chapter 4: The Movie Window 63



To the right of the toolbox buttons is a text area where
the project file name is displayed. Status and warning
messages are also displayed in this area when required.

The next controls relate to clip markers, which are like
bookmarks attached to clips in your project. In a new
project, the only visible clip marker control is the Add
Marker button. When you add your first marker, more
controls appear.

Further still to the right are the Audio scrubbing, Clip
split and Clip delete buttons, then three view selection
buttons (see “Movie Window views” on page 67), and
finally a compact version of the Volume and balance
tool’s output level meter (see page 248).

Scarub— Split Delete Aucdlio

sound cli cli meter
Toolbox File name and P P
buttons message area Add marker View buttons
|
L T : e ——

Audio scrubbing button

o=l)) By default, your project’s audio is previewed
during playback only. Studio’s audio scrubbing feature,
which is turned on and off by the loudspeaker button,
provides audio preview when you are scrubbing
through your movie as well.

Audio scrubbing makes life much easier when making
editing decisions that depend on sound cues.

Split clip/scene button — the razorblade

&3 Click this button to split the currently-selected clip
in the Movie Window, or the currently-selected
scene in the Album.
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No information is lost. If the item is an Album scene, it
is split at the indicated point into two shorter scenes. If
the item is a clip in the Movie Window, it is duplicated
and automatically trimmed to the split point.

The razorblade button can be used with the track-
locking buttons in the Movie Window’s Timeline view
to carry out special operations such as insert editing,
and edits in which the audio leads or lags behind the
video. See “Advanced Timeline editing” on page 98.

0.00:02 ey sl

o T

Splitting a clip: The placement of the edit line in the
original clip determines the split point. When you
apply the razorblade tool, Studio duplicates the clip
and trims away the portion after the split point in the
first copy and up to the split point in the second.

Delete Clip button —the trashcan

fmf This button deletes the currently-selected content
in any of the Movie Window views. By default,
when video clips on the main video track of your
project are deleted in any view, the gap in your movie
that would be created by the deletion is automatically
closed up, and clips on other tracks are removed or
shortened as required to keep everything in sync.

If you delete clips on other tracks, the default behavior
is that gaps between them are not automatically
removed, so the timing of other clips is not affected.

If you press the Ctrl key while clicking the delete
button, or pressing the Delete key, the default behavior
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for the current track is reversed. That is, on the main
video track, Ctrl+Delete leaves a gap when the clip is
removed, while on the other tracks, the gap on the track
is closed up. In neither case are other tracks affected.
You can also access the delete operations through the
right-button context menu for clips on the Timeline.

Figy SpaLcual Figy SpaLeua
Delete Delete Delete Delete
Delete (leave gap) Ckrl+Delete % Delete (close gap) Ctrl+Delete %

ok hely ik Rl

The delete options on the right-button menu for
Timeline clips are not the same for clips on the main
video track (L) as for those on other tracks (R). The
menus list the context-dependent keyboard shortcuts.

Positioning: edit line, scrubbers

The current position is the frame showing in the Player
when you are working with a clip in the Movie
Window. In the Timeline view, it is indicated by the
edit line. The current position can be changed by
moving either the Timeline scrubber (to which the edit
line is attached) or the Player scrubber.

Timeline scrubber Trim scrubber Player scrubber

e P pren

e F o P Doy 2 20061

-9

temad-al

When the Clip properties tool is open, a third
scrubber, the trim scrubber, allows you to adjust the
current position within the clip during trimming.
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€ MoVIE WINDOW VIEWS

The Movie Window provides three different views of
your project: Timeline, Storyboard and Text. Select the
one you want to use by clicking the view selection
buttons in the upper right corner of the Movie Window.

Storyboard view

Storyboard view shows the order of ogo| =
video scenes and transitions. It uses
thumbnail icons for quickly structuring a movie. You
can choose to work with large or small thumbnails with
the Show large storyboard thumbnails checkbox on the
Project preferences options panel.

Timeline view

Timeline view shows the positions  go= (=
and durations of clips relative to
the Timescale. This view also displays up to eight
tracks on which you can place various types of clip:

e Video, plus full-screen disc menus, titles =
and graphics: The video track contains the
primary visual material in your production. See
Chapter 5: Video clips, Chapter 10: Still images and
Chapter 11: Disc menus for more information.
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e Original (or “synchronous”) audio: The

original audio track contains the audio that 4/
was captured along with the video from your camera.
You can manipulate the audio clips on this track to
achieve various effects using insert-editing and split-
editing techniques. See “Insert editing” (page 100)
and “Split editing” (page 102) for more information.

Overlay video and audio: In Studio Plus, [Gg
video and images placed on the overlay track

can be used with the Picture-in-picture and
Chroma key tools to give your video 4’
productions a professional appearance. These
features are locked in other versions of Studio,
producing “watermarked” output when used. You
can upgrade to Studio Plus at any time if you need its
advanced capabilities. Original audio for overlay
video is stored on the linked audio track. See
Chapter 8: Two-track editing with Studio Plus for
details about the overlay track.

Title and graphic overlays: Images placed on T
the title track will be rendered as overlays

upon the main video, with transparent backgrounds.
See Chapter 10: Still images and Chapter 11: Disc
menus for more information.

Sound effects and voice-overs: The audio ]~
clips on this track are mixed with the original
audio track and the background music track to create
the final soundtrack for your movie. See Chapter 13:
Sound effects and music for full information.

Background music: The background music for %}
your movies can be created to any desired

duration with the SmartSound tool (page 235) or
imported with the CD audio tool (page 234). Your

Pinnacle Studio



soundtrack can also make use of mp3 and other
music files (see page 229).

e Disc menus, chapter marks and return-to-
menu links: This is an extra track that appears
above the video track whenever the movie has at
least one disc menu. See Chapter 11: Disc menus for
information.

Timeline scrubber Timescale
T o]t Lincoln Park o Ee B = =

LTI .

Menu [ [wm 2

. g E =l s
Video = i g : &

Audio /7 &

Title "2

Sound effect «:
Music &

)

Because many editing operations can be carried out
only in Timeline view, you should choose it whenever
extensive, detailed or advanced editing is required.

Track locking

The video track normally takes precedence over all
other tracks for trimming or deleting. This has several
consequences:

e When you trim a video clip, clips running
simultaneously on other tracks are also trimmed.

e When you delete a video clip, the time segment it
used is also removed from any parallel clips.

o Clips that fall entirely within a deleted video clip’s
span are also deleted.

These behaviors can be bypassed when necessary with
a feature that allows you to “lock” any track indepen-
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dently of the others, thereby excluding it from editing
and playback operations.

The padlock buttons along the
right edge of the Movie
Window, can be clicked to
toggle  locking for the
corresponding track. Track- =)
locking gives Studio insert-edit e 4‘_;
and split-edit capability (see :
Chapter 5: Video clips).

Track muting and hiding

The audio tracks can be
individually muted with the
mute buttons at the right edge
of the Movie Window. These
buttons have the same function
as the mute buttons in the
Volume and balance tool. (See
page 248 for more
information.)

The equivalent operation for
video tracks is effected with
the hide buttons, which can be
used to temporarily omit a
track’s video from your
project. This is especially
handy to see what’s really
going on while editing overlay video in Studio Plus

e L i
Hide: the main video track
e ] 1

Placement feedback

Studio gives you several types of feedback about your
actions as you place clips in the Timeline view.
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The status line: The status line area on the left of the
Movie Window title bar displays messages as you place
clips and perform other actions.

Placement symbols: While you are dragging a clip
into position on the Timeline, Studio provides feedback
to tell you whether the current placement of the clip is
valid. The mouse pointer shape and the colors of the
vertical placement lines indicate what you can and
cannot do.

For example, if you attempt to drag a sound onto the
video track, the placement guidelines turn from green
to red, the mouse pointer changes from “copy” to
“unavailable”, and the status line tells you, “Only
scenes, titles, photos, menus and transitions on video
track.”

Green placement lines with the “copy” pointer ] mean
that an action is valid; red placement lines with the
“unavailable” pointer © show that it is not.

Red placement lines Unavailable symbol
indicate invalid operation

Clip markers

Studio’s straightforward system of clip markers can
simplify navigation within a project, especially one that
is long or complex.

Controls relating to clip markers appear in the Movie
Window title bar. In a new project, the only visible
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control in the group is the add marker button. The
remaining controls appear only after the first marker
has been added.

In a new project, the only visible clip marker control
is the Add Marker button @. Clicking the button (or
pressing your ‘M’ key) creates a marker at the
position of the Timeline scrubber.

|El1 Hanadu j Q0 bl

Once a marker has been added, the Add Marker
button changes to Delete Marker, and the remaining
controls appear ®. Notice marker tab ‘01’ at the
scrubber position ©.

|EIZ Xanadu@ j GAD bl
00020 e 14

As more markers are added, the Previous Marker
and Next Marker buttons are enabled as needed @.
Studio renumbers markers to keep them in
sequence ©, but leaves unchanged the name you
provided, if any ©.

A clip marker represents a particular frame in a
particular clip. Even if that clip is moved around within
the project, or trimmed, the anchor location remains
unchanged. However, the marker itself can be moved,
even to a different clip, by dragging it with the mouse.
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The clip marker controls include:

Add marker, Delete marker: In Timeline
view, the add marker button is enabled while

any clip is selected, provided there is not
already a marker at the scrubber position. If a marker
is present, the delete marker button appears instead.

Previous marker, Next marker: These buttons |¢]
allow you to step through the markers in your
project. Unlike the add marker and delete >
marker buttons, these buttons are enabled in all
Movie Window views, not just Timeline view.

Clip marker title: If there is a clip marker at the
Timeline scrubber position, its number and name are
displayed in this text field (otherwise the field is
uneditable). The displayed marker number is
assigned automatically, and cannot be changed, but
the optional name can be modified at will.

01 ¥anadd |

Clip marker title list: Click the arrow button at the
right of the clip marker title to open this list, which
shows the number and name of each marker in your
project. Selecting a marker moves the Timeline
scrubber to the corresponding position.

|EI2 Hanadu j q 0 [A

0 Granada [ mnnod o
v Q 0:00;:24.00

Note: Once you have more than a very few markers in
your project, managing them becomes simpler if you
give them meaningful names. However, names are
optional and, as noted above, Studio helps out by
automatically keeping the list in time order.
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Text view

The Movie Window Text view is a
list showing the start and end times
of clips, as well as their duration. In addition, custom
names for clips are visible in this view.

o [ | ===
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0’0 THE TOOLBOXES

4

The toolboxes provide a convenient point-and-click
interface for editing operations — adding clips to your
movie, modifying existing clips and applying special
effects. Studio provides separate toolboxes for video
and for audio operations.

The toolboxes are available only in Edit mode. They
are opened and closed with the buttons at the top left of
the Movie Window.

= oz Video toolbox open
&, [z | Audio toolbox open

1=, oz Both toolboxes closed
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Select the toolbox you want to open by moving your
cursor over the icons. The individual buttons highlight,
indicating which toolbox will open when you click.
The Album is then replaced by the toolbox display,
which contains two main areas:

o Tool selector buttons in a panel on the left. Clicking
one of these opens the corresponding tool.

e The currently-selected tool on the right. Double-
clicking a clip in the Movie Window also displays
the corresponding tool (except for title clips, which
are opened directly in the Title Editor when you

double-click).
H@ - Marne: Family Fun Day [1:26.0] Duration:[0:00:03.11 | 2 s
E
-g T
o
% g
o
—'8 &)
s =

Current tool l

All the tool-selector buttons, except the top one in each
set, open specialized tools. The top button in both
toolboxes is the Clip properties tool. It displays a tool
appropriate for trimming and otherwise editing the type
of clip currently selected in the Movie Window.

The Title Editor

One powerful tool that is not directly accessed through
the toolboxes is the Title Editor, in which you can
combine text, images and other graphic resources to
make titles and disc menus for your Studio productions.
Access the Title Editor through the Title and Disc menu
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tools, or with the Go to Title/Menu Editor command
from the right-button context menu in the Movie
Window. See Chapter 12: The Title Editor for full
information.

The Video toolbox

The seven tools in this toolbox modify or create visual
clip types, including video clips, themes, titles, still
images and disc menus.

=5
e Frame grabber
el
= | SmartMovie
‘ PR Picture-in-picture
and Chroma-key
@ d Ch |

o Video effacts
-

Clip properties: The Clip properties tool |@
adjusts the start and end times of any type of

clip. This is called “trimming”. The tool also allows
you to type in a descriptive name for the clip. The tool
also presents additional interface components
appropriate to the type of clip being edited. See
“Trimming with the Clip properties tool” on page 94
for more information.

Themes: The Theme editor tool lets you |
customize clips created from “theme templates”.

The tool includes a mini-Album from which you can
import video and photos to be used in the theme clip.
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Some theme templates also provide text captions or
other parameters that allow customization. See Chapter
6: Themes and theme editing for more information.

Titles: This tool lets you edit the names and
lengths of titles. The Edit Title button provides
access to the Title Editor window, where you can
change the text and appearance of the title. See Chapter
12: The Title Editor for more information.

Disc menus: The Disc menu tool has a number
of controls for editing the links between the
buttons on a disc menu and entry points into your
movie called chapter marks, which are represented on
the menu track in the Movie Window. The Edit Menu
button opens the Title Editor, where you can modify
the visual appearance of a menu. See “The Disc menu
tool” on page 207 for more information.

Frame grabber: This tool takes a snapshot of a | ;&
single frame from your movie or from your
current video source. You can use it in your movie, or
save it for use in other applications. As with Capture
mode itself, this tool presents a different interface if
your current capture source is DV than if you are using
a non-DV source. See “The Frame Grabber” on page
189 for more information.

SmartMovie: This tool automatically combines
your source footage with the digital song file of

your choice to create a music video in any of a variety
of styles. See “The SmartMovie music video tool” on
page 106 for more information.

PIP and chroma key tool: The PIP and Chroma | g
Key controls occupy separate tabs on the same

tool window, so this can be thought of as really two
tools in one. It provides an alternative, graphical
interface to the Studio Plus Picture-in-picture and
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Chroma key effects. See “The Picture-in-picture tool”
(page 154) and “The Chroma key tool” (page 160) for
more information.

Video effects: Studio provides numerous plug-in |E
video effects with this tool. Each video clip,
theme clip or still image in your project can use effects,
whether alone or in combination.

Along with its basic library of useful effects, Studio
provides some “locked” premium effects that you can
try out. See Chapter 7: Video effects for details about
this tool. For information about purchasing premium
content for Studio, see “Expanding Studio” on page 11.

The Audio toolbox

The six tools in this set operate on or create audio clips
— “original” audio, voice-overs, sound effects and other
audio files, CD tracks and SmartSound background
music.

|‘ ?ﬁ Clip properties
( Volume and balance
FG
" ,ﬁ Voice-overs
" @ CD audio
i Background music
i
( Audio effects
1

Clip properties: The Clip properties tool lets |@
you adjust (“trim”) the start and end times of any

type of clip. You can also enter a descriptive name for
the clip to replace the default name if desired. (Clip
names are displayed when the Movie Window is in
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Text view.) The tool’s other controls vary depending
on the type of clip. See “Trimming with the Clip
properties tool” on page 240 for more information.

Volume and balance: This tool gives you | g
master volume controls for each of the three
audio tracks: original audio (audio captured with
video), sound effects and voice-overs and background
music. It also enables you to mute any or all of the
tracks, and to add real-time volume fades. Use the
balance and surround control to position each track
independently of the other two in a one-dimensional
stereo or two-dimensional surround-sound space.
When the overlay track is open, the tool provides a
fourth set of controls, which affect the overlay audio
track. See “The Volume and balance tool” on page 248
for more information.

Availability: Surround sound and overlay video are supported in
Studio Plus only.

Record voice-overs: To record a voice-over,
simply click the Record button and begin
speaking into your microphone. See “The Voice-over
tool” on page 237 for more information.

Add CD audio: Use this tool to add tracks, in
whole or in part, from an audio CD. See “The
CD audio tool” on page 234 for more information.

Background music: This tool lets you add | g
background music using ScoreFitter, Studio’s
powerful music generator. Choose a style, song, and
version. Studio will create a musical soundtrack that
matches the duration of your movie. See “The
Background music tool” on page 235 for more
information.
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Audio effects: This tool lets you apply plug-in | g
effects to any audio clip. The popular VST
standard for audio plug-ins is supported, enabling you
to augment your library with add-on and third party
effects. A configurable noise reduction filter is supplied
as a standard effect. Effects available in Studio Plus
also include both graphic and parametric EQ, reverb,
chorus and others.

Some “watermarked” premium effects may also be
included for you to try out, with others available
through the Pinnacle web-site by clicking the More
effects... “category” in the audio effects browser. See
Chapter 14: Audio effects for details about this tool.
For information about purchasing premium content for
Studio, see “Expanding Studio” on page 11.
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CHAPTER 5:

Video clips

The cornerstone of most Studio video projects is the
Album section containing your captured video scenes.
To create your edited movie, you drag scenes from the
Album into the Movie Window, where they are treated
as editable video clips.

This chapter explains how to set the “in” and “out”
(start and end) points for each clip. The Movie
Window’s editing interface makes this “trimming”
process simple, rapid and precise. The methods covered
in this chapter for trimming video (“Trimming video
clips”, page 89) can for the most part also be applied to
the other types of clip (such as titles and sound effects)
that are covered in later chapters.

A later section of the chapter covers more advanced
editing techniques, including split edits and insert edits,
that can give your movies a more professional look.
See “Advanced Timeline editing” on page 98.

And finally we’ll explore SmartMovie, Studio’s
automatic movie generator. SmartMovie intelligently
combines a music soundtrack with your video footage
to create a beat-synchronized music video, or with a
series of still images to create a slideshow. Both modes
support a variety of style options.
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¥ VIDEO CLIP BASICS

The first step in creating a movie is to introduce some
video scenes from the Album into the Movie Window,
where they become editable clips. At some point you
will probably also add some transitions, titles, audio
and other extras, but a set of video scenes is the starting
point for just about any project.

This section explains how to add scenes to your movie,
and how to work with scenes from multiple capture
files. It also covers some interface features that provide
useful feedback as you work.

Adding video clips to your movie

There are two ways to add a video clip to your movie:

Drag and drop: Drag a scene from the Video Scenes
section of the Album and drop it into the Movie
Window. This is normally the easiest and quickest way
to put together a rough cut of your movie. You can drag
multiple scenes simultaneously if you wish.

The clipboard: The standard clipboard operations
(Cut, Copy and Paste) can be used with video clips in
the Movie Window. The Copy operation works on
Album scenes also.

When a scene or clip is pasted into the Movie Window,
it is inserted at the first clip boundary starting at the
edit line position. You can use the standard keyboard
shortcuts for clipboard operations (Ctrl+X for cut,
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Ctrl+C for copy, Ctrl+V for paste), or select the desired
operation from the right-button menu.

When the Movie Window is in Timeline view, you can
drop a video scene or clip onto any of the following:

e The main video track. If the clip has associated
audio, it is added to the original audio track. This
video will serve as the background for any overlay
video or titles on the lower Timeline tracks.

e The overlay track. Video on this track is
superimposed on the contents of the video track. The
picture-in-picture and chroma key effects are used to
make a portion of the overlay frame transparent so
that some of the main video can be seen. Except in
Studio Plus, any clips on the overlay track are
displayed with a “watermark” graphic. If you decide
to use the overlay track in your movies, you can
upgrade to Studio Plus at any time.

e The title track. In Studio Plus, if the overlay track is
hidden, dropping a video clip on the title track causes
the overlay track to open and the clip to be placed
upon it. In other versions of Studio, or when the
overlay track is already displayed, the title track does
not accept video clips.

e The sound effects track or the background music
track. Attempting to drop a video clip on either of
these tracks actually drops the clip’s original audio.

Working with multiple capture files

For some projects you may want to incorporate scenes
from multiple source tapes, or from different capture
files made from one tape. To achieve this, load in each
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of the files in turn and drag whichever scenes you want
from each file into your movie.

To use multiple capture files:

1. Drag scenes from the first capture file into the
Movie Window.

2. Using the dropdown list or the folder button in the
Video Scenes section of the Album, open the
second capture file. Studio displays scenes from
only the current file in the Album. See “Opening a
captured video file” on page 44 for detailed
information on this step.

3. Drag scenes from the second captured file into the
Movie Window. Continue in this manner until you
have gone through all the files.

Because any given movie can be in only one of the
standard (4:3) format and the widescreen (16:9) format,
you cannot mix frame formats in the Movie Window.
By default, the first video clip you add to a movie
determines the movie’s frame format, and later clips
are modified as necessary to conform to it. See “The
project video format” below for further information.

The project video format

The video scenes you add to a project need not all
originate with the same device or be in the same file
format. They need not even have the same frame size,
aspect ratio or frame rate.

When video is played back within Studio, however, a
common frame format must be used. The Project
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format box on the Project preferences options panel
lets you specify the format for new projects either
explicitly (e.g. “NTSC Widescreen”) or implicitly,
from the format of the first clip you add to the project.

Project format

(™ Set From first clip added to project

(+ Use this Format For new projects:

NTSC Standard |

Currenk: 720 % 480, 29.97 frames/zec
4.3, interlaced

The current project format is displayed as a tooltip over
the project title in the Movie Window.

= ofZ Lincoln Park * I

MTSC Widescreen
= 720 x 480, 29,97 framesfsec

. Bl 16:9, interlaced

Codec:DY

The project format applies to all video and image clips
in the Movie Window, and to the preview of those clips
in the Player. Visual content in the Album, such as your
captured video scenes, is shown by default in its
original format, whether or not that matches the project
format.

If you want to avoid black bars (“letterboxing”) in your
project video, but still want to use scenes shot in the
wrong aspect ratio, there are two other approaches you
can consider:

e Use the Aspect ratio commands on the Album menu.
These let you stretch the Album scenes to conform to
the proportions of the project frame, at the cost of
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some distortion. Please see “Video aspect ratios” on
page 47 for more information.

e Use the 2D Editor effect with keyframing to create a
“pan and scan” version your video. Studios often use
this technique to make their movies fit a standard
television screen when they are transferred to
videotape or DVD. There is no distortion with this
method, but some material is lost from each frame.
Careful tracking of the action with the aid of
keyframing generally allows you to obtain
acceptable results despite this problem.

Availability note: The 2D Editor effect and the keyframing feature
are provided in Studio Plus only.

il 0 0001 12 (& i) ® o001 12 & ek 0 0001 1
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Compensating for source video in the ““wrong”
aspect ratio by adding black bars (L), stretching to
the full frame (C), and pan-and-scan (R). Each
method has its own drawbacks.

Background rendering

The project format is also used as the target format for
rendering, which is the process of generating video for
footage in which HFX transitions, effects or other
computationally demanding features are used. Until
such video has been rendered, it may not display
smoothly and with full detail during preview.
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Studio is able to carry out rendering behind the scenes
while you work. This feature is controlled from the
Background rendering box on the Video and audio
preferences options panel.

Background rendering

v Enable backaround rendering

" Set codec automatically

(% 1Jse this codec For background rendering:

D besk For output to DY tape ﬂ

Current: DV

Following the dialog’s advice regarding the codec to
use for background rendering may help reduce the
rendering time when your final movie is output.

If you are planning to preview your video on an
external device (Studio Plus only), you may need to set
the project format and the background rendering codec
to match that device. For instance, if you are
previewing on an analog monitor plugged into your DV
camcorder, you should do your background rendering
in DV.

Interface features

Studio provides a variety of visual cues regarding the
video clips in the Movie Window:

e When a clip is added to the Movie Window, a green
checkmark appears on the Album’s icon for the
corresponding scene. The checkmark remains as
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long as any clip in the Movie Window belongs to
that scene.

To see the original location of a clip in your source
video, use the Find Scene in Album command on the
right-click menu for Movie Window clips. Studio
highlights the Album scene from which the selected
clip is drawn.

To go the other way, use Album > Find Scene in
Project to show how a particular Album scene is
used in your current project.

When neighboring scenes from the Album are placed
in sequence in the Movie Window, the border
between the clips is displayed as a dotted line. This
is to help you keep track of your clips, and does not
affect how they can be manipulated in the Movie
Window.

In Timeline mode, any special effects you have
applied to a clip are indicated by small icons along
the bottom of the clip. These correspond to the effect
groups shown on the Video effects tool browser. You
can open the tool for parameter editing by double-
clicking any of the icons.

The star icon below this video clip shows that at least
one effect in the “Fun” category has been applied.
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® TRIMMING VIDEO CLIPS

In general, captured video scenes contain more material
than you actually require for your movie. “Trimming”
— the process of adjusting the in and out points of a clip
to remove unwanted footage — is a fundamental editing
operation.

No data is lost by trimming: Studio sets new start and
end points for the clip in the Movie Window, but the
source of the clip — the original Album scene — remains
intact. This means you can always reset clips to their
original state, or select different trim points.

Studio offers two ways to trim any clip (video scenes,
transitions, titles, still images, audio clips and disc
menus):

e Directly on the Timeline (see “Trimming on the
Timeline using handles” below).

e Using the Clip properties tool (see “Trimming with
the Clip properties tool” on page 94).

A video clip can be trimmed to any desired in and out
points within the limits of the original scene.

Trimming on the Timeline using handles

The quickest way to trim is by dragging the edges of
clips directly on the Timeline. Watch the Player as you
trim, so you can find the frame on which you want to
begin or end.
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Let’s first consider the simplest trimming case, in a
movie with only one clip. Then we’ll turn to the more
usual situation of trimming a single clip that is
surrounded by other clips.

To trim a single clip on the Timeline:

1.

2.

Delete all but one clip from the Timeline. If the
Timeline is empty, drag a scene in from the Album.

Expand the Timescale to make fine adjustments
easier.

Position the mouse pointer anywhere on the
Timeline except directly over the edit line. The
pointer becomes a clock symbol. Click-drag it to
the right to expand the Timescale.

This illustration shows maximum expansion, where
each tick mark represents a single frame:

0:00:00.27

Position your mouse pointer over the right edge of
the clip. The pointer becomes a left-pointing arrow.

@ (2 Tenton Tom* 0 ¢ =
i i ) 0000400

Click-drag to the left while keeping an eye on the
Player, which updates continuously to show the last
frame in the trimmed clip. As you shorten the clip,
the arrow cursor becomes two-directional,
indicating that the clip edge can be dragged both
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left and right. You can reduce the clip to as little as
a single frame, or increase it up to the end of the
source scene.

o]z Tendon Tom ® o @ =
b . {0:0004.00

5. Release the mouse button. The clip is now trimmed.

Multiple clips

The secret to trimming a clip when multiple clips are
on the Timeline is that you must first select the clip to
be trimmed by clicking on it with the mouse.

To trim with multiple clips on the Timeline:

1. Set up the Timeline with two short clips.

2. Adjust the Timescale until the clip you want to
adjust is a convenient size for editing.

3. Click the second clip. The video track should now
look something like this:

0:00:02.00 0:00:04.00
T

You can trim the right-hand edge of the clip just as
in the single-clip example above. As you do so, the
last frame of the clip is displayed in the Player. As
long as the second clip remains selected, you can
continue to trim more video by dragging the edge to
the left, or restore some of the trimmed video by
dragging the edge to the right.
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4. With the second clip still selected, move your
mouse pointer over the left edge of clip until the
pointer changes to a right arrow.

As you drag, the first frame of the clip is displayed
in the Player. As long as the clip remains selected,
you can continue to trim more video by dragging
the edge to the right, or restore some of the trimmed
video by dragging the edge to the left.

6. Release the mouse button. The clip you trimmed
snaps back against the right edge of the first clip.

Gaps and fills: Trimming with the Ctrl key

As we have seen in the example above, when you
shorten a clip on the video track, the clip and any clips
to the right of it move leftwards as necessary so that no
gap is left. At the same time, clips on other tracks are
shortened to keep the whole Timeline in sync. When
you trim a clip on any other track, however, gaps are
not automatically closed up, and no other track is
affected.
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This default trimming behavior simplifies editing under
most circumstances, but Studio also gives you a way to
invert the behavior when needed. If you press the Ctrl
key before you begin trimming a clip on the video
track, neither that clip nor any other will be
repositioned, and gaps are not closed up. There is no
effect on other tracks.

Meanwhile, using Ctrl when trimming clips on other
tracks again inverts the normal behavior. The clips on
the track will close in to fill any gap left by the trim.
Clips on tracks besides the one being trimmed are again
unaffected.

Note: See page 65 for a description of the parallel
behavior of Ctrl when deleting clips.

Clip-trimming tips

If you are having difficulty manipulating the edges of
clips during trimming, try the following:

o Verify that the clip you wish to trim is selected, and
that it is the only one selected.

e Expand the Timescale until it is easier to make fine
adjustments.

¢ Avoid expanding the Timescale too far, which makes
clips appear very long. If that happens, undo until the
scale is the way you want it; or reduce the scale by
dragging it towards the left; or select an appropriate
value from the Timescale’s context menu.
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Trimming with the Clip properties tool

‘@ Although it is possible to trim video clips

directly on the Timeline with full frame
accuracy, rapid, precise trimming is often easier to
achieve with the Clip properties tool. To access this
tool, select the clip you want to change, then use the
Toolbox » Modify Clip Properties menu command, or
click one of the toolbox buttons at the top left of the
Movie Window. (Clicking the same button a second
time will close the tool.)

In the case of video clips — in fact, any clips other than
titles — you can also open and close the Clip properties
tool by double-clicking the clip in any Movie Window
view.

The Clip properties tool can be used to modify any
kind of clip. It offers an appropriate set of controls for
each type.

The Name text field: For a video clip, most of the clip
property controls are for trimming. The only exception
is the Name text field, which lets you assign a custom
name to the clip to replace the default one.

The Name field is provided on the Clip properties tool
for all clip types. Clip names are used by the Movie
Window’s Text view, and can also be viewed as fly-by
labels when your mouse moves over clips in the
Storyboard view.

Preview areas: Separate preview areas show the in and
out frames of the trimmed clip, together with a counter
and jog buttons. The layout of each preview area is
similar to that of the Player during normal editing.
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Setting playback position: A scrubber control across
the bottom of the tool lets you set the playback position
anywhere within the clip. You can also set the playback
position using the counter and jog buttons located
between the two preview areas.

Using the counters: The positions reported by all three
counters are relative to the beginning of the clip, which
is position 0:00:00.0. As with the counter on the Player,
you can adjust the counters in the Clip properties tool
by clicking in one of the four fields (hours, minutes,
seconds, frames) to select it, then using the jog buttons.
When none of the fields is explicitly selected, the jog
buttons apply to the frames field.

Transport controls: While the Clip properties tool is
in use, the transport controls in the center area
substitute for those that normally appear on the Player.
These special transport controls include a Loop
play/Pause button © that can be used to cycle
repeatedly through the trimmed portion of the clip
while the trim points are being adjusted.

Setting the trim points: The left bracket [ button
beside the counter in the left preview area, and the right
bracket 1 button beside the counter in the right preview
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area, set their respective trim points to the current
position.

You can also adjust either trim point by:

e Entering a value directly into its counter
¢ Adjusting a counter field with the jog buttons
o Dragging the corresponding trim caliper

The Duration text field: This field shows the length of
the trimmed clip in hours, minutes, seconds and frames.
If you modify the value, either by editing the numbers
directly or by clicking the associated jog buttons, the
effect is to change the out point of the clip. Of course,
you cannot reduce the duration to less than a frame, or
increase it beyond the limits of the original video scene.

Usage tip: If you want to switch from trimming one
clip on the video track to trimming another, just click
on the new clip while the Clip properties tool remains
open, or drag the Timeline scrubber to the new clip.

Resetting trimmed clips

If you change your mind about a particular trim
operation (or group of operations) after previewing,
either use the Undo button (or Ctrl+Z) or manually
reset the trimmed clip using one of these methods:

e Drag the clip’s right edge directly on the Timeline
until it stretches no further,

e In the Clip properties tool, drag the trim calipers to
the ends of the clip.
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© SPLITTING AND COMBINING CLIPS

If you want to insert one clip on the video track into the
middle of another clip, split the latter into two parts
then insert the new item. “Splitting” a clip actually
results in it being duplicated. Both clips are then
automatically trimmed so that the first ends at the split
point and the second begins there.

To splita clip in Timeline view:

1. Choose the split point.

You may use any method that adjusts the current
position, such as moving the Timeline scrubber,
clicking Play and then Pause, or editing the counter
value in the Player.

2. Either right-click within the clip you wish to split
and select Split Clip from the pop-up menu; or,
make certain the edit line is positioned where you
wish to split the clip, and click the Split clip/scene
(razorblade) button (see page 64).

The clip is split at the current position.

To restore a split clip:

e Use the Undo button (or press Ctrl+Z). Even if you
have performed other actions since you split the clip,
the multilevel undo allows you to step back as far as
needed. Or,

e If undoing is not desirable because of intervening
actions that you don’t want to discard, you can

replace both halves of the split clip with the original
from the Album. Or,
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e Delete one half of the split clip, and trim out the
other.

To combine clips in the Movie Window:

Select the clips you wish to combine, then right-click
and choose Combine Clips.

The operation is allowed only if the combination of
clips will also be a valid clip — that is, a continuous
excerpt of the source video. On the Timeline, clips that
can be combined meet along a dotted edge.

® ADVANCED TIMELINE EDITING

Note: Additional features of Studio Plus, making use of the overlay
track, are covered in Chapter 8: Two-track editing with Studio Plus.

During most editing operations, Studio automatically
keeps the clips on the various Timeline tracks
synchronized. For instance, when you insert a scene
from the Album onto the video track, the relative
positions of all clips to the right of the insertion remain
unchanged.

Sometimes, though, you might like to override the
default synchronization. You might want to insert a
new video clip into your project without displacing any
clips of other types. Or you might want to edit video
separately from its accompanying original audio — a
valuable technique with several variations, discussed
below.
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Such special edits are possible using the track lock
buttons along the right edge of the Movie Window in
Timeline view. Each of the standard tracks (all except
the menu track) provides a lock button. See “Track
locking” on page 69 for more information on track
locking.

A locked track is grayed out in the Timeline view,
indicating that the clips on the locked track cannot be
selected or edited in any of the three views; nor are
they affected by editing operations on unlocked tracks.

Apart from the menu track, any combination of tracks
can be locked.

= s Come and go2 ] =) = B 5| =

Locking the title track, for example, prevents the
duration of a title from being changed even when you
trim clips on the main video track at the same time

index.

= ol Come and go 2 * ] ) B L =l =

When the title track is unlocked, trimming the main
video clip above it automatically trims the title.
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Insert editing

In ordinary Timeline editing, a video clip and the
original audio that was captured with it are treated as a
unit. Their special relationship is symbolized in the
Movie Window by the line connecting the video track
indicator with the original audio track indicator,
showing that the latter is dependent on the former.

The track lock buttons make it possible to deal with the
two tracks independently for operations like insert
editing, which typically means replacing part of a clip
on the video track while the original audio track
continues uninterrupted.

Note: Under Studio Plus, insert editing may also be carried out on
the overlay video and audio tracks, using analogous methods to
those described here.

For instance, in a sequence that shows someone
recounting a story, you might wish to insert a shot of an
audience member smiling (or sleeping!) without
breaking away from the main audio.

To perform an insert edit on the video track:

1. In the Timeline view of the Movie Window, click
the original audio track’s padlock button to lock
the track.

| The lock button is highlighted in red, and the
track itself is grayed to show that its contents
will not be affected by editing operations.
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2. Clear space on the video track for the video clip you
want to insert. Position the Timeline scrubber at the
point you want the insertion to start and use the
Split clip/scene button. Now move to the point
where the insertion should end and again split the
clip. Finally, delete the portion of video that will be
replaced by the insertion.

Because the audio track is still intact, having been
locked, the video to the right of the insertion point
does not move leftwards to fill the gap you have
made in the Timeline, for the video and audio
would then no longer be synchronized. If you were
to preview your video now, you would see a black
screen as the gap portion played back, but the
soundtrack would be normal.

& s Come and go 2 * 2] =) = I e =

3. Now all that remains is to place the clip you want to
insert. Drag the clip (whether from the Album or
elsewhere on the Timeline) into the hole in the
video track that you’ve just opened up.

& s Come and go 2 * ] =) B e (=] =

If the inserted clip is too long for the space you
created it is automatically trimmed to fit the space.
You can adjust the trimming with the Clip
properties tool.
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Insert editing on the original audio track

The converse insert-editing operation, in which a sound
clip is inserted into the original audio track over
unbroken video, is needed less often but is also readily
performed in Studio.

The procedure is analogous to the one for inserting
video: simply reverse the roles of the two tracks at
every step.

Split editing

In “split editing”, a clip’s audio and video are
separately trimmed so that the transition to one occurs
before the transition to the other.

Note: Under Studio Plus, split editing may also be carried out on the
overlay video and audio tracks, using analogous methods to those
described here.

In an “L-cut”, the video precedes its sync audio; in a
“J-cut”, the audio comes first.

Tip: For faster, more precise trimming, you may find it
helpful to have the Clip properties tool open when
following the procedures in this section. To open the
tool, just double-click one of the video clips before you
begin.

The L-cut

In an L-cut, the cut to new video comes before the cut
in the audio. Imagine a videotaped lecture in which the
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video periodically cuts away from the speaker to show
travel or nature scenes illustrating the lecture topic.

Audio and video cut simultaneously.

Instead of cutting the audio and the video
simultaneously, you might decide to let the speaker’s
voice overlap into the following scene. This makes it
clear to the audience that the new scene they are now
watching illustrates whatever explanation the speaker
has been providing.

Notice that the video and audio clip boundaries in the
completed cut form an L-shape.

Audio cuts after video. The resulting ““L’” shape is
outlined in this illustration.

There are many effective uses of this technique. It can
be considered whenever the second clip’s video serves
to illustrate the first clip’s audio.

To perform an L-cut:

1. Adjust the Timeline so you can easily count off the
number of frames or seconds you want to overlap.
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Select the left-hand clip and trim its right edge to
the point where you want the audio to end.

Lock the audio track. Now drag the right-hand edge
of the same clip’s video leftward to the point where

With the audio track locked, drag the second clip’s
video to the left until it meets the original clip.

If there isn’t enough excess video at the start of the
second clip to make this trim possible, you will first
need to trim off a sufficient amount from both its
video and audio then try again.

Unlock the audio track.

The video now cuts away to the second clip ahead
of the audio. Video has been trimmed from the end
of the first clip, and audio has been trimmed from
the start of the second clip.
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The J-cut

In the J-cut, the new audio cuts in before the video
switches. This can be effective when the second clip’s
audio prepares the viewer for the material in the scene.

Returning to the videotaped lecture example, let’s say
we are now going to switch back to the speaker at the
end of the interpolated footage. If we let the next part
of the lecture appear on the soundtrack a few moments
before the video shows us the podium again, the change
will be much less abrupt.

This time the clip boundaries outline the letter J:

Audio cuts before video. The resulting
“J” shape is outlined in this illustration.

To perform a J-cut:
1. Adjust the Timeline so you can easily count off the
number of frames or seconds you want to overlap.

2. As before, trim back the right edge of the left-hand
clip, both video and audio, by the overlap interval.

3. Lock the audio track. Now drag the right-hand edge
of the same clip’s video back to the right by the
overlap interval.

4. Unlock the audio track.

The audio now cuts away to the second clip ahead
of the video.
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Note: The procedures described above for the L-cut
and the J-cut are not the only possibilities. With the J-
cut, for example, another method would be to trim the
right-hand clip to the desired start point of the video
then, with the video track locked, drag the audio
portion left to overlap the audio of the left-hand clip.

¢ THE SMARTMOVIE MUSIC VIDEO TOOL

Creating a music video seems like a big job, even with
the convenient editing features of Studio. Dozens of
brief clips must be carefully aligned to the beat of the
soundtrack, in order that the music and video are
properly coordinated.

With Studio’s SmartMovie tool, however, you
can construct a dynamic, beat-synchronized
music video almost instantly, in your choice of styles
and using any combination of video footage and music.

You can make slideshows, too. SmartMovie can create
an instant slideshow from any set of still images, in a
choice of styles and with synchronized music.

In order to creste a music videa The SmartMOVle tOOI Walks
add =ome music to the music track. you th rough the Cl’eatlon
Click here to add music to vour process with simp|e Step_by_
project. . . .
step instructions. To begln, use
Y the Album to locate the video
scenes or still images you want
to include, and drag them onto the Movie Window.

Tip: The Timeline view of the Movie Window is
recommended when working with audio clips.
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With the visuals in place, add a SmartSound,CD audio
or digital music (wav, mp3) clip to the background
music track. The duration of this clip — and not the
amount of visual material you supply — determines the
length of your music video. If you don’t supply enough
visual material, SmartMovie will use your video clips
or images multiple times in order to achieve the
required duration. Conversely, clips or images will be
omitted if you provide more than can be used within
the duration of the song.

Exception: When making a slideshow with the Use all
images option checked (see below), it is the number of
images you provide that determines the length of the
finished project, not the duration of the music clip.

SmartMovie styles

Select a style from the dropdown list at the top of the
SmartMovie tool window. A variety of styles is offered
for both music video and slideshow projects.

Music Yideo Style

MMUQD video - Fast Paced j Relative Wolume

Music virea - Fast Faced @l’g é
Ihusic video - Pop star

Music Video - Old Movie

rMusic Video - Vaudevile :l

Music Videa - Wild and Crazy
usic Video - Electra

An amusing style that will turn your

viden into & silent-fim-era comedy
IMusic Viden - Simple and Elegant shart

{Musm “ideo - Slow and Romantic

g omadnp s

Music Video - Mostalgia
Muzic Video - Dreamy
Music Video - Moody
[Slideshaw - Elegant
Slideshow - Documentary
[Slideshow - Montage
[Slideshow - Presentation

[Slideshow - Mostalgia
[Slideshow - Dreamy
[Slideshaw - Swing

A brief description of each style is displayed in the
status balloon as you scroll through the style list.
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For video styles, you will get the best results if the
starting duration of your video footage is about double
the length of the soundtrack. Each of the slideshow
: styles has its own ideal ratio

e i ot | between the number of pictures
fin end 1 min 16 secs. and the length of the song. The
A SR B LTS balloon provides

slideshow. guidance for getti ng the
L/ proportions right.

SmartMovie options

The Use clips in random order option lets you mix up
the visual material without regard to its initial
sequence. This option is the default with some styles. It
tends to give a finished product with a relatively
uniform texture, but sacrifices narrative continuity.

|Music Video - Vaudeville j

& Use clips in random order O Use all images

Check the Use all images option when you want to
ensure that all the still images you have added to your
project are actually used in the slideshow, regardless of
the length of music you have provided. Studio will
repeat or trim the music clip as required to match the
number of images you have chosen.

Note: The Use all images option affects SmartMovie
slideshows only, not music videos.

The Relative volume slider adjusts the prominence of
the background music track relative to the other audio
tracks. Move the slider all the way to the right if you
want to hear only the music track in the finished video.

Relative Wolume

S e — &
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The last configuration step is to enter the text to use for
the opening and closing titles. Each text line consists of
two edit fields. Use Tab and Shift+Tab to jump
between the left and right fields.

Opening Title
[Lab O'Rattary |
Closing Credits
Directar Fhoda Ireland ~
Producer Simeon Stodgely
Created with Pinnacle Studio
w

The big moment...
Finally, click the Create SmartMovie button and sit
back while Studio generates your movie.

Create Smarthovie

Using SmartMovie from Capture mode

Studio lets you jump directly from capturing your
video right into the SmartMovie tool. To use this
option, simply initiate your capture as usual, then check
the applicable box on the Start Capture dialog.

¥ Create "SmartMovie" automatically after capture
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CHAPTER 6:

Montage® themes and

Studio’s customizable Montage

theme editing

® “themes” provide a

powerful but easy to learn method of achieving

Skar j

50s Modern
alburn

Biabey

Instant Photo
Love

MultiLayer Mix
SEasons

Sports

Star I
Tribute by

Wideo Wall
Mare Montage Themes. ..

slideshow, animation and multitrack editing
effects. With themes you can quickly give
your videos a more professional look while
maintaining a coherent structure.

Each theme consists of a set of templates that
can be added to your project as “theme
clips”. You can create attractive, visually
consistent sequences that integrate artist-
created titles and animations with your own
photos and video.

titles.

Note: “Titles” created from a Montage theme are not
related to those in the Titles section of the Album, or
created in Studio’s Title Editor. Themes are easier to
use, and can provide animation and other effects not
available in the Title Editor. On the other hand, the
Title Editor gives you a rich set of text drawing effects,
and much finer control over the appearance of the
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The themes provided are each designed to cover a
typical need. W.ithin each theme, the available
templates are designed to complement one another
when used in the same project. For instance, most
themes provide an Opening template and a matching
Ending template. Many themes also provide one or
more Segue templates for transitioning from one video
or image clip to another.

v

Il-..1 A Al
The appearance of a theme clip’s Timeline icon
reflects its structure. Here, from left to right, are an
Opening, a Segue, and an Ending icon. The zig-zag
edges correspond to the placement of full-frame
video in the clip. The video at the end of the
Opening, and at the start of the Ending, can be
edited to match that of a Segue; thus the zig-zag also
indicates how the templates can be used together.

Each template defines a video or graphic sequence with
blanks to be filled in by you. Most templates provide
one or more slots for video or image clips. Many let
you supply text captions for titles, and some have
additional parameters for other special properties.

Theme templates are stored in their own section of the
Album. The first step in using a chosen template is to
bring it into your project as a theme clip. As usual, this
is done by dragging the icon from the Album to the
Movie Window.

In the Movie Window, the theme clip is treated as an
ordinary, self-contained video clip. To customize the
clip — to fill in the template’s blanks — you will use the
Theme Editor tool.
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USING THEMES

Theme templates are stored in the Themes section of
the Album. The Album displays all the templates in a
given theme, as selected from a dropdown list. To use a
template, simply drag its icon from the Album into the
Movie Window.

oy | [50stodem - Gy | [pav
505 Modern
= - g c | ] e : i
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Pick a theme from the dropdown list (L) to show the
templates available (R). To use a template, drag its
icon down into the Movie Window.

When the Movie Window is in Timeline View, theme
clips can be trimmed and edited much like ordinary
video. You can elaborate them with transitions and
effects, adjust their audio, and so on. Like disc menus,
they are configured with a special editing tool, which
opens automatically when the clip is added to the
project, or when it is later double-clicked.

e i Nowa ]

The theme clip (selected in illustration) is treated as
a unit in the Movie Window. Its special properties
can be modified with the Theme Editor tool (double-
click the clip to open).
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The Theme Editor tool allows the user to ‘
customize a theme clip by adjusting its built-in
settings or specifying video and audio subclips for it to
use. The editor can also be accessed with the Toolbox
» Edit Theme menu command.
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The Theme Editor tool lets you specify theme
elements such as video or image clips, property
settings, and text captions. Clips are added by
dragging them either from the editor’s own mini-
Album (left side of tool) or from the Movie Window.

The Themes section of the Album

‘ ~ In the Album, the templates for one theme may
=" De viewed at a time. As with video scenes, you
use the mouse to select, play or add a theme template:

e Single-click loads the template to the Player, where
it can be played back with the transport controls.

e Double-click loads the template to the Player and
begins playback immediately.

e Dragging the template to the Movie Window, or
right-clicking its icon and clicking the Add To Movie
context menu command, inserts it into your project.
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As with menus, a special editor tool opens
automatically when a theme clip is added to the
movie.

Creating theme clips

To create a theme clip, use any of the standard methods
of adding content to your project:

e Drag an icon from the Themes section of the Album
to the Movie Window.

e Select Add To Project in a theme template icon’s
right-button context menu.

e Paste the contents of the Windows Clipboard after
you have cut or copied an existing theme clip.

Each theme is configured to appear on the track that is
appropriate to the theme’s content type:

e Themes whose content is a graphic overlay with
transparent background, such as a title or PIP frame,
are usually added to the Title track.

e Themes with full-frame video, such as opening
sequences, can be added to the Main video track
(Studio) or the Overlay video track (Studio Plus).

The default length of a theme clip depends on the
design of the individual template.

If you drop a new theme clip onto an existing one on
the Timeline, the new clip either is inserted beside the
old one or simply replaces it. The choice of operation
depends on the position of the mouse pointer relative to
the target clip when you release the button.

Chapter 6: Montage® themes and theme editing 115



116

Inserting a theme clip before or after an existing
clip: 1f you drop the new clip near the start or end of an
existing theme clip, it is accordingly inserted before or
after the existing clip. The placement lines that show
the position of the new clip on the Timeline are drawn
in green.

=]t My Movie *

L | Placement lines

A new theme clip, represented by the ‘copy’ mouse
pointer, is dragged near the beginning of the left-
hand clip. Green placement lines indicate where the
new clip will be inserted.

In the illustration, the placement lines show the
boundaries of the clip that would be created by
releasing the mouse button at the current position,
based on the template’s default length. All existing
clips would be moved rightwards to accommodate the
new one. If you were instead to drop the new clip near
the right-hand edge of the same existing clip, it would
be inserted after the clip.

Replacing an existing clip: If you drop a new theme
clip onto the middle of an existing one, the new clip
replaces the old one. The new clip also takes over any
existing customizations of the old clip. The placement
lines, drawn in blue, show the boundaries of the clip to
be replaced; regardless of its designed default length,
the new clip will inherit these boundaries.
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L 1 Placement lines

A new theme clip is dropped onto the middle of the
left-hand clip, replacing it. The positions of other
clips are not affected.

_____________________________________________
Working with theme clips on the Timeline

Theme clips behave like ordinary video clips when it
comes to operations like trimming and adding
transitions.

When a theme clip is trimmed...

Although trimming operations on the Timeline are the
same for theme clips as for video clips, the actual result
produced by trimming depends on the nature of the
clip.

In an all-animated theme, such as a fancy rolled title,
the animation runs to completion at whatever speed the
current clip duration dictates. Shortening the clip thus
causes the animation to run faster, but does not truncate
the sequence.

Clips that include video, in contrast, can be trimmed in
the usual way. Many themes include a variable-length
video subclip. When one of these is present, the clip
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can be expanded as far as the length of the subclip will
allow — indefinitely, if the subclip happens to be a still
image.

Transitions and effects

Transitions can be used at the beginning and end of
theme clips in the same way as with other clip types.

Video and audio effects can also be added to theme
clips as usual, and apply to all the content the clip
embodies. However, a few effects, such as Speed, are
not available for use with theme clips.

Anatomy of a theme

For examples of how themes work, let’s examine the
included “50s Modern” theme, which contains five
templates.

All the templates in this particular theme use the same
backdrop design — an abstract, scrolling pattern. It is
continuously visible except during full-frame video
segments. The coloring of the pattern is set using a
parameter control available in the Theme Editor for
each of these templates.

Now let’s look at each template in turn to see how it is
constructed from the elements — clips and captions —
that you supply in the Theme Editor.

Opening:  An Opening template
usually starts with some sort of

animation, including titles, and ends .‘_1‘6
with full frame video. Our “50s Modern” example
follows that pattern.
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The scrolling background animation runs through most
of this sequence. Within the animation, two
customizable captions are displayed. They are
represented in the diagram below by lines on the
“Animation” bar. Both captions are flown into and out
of the frame (dark line color), with a one and a half
second pause for stationary display (light line color) in
between.

00.00 0:00:04.00 0:00:08.00 0:00:12.00 0;

— [— Animation -

Schematic representation of the Opening template in
the *50s Modern’ theme, at its default length of about
14 seconds.

Just as the second caption is leaving the frame, an
animated panel containing the running video subclip is
launched. The video zooms to full frame by 11:18 in
the theme clip, and remains so through to the end (the
white portion of the “Video” bar in the diagram).

By default, the length of this theme clip is 13:29. The
embedded video clip starts at a fixed offset of 7:03 and
runs to the end; its length is therefore 6:26. If your
video subclip is long enough, you can lengthen the
overall clip, extending the full-frame video portion.
This capability is indicated in the diagram above by the
arrow at the end of the “Video” bar.

Segue A: Segue templates connect two
full-frame video sequences by means
of some kind of animation. This first
Segue example begins with two seconds of full- frame
video, then zooms out to reveal a formation of multiple
video panels running simultaneously. Zooming in on
the final subclip leads to an expandable section of full-
frame video.
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Animation

Segue A integrates multiple video sources.

Segue B: This Segue achieves the
basic aim of connecting two video
clips more simply than the previous

one. The first subclip starts at full frame, then zooms
out while rotating away from the viewer. When the
reverse side of its rotating panel comes into view, the
second subclip has replaced the first. The panel zooms
in to fill the frame towards the end of the clip.

Animation

Segue B creates a simpler transition.

Once again, the full-screen segment of the second
subclip can be extended by expanding the theme clip
on the Timeline.

Segue C: This is similar to Segue B,

except that the flying video panel takes

an extra spin in the middle to admit

one more subclip into the sequence. The final subclip is
again expandable.

Animation

Segue C includes a bridging video subclip.
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Ending: The purpose of an Ending
template mirrors that of an Opening
template, and in this example the
internal structure is also mirrored almost exactly. Full-
frame video recedes to a flying panel that gives way to
animated captions — just the opposite of the Opening
sequence described above. The one difference is that in
the Ending clip the full-frame portion is not extendable.

Animation

The Ending theme mirrors the Opening theme.

Opening the Theme Editor tool

The Theme Editor tool allows you to customize
a theme clip by specifying your own subclips
and other customizations. The tool can be invoked from
a theme clip in the project in either of these ways:

o Double-click the clip in the Movie Window.

o Select Open With Theme Editor on the clip’s context
menu.

You can also open the tool directly:

o Click the Theme Editor tool button.
e Select Theme Editor in the Toolbox menu.

With these two methods, if a theme clip is currently
selected in the Movie Window, it is automatically
loaded into the editor upon opening. While the editor is
open, clicking on a different theme clip in the Movie
Window changes the preview to that clip without
closing the editor.
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Using the Theme Editor tool

Each theme template has its own set of slots for video
and photo content, represented by “drop zones” in the
Theme Editor. Most templates have at least one of
these; the maximum is six. Some also provide text
captions and other parameters as required to customize
special features.

The Theme Editor is split down the middle into two
parts. On the left, a mini-Album provides access to
your video and still image libraries; on the right is a
customization panel. Here are the drop zones for your
video and images, along with any text fields or other
controls required by template parameters.
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The left side of the Theme Editor tool contains a
mini-Album with tabs for Videos and Photos only.
The right side contains the theme clip’s drop zones,
and controls for setting its parameters. Drag video
or image clips onto a drop zone from either the mini-
Album or the Movie Window. If necessary to create a
longer subclip, you can also select multiple clips of
contiguous video and drag them to the zone as a unit.
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Working with drop zones

Clearing drop zones: To delete a subclip from its drop
zone, right-click the zone and select Delete from the
pop-up menu.

Copying subclips to the Movie Window: To copy a
subclip from a drop zone in the Theme Editor to the
Timeline (or other Movie Window view), right-click
the zone and select Add to Timeline from the menu.
This is normally used to add or modify an effect on the
subclip before dragging it back into the theme clip.

Muting subclip audio: Some drop zones are marked
with an audio symbol ER, indicating that the audio
portion of any video in that zone will be included in the
theme clip’s audio. If you don’t want the audio to be
used, click the audio symbol to mute &l the subclip.

3 o 1 |
22 3 =

Text 1: Your Text Here
Text 2 Your Text Here
Caolar:

To set the start frame of a subclip, hold down the left
button with the pointer over the drop zone, then drag
horizontally. To allow fine trimming, the amount of
change produced by a given mouse movement is at
first small then becomes rapidly greater with
distance. A relatively large mouse gesture may
therefore be required to get a desired adjustment.

Aligning subclips: Video in a drop zone can be
positioned relative to the zone’s time window with the
mouse. When the mouse pointer enters a drop zone
with excess video available, it changes into a double-
headed arrow. Click and hold the left mouse button
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now to control the start of clip slider below the zone.
Move the mouse back and forth to set the start frame.

As you scroll the start of clip slider, the icon in the
drop zone is updated to show the new starting frame.
At the same time, the Player shows the frame at the
current scrubber position. If the drop zone you are
working with is active at that time index, the preview
will reflect any changes to the start frame. When you
are fine tuning the start frame of a subclip, it’s a good
idea to set the scrubber position to the location where
the Player preview will be of the greatest assistance.

Using the start of clip slider changes neither the
position of the subclip within the theme clip, nor its
duration. Rather you are only choosing which excerpt
of the subclip is used. The Theme Editor does not allow
you to set the start of the subclip so late that the video
would run out while the drop zone is still active. For
example, if you drop a six-second segment onto a drop
zone requiring five seconds of video, you will be able
to set the start point up to one second into the subclip.

If the subclip is actually shorter than the drop zone’s
duration, or of equal length, no adjustment of its start
frame is possible. When the theme clip displays, the
last frame of the subclip is frozen if necessary to fill the
time allocated to its drop zone.

Adding effects within drop zones

It is not possible to apply video or audio effects to a
subclip within the Theme Editor itself. Instead, right-
click the drop zone and select Add to Timeline from the
pop-up menu. Locate the clip on the Timeline (at the
scrubber position). From now on, it’s just another clip:
trim it to taste, and add or edit effects as usual. Finally,
drag it back to the drop zone, overwriting the previous
contents. The Timline copy can now be deleted.
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Video effects

Most video editing consists of selecting, ordering and

trimming video clips,

of connecting clips with

transition effects and combining them with other
materials such as music and still images.

Sometimes, though, you also need to modify the video
images themselves, manipulating them in some way to
achieve some desired effect. Studio’s Video effects tool
provides an extensive set of plug-in video effects that
can be applied either to video or still images. See page
136 for descriptions of Studio’s supplied effects.

The Video effects tool is the eighth tool in the
Video toolbox. It has two main areas: at left, an

-

effects list showing which effects are already attached
to the current clip(s), and at right, a parameters panel
where you can tune the effect as required.
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Video effects vs. audio effects

In most respects, the Video effects tool and the Audio
effects tool work identically, except for the type of
material they apply to.

_________________
Working with the effects list

Each video or image clip in your project can be
modified by one or more video effects. Each effect is
applied to the original image in turn, in the order in
which they are listed on the Video effects tool.

=0 Wideo Effects

= = Auto Color Correction
|D * Water Drop

= €2 Soften

The checkboxes next to each effect name allow you to
enable and disable effects individually without having
to remove them from the list (which would cause any
customized parameter settings to be lost). In the above
illustration, the “Speed” effect has been disabled while
the other two effects on the list remain in force.

Adding and deleting effects

To add an effect to the list for the © aqq new Efect )
current clip, click the Add new ’
effect button, which opens an effects browser on the
right-hand side of the tool window.

Click an item in the browser’s Category list to display
the names of the individual effects in that category.
Select the effect you want, then click the OK button to
add the effect.

126 Pinnacle Studio



To remove the currently-selected effect from
the list, click the delete effect (trashcan) button.

Add Video Effect
Category Effect
Standard RTFX [@l Chrama Keyer "~
[5tudin Plus RTFX | | @ Luma keyver
Free with Registration (@ Picture-in-Picture
RTFX Yalume 1 },’.} 20 Editar
7% More Effects... i EarthQuake
|}* Lens Flare [,
},‘.'k Magnify "
),':k Muotion Blur
‘;ﬁ Water Drop
e \niatariiawa v
(0124 Cancel

The Video Effects browser is open here to the Studio
Plus RTFX page, which contains an additional set of
effects for Studio Plus. The other packs listed contain
other premium effects requiring separate purchase.
The last ‘category’, More Effects, opens a page on
the Pinnacle web-site where additional premium
effects are available.

Premium video and audio effects, like other locked
content in Studio, can be used freely, but cause a
“watermark™ graphic to be added to the video when
played back. If you want to use the effect in an actual
production, you can purchase an activation key without
leaving Studio. For information about purchasing
locked video and audio effects, and other premium
content for Studio, see “Expanding Studio” on page 11.

Changing the order of effects

The cumulative result of using more than one (@
effect on the same clip can vary depending on the E
order in which the effects are applied. With the

up and down arrow buttons to the right of the effects
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list, you can control the position of each effect in the
processing chain. The buttons apply to the currently-
selected effect.

Changing effect parameters

When an effect is selected in the effects list, the
parameters panel on the right-hand side of the Video
effects tool window provides controls for adjusting the
effect’s parameters, if any.

('_7\' Water Drap Presets: | Big Drop =l
Progress j
Progress = 'D
Drop Position
Horizantal = 'D
Yertical = o]
Waves
Wiigwe Calint L | j
Add Delete 4|1 p |0:00:00.00 :
& Use keyframes [ Reset )

The controls for the basic library of effects supplied
with Studio are described below (beginning on page
138). Add-on effects are described in their own on-line
documentation, which you can access from the
parameters panel by pressing function key F1 or
clicking the help button(z) at the top left of the
parameters panel.

Note: Some plug-in effects may provide their own
parameter windows with specialized controls. In those
cases, the parameters panel on the effects tool displays
a single Edit button, which accesses the external editor.

Pinnacle Studio



Using parameter presets

In order to simplify the use of parameters, many effects
offer presets that let you configure an effect for a
particular use simply by selecting a name from a list.

In Studio Plus, there are two kinds of preset: static,
which store a single set of effect parameters, and
keyframed, which store multiple sets of parameters in
the form of keyframes (see below).

(2) Pan And Zaom Presets: | ]
Toom = Static Presets
Pan And Zoam
Harizantal Pasiti... B | Keviramed Presets
Small Zoomer
Wertical Position - Big Zoom
PanAcross I~

Reduce flickering & Pan Down

Pan Caorners

In versions of Studio that do not support keyframing
only static presets are available.

Often, the quickest way to configure an effect is to start
with the preset that comes closest to what you want,
then fine-tune the parameters by hand.

Resetting effects: A special type of preset Reset

is the factory default setting of each effect.

The default can be restored at any time by clicking the
Reset button at the bottom of the parameters panel.

If Reset is clicked when keyframing is in use, the
default parameter values are assigned only to the
keyframe at the current movie position. That keyframe
is created if it did not already exist.
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Keyframing

The parameters for Studio video effects are ordinarily
applied at the first frame of the video clip and continue
unchanged to its end. This is the standard behavior for
each effect you add to the clip.

(2) Pan And Zoom Presets: | 1 =l
Zoom | [~ I[70.00 70.00 70.00

Horizontal Positi... | ™) I[1000 ] [1000 ] [1ooo0 ]

wertical Position | = I[5.00 ] [so00 | [500 ]

Ordinarily, an effect’s parameter values do not vary
throughout the video clip the effect belongs to.

Keyframing — the ability to change parameter values
smoothly within a video clip — opens a wide range of
new possibilities for using effects in your movies.

Availability note: The keyframing feature described here is provided
in Studio Plus only.

Each keyframe stores a full set of parameter values for
the effect, and specifies at which frame within the clip
those values should be fully applied.

(2) Pan And Zoom Presets: | 1 |
Zoom | ™) 17000 45.00 26.00

Horizantal Positi.. | = I[10.00 ] [4000 | [1oa00 ]

vertical Position | = I[-5.00 ] [1500 | [-500 ]

With keyframing, new sets of parameter values can
be applied as often as desired throughout the clip.
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Between keyframes, numeric parameter values are
automatically adjusted from frame to frame to connect
the keyframe values smoothly.

A graphical view of the keyframes in the example
above. The values of Zoom (Z), Horizontal Position
(H) and Vertical Position (V) are set by keyframe 1
at the start of the clip, by keyframe 2 about a third of

the way in, and by keyframe 3 at the end. The values
change smoothly over intermediate frames.

Most effects support keyframing. A few do not, either
because they have no parameters or because, as with
the Speed effect, keyframing doesn’t readily apply.

Keyframing scenarios

Theoretically, a clip may have as many keyframes per
effect as it has frames, but you usually need only a few.

100)

Two keyframes are enough to smoothly vary parameter
values from one setting to another throughout the clip.
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Keyframing gives you sensitive control over the way
the effect is applied to the clip. It becomes a simple
matter to ease an effect in and out, for example.

. 7
A
D@ @@

With a set of four keyframes you can ease in one or
more parameter values at the start of a clip and ease
them out again at the end.

il

D @® @

A pan-and-zoom slideshow like that described in
under “Editing image clip properties” (see page
182) can be created using the Pan-and-Zoom effect
on a single still-image clip. Two keyframes with
identical parameters are created to define the start
and end of each view — however many are required —
within the show.
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Using keyframing

In the parameters window for any effect that supports
keyframing, locate and check the Use keyframes box.
Until you do this, the effect maintains a single set of
parameter values throughout the clip.

@) Fan And Zoom Presets: | |
Zoom f = '
Horizontal Positi... | = '
Vertical Position | ™ oo ]
Reduce flickering O

O Use keyframes Reset _‘.:'

When you switch on keyframing for an effect, two
keyframes are created automatically. One is anchored
to the start of the clip, and the other to its end. The
parameters for both are set to the non-keyframed value.
On the Movie Window timeline, a keyframe appears as
a numbered flag on the video clip. The keyframe flags
are displayed as long as the effect’s parameter window
remains open.

Keyframes for the effect currently open in the effect
parameters window are shown as numbered flags
over a vertical line. The current keyframe, if any, has
a highlighted flag, like that of keyframe 3 here.
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At the same time, additional controls are displayed at
the bottom of the parameters window: the Add and
Delete buttons, the Current keyframe indicator with
forward and back arrows, and the Keyframe time
counter with jog arrows.

Add Delete 1 p |(0:00:00.00

' Use keyframes Reget

New controls appear at the bottom of the parameters
window when keyframes are enabled.

The Current keyframe indicator shows the [z |»
number of the keyframe attached to the frame

you are viewing in the Movie Window. Use the arrows
to advance from keyframe to keyframe. As you click,
the Movie Window scrubber jumps to the next
keyframe position.

When you are viewing frames of your movie for which
no keyframe has been defined, the indicator shows a
dash. The displayed parameter values are those that
will apply to the current frame during playback.

To create a keyframe at any such point, click the Add
button, or simply start to adjust the parameters: when
you do, Studio adds a keyframe automatically.

& Use kevfra%es Reset

Add Delete 4| |[» |0:00:03.00 ‘

Keyframes are numbered in sequence from the start of
the clip. When a new keyframe is inserted, or an old
one is deleted, those that come after are renumbered to
correct the sequence.

-

Add Delete [%44 po(0:00:03.00( &
& Use keyframes

Reset
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The Delete button is available whenever the current
frame has a keyframe; that is, whenever the Current
keyframe indicator shows a number rather than a dash.

The Keyframe time counter shows the time offset
within the clip of the current movie time — the frame
showing in the Player. The first keyframe is therefore at
time zero, and the last is at an offset equal to one frame
less than the duration of the clip.

When the current frame has a keyframe, its time offset
can be changed with the counter’s jog arrows. The
positions of the first and last keyframes cannot be
adjusted. Others can move freely between the current
positions of their neighboring keyframes.

Add Delete 4|3 p |0:00:02.16 %

' Use keyframes Reget

Setting the time of keyframe 3.

Previewing and rendering

While you are working with the Video effects tool,
choosing effects and adjusting parameter settings, the
Player gives a dynamically-updated preview of the
current frame in your movie. Previewing a single frame
may not be very revealing when you are working with
effects that evolve over the duration of the clip (like the
Water drop effect, page 146). In those cases, you will
need to play back the clip to see the full impact of the
effect you are applying.

Because many effects require intensive calculation, a
fully smooth and detailed preview of the full clip won’t
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be instantaneously available in most cases. Each time
effects are added or removed, or settings are changed,
Studio commences “rendering” the clip — recalculating
its final appearance — in the background without
interrupting your workflow. A colored bar appears in
the Timescale above the clip while background
rendering is in progress.

Background rendering is optional. You can disable it, if
required, in the Project preferences options panel
(Setup > Project Preferences).

¥ VIDEO EFFECTS LIBRARY

The plug-in video effects installed with Studio are
divided into six categories, each symbolized by an
icon:

e Cleaning effects help correct defects in the &y
source video, such as noise and camera shake.

e Time effects, like Speed in Studio Plus, change &
the tempo of playback without affecting the
appearance of the video frames themselves.

o Style effects like Emboss and OId film let you &»
apply distinctive visual styles for added impact.

e Overlay effects support the overlay features of (o
Studio Plus, such as Picture-in-picture and Chroma
key.

e Fun effects like Water drop and Lens flare &
provide extra scope for creative fun in your movies.

e Color effects let you modify the coloration ofa £»
clip, whether subtly or dramatically.
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Plug-in effects are organized into packs of one or more
effects each. In this manual, we cover the five effects in
the Standard RTFX pack (see page 138), which is
included with all versions of Studio. Further on, we
briefly describe the more than 20 additional effects in
the Plus RTFX included with Studio Plus (page 140).

Full documentation of the parameters for the Plus
effects is included in their context-sensitive on-line
help, which can be viewed by clicking the help
button (2) at the top left of the effect parameters panel,
or by pressing the F1 key when the panel is open.

Building your effects library

Studio’s plug-in architecture means that you can
continue to add new effects to your video effects
library as they become available. Expansion packs of
effects from Pinnacle and other vendors will integrate
seamlessly with the program.

Some expansion effects are shipped with Studio as
locked, premium content. These include Pinnacle’s
RTFX Volume 1 and 2 packs. Such effects can be
previewed in Studio as usual, but are “watermarked”
with a special graphic during playback.

Purchasing an activation key will remove the
watermark. This can be done without leaving Studio.
For more information about obtaining premium content
for Studio, see “Expanding Studio” on page 11.

Warning: Studio’s plug-in video effects are computer
programs. They are theoretically capable of actions
with the potential to damage or disrupt your system,
such as modifying or deleting files and editing the
system registry. Pinnacle advises against installing
third-party plug-ins except those from trusted vendors.
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¥ STANDARD EFFECTS

This section describes four of the five effects included
in the Standard RTFX group at the top the Studio
effects browser. The fifth, Pan and zoom, is covered
under “The pan-and-zoom effect interface” on page
188.

Auto color correction, Noise reduction and Stabilize are
classified as cleaning effects, which help correct
defects in the source video, such as noise and camera
shake.

Note: Studio’s video cleaning effects are general-
purpose filters designed to reduce the most common
problems found on a wide range of material. They are
not a panacea. Your results will vary depending on the
original material and the severity and nature of the
problems.

Auto color correction

This effect compensates for incorrect color balance in
your video. The idea is similar to the “white balance”
setting on a camcorder.

Brightness: Color correction may affect the brightness
of the image. You can apply a manual correction, if
needed, with this slider. (Technically, the control
modifies the “contrast gamma” of the image rather than
its actual brightness.)
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Note: The Auto color correction effect may introduce
video noise into the clip as a side-effect of processing.
If this happens to a troublesome degree, add on the
Noise reduction effect described below.

Noise reduction

This plug-in applies a noise-reduction algorithm that
may improve the appearance of noisy video. In order to
minimize artifacts (image defects caused as a side-
effect of image processing), noise reduction is only
performed in areas of the frame where the amount of
motion falls beneath a certain threshold value.

Motion threshold: This slider governs the threshold
value. Moving the slider rightwards increases the
amount of motion the effect will tolerate, thus tending
to increase the proportion of the image that will be
affected. At the same time, the danger of introducing
unacceptable artifacts into the video is also increased.

Stabilize

Like the electronic image stabilization feature in many
digital camcorders, this effect minimizes any jerkiness
or jitter caused by camera movement. The edge areas of
the image are discarded, and the central portion is
magnified by about 20% to fill the frame. By adjusting
the boundaries of the selected region on a frame-by-
frame basis, Studio is able to compensate for the
unwanted camera motion.
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Studio’s Stabilize effect works by expanding a
selected area (inner lines) to full-frame size. The
area is adjusted from frame to frame to compensate
for slight aiming differences caused by camera
shake.

Speed

This sophisticated effect allows you to set the speed of
any video clip over a continuous range from 10 to 500
percent of normal, in either forward or reverse motion.
The length of the clip changes as you vary its speed.

If the clip contains audio, that too is sped up or slowed
down. The option of maintaining the original pitch lets
you avoid the sudden introduction of cartoon voices
into your soundtrack.

& PLUS EFFECTS

The Studio Plus RTFX pack of video effects is
included with Studio Plus. Users of other Studio
versions can obtain the effects by upgrading to Studio
Plus.
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This section gives a brief description of each effect in
the group, except:

e Two of the Overlay effects are covered elsewhere
(Chroma key on page 164, and Picture-in-picture on
page 159).

e The HFX Filter effect, which allows you to create
and edit animated 3D transitions with Pinnacle’s
Hollywood FX software, opens externally to &
Studio, and provides its own on-line help. HFX
Filter uses a special Pinnacle category icon.

The effects appear here in the same order as they do in
the effects browser, where they are sorted by category
(see page 136). Full descriptions, including all
parameters, are available in the context-sensitive help
when the effect parameters window is open in Studio
Plus.

Blur

Adding blur to your video produces a result similar to
shooting out of focus. Studio’s Blur effect allows you
to add separate intensities of horizontal and vertical
blurring over the whole frame or any rectangular region
within it.

You can easily blur out only a selected portion of the
image, such as a person’s face, an effect familiar from
TV news coverage.
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Emboss

This specialized effect simulates the look of an
embossed or bas-relief sculpture. The strength of the
effect is controlled by the Amount slider.

Emboss can ften be enhand by adjusting contrst
and brightness with the Color Correction effect (right).

T
Old film

Old movies have a number of traits that are usually
considered undesirable: grainy images caused by early
photographic development processes, spots and streaks
from dust and lint adhering to the film, and intermittent
vertical lines where the film has been scratched during
projection. The Old film effect lets you simulate these
defects to lend your pristine video the appearance of
movies that have suffered the ravages of time.
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Soften

The Soften effect applies a gentle blurring to your
video. This can be helpful for anything from adding a
romantic haze to minimizing wrinkles. A slider controls
the strength of the effect.

Stained glass

This effect simulates the appearance of viewing the
video through a pane of irregular polygons arranged
into a mosaic.

Sliders let you control the average dimensions of the
polygonal “tiles” in the image and the width of the dark
edging between neighboring tiles from zero (no edging)
to the maximum value.

Thr

0000000000000
Luma key

This overlay effect works very similarly to Chroma
Key (page 164), but in this case the transparent areas of
the foreground image are defined by luminance rather
than color information.
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2D Editor

Use this effect to enlarge the image and set which
portion of it will be displayed, or to shrink the image
and optionally add a border and shadow.

Earthquake

The Studio Plus Earthquake effect jiggles the video
frame to simulate a seismic event, whose severity you
control with sliders for speed and intensity.

Lens flare

This effect simulates the flaring seen when direct bright
light overexposes an area of a film or video image.

You can set the orientation, size and type of the main
light. The first option of those shown below lets you
remove the light, though its secondary effects — rays
and reflections — are still generated.

BN
The ei

ight Type options.

D
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Magnify

This effect lets you apply a virtual magnifying lens to a
selected portion of the video frame. You can position
the lens in three dimensions, moving it horizontally and
vertically within the frame, and nearer to or further
from the image.

Motion blur

This effect simulates the blurring that results when a
camera is moved rapidly during exposure. Both the
angle and the amount of blurring can be set.

Rotate

This effect allows rotation of the entire video frame,
and also provides controls for independent horizontal
and vertical scaling.

Full-frame 180° rotation (L); rotation with differential
scaling, to produce a simple perspective effect (R).
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Water drop

This effect simulates the impact of a drop falling onto
the surface of water, producing expanding, concentric
ripples.

Stages in the Water Drop effect (““Big drop™ preset).

Water wave

This effect adds distortion to simulate a series of ocean
waves passing across the video frame as the clip
progresses. Parameters allow you to adjust the number,
spacing, direction and depth of the waves.

Black and white

This effect subtracts some or all of the color
information from the source video, with results ranging
from partly desaturated (the “Faded” preset) to fully
monochrome (“Black and white”). The Amount slider
controls the strength of the effect.
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Color correction

The four sliders in the parameters panel for this effect
control the coloration of the current clip in terms of:
Brightness: The intensity of light

Contrast: The range of light and dark values

Hue: The location of light on the spectrum

Saturation: The quantity of pure color, from gray to
fully saturated

Color map

This effect colorizes an image using a pair of blend
ramps, or color maps. Stylize your footage with bold
color treatments, add duotone and tritone style
colorization, or create striking editorial transitions.
Color map can be used for anything from fine control
of monochrome images to psychedelic color
transformations.

Invert

Despite its name, the Invert effect doesn’t turn the
display upside-down. Rather than the image itself, it is
the color values in the image that are inverted: each
pixel is redrawn in its complementary light intensity
and/or color, producing a readily recognizable but
recolored image.
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This effect uses the YCrCb color model, which has one
channel for luminance (brightness information) and two
channels for chrominance (color information). The
YCrCb model is often used in digital video
applications.

Lighting

The Lighting tool enables correction and enhancement
of existing video that was shot with poor or insufficient
lighting. It is particularly suitable for fixing backlit
outdoor sequences in which the subject’s features are in
shadow.

Posterize

This Studio Plus effect lets you control the number of
colors used to render each frame of the clip, all the way
from the full original palette down to two colors (black
and white) as you drag the Amount slider from left to
right. Regions of similar color are coalesced into larger
flat areas as the palette shrinks.

RGB color balance

RGB Color Balance in Studio Plus serves a dual role.
On the one hand, you can use it to correct video that
suffers from unwanted coloration. On the other, it
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allows you to apply a color bias to achieve a particular
effect. For example, a night scene can often be
heightened by adding blue and slightly reducing overall
brightness. You can even make video shot in daylight
look like a night scene.

Sepia

This Studio Plus effect imparts the appearance of
antique photography to the clip by rendering it in sepia
tones rather than full color. The strength of the effect is
controlled with the Amount slider.

White balance

Most video cameras have a “white balance” option for
automatically adjusting their color response to ambient
lighting conditions. If this option is switched off or not
fully effective, the coloration of the video image will
suffer.

Studio’s White balance effect corrects the problem by
allowing you to specify which color should be taken as
“white” in this image. The adjustment needed to make
that reference color white is then applied to every pixel
of the image. If the reference white is well chosen, this
can make the coloration seem more natural.
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CHAPTER 8.

Two-track editing
with Studio Plus

Studio Plus brings the power of multitrack video
editing to Studio with the addition of an auxiliary video
track on the Movie Window Timeline called the
overlay track. Now you can use advanced picture-in-
picture and chroma-key effects while retaining the
convenience of Studio’s streamlined and intuitive user
interface.

0000000000000
Introducing the overlay track

Upon installation, the Timeline displays the five tracks
familiar to long-time Studio users: the video track with
its original audio track, and the title, sound effect and
music tracks.

To open the overlay track, drag a video clip from the
Album © into the Movie Window and drop it on the
title track @®. The overlay track instantly appears with
the clip properly positioned upon it ©.
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T

Drop video on the title track to open the overlay track.

Along with the overlay track, Studio adds an overlay
audio track to accommodate the video clip’s original
audio information.

Once the overlay video and audio tracks have been
opened, Studio no longer accepts video clips on the title
track. Drag clips from the Album directly onto either
the video or overlay track as required.

Video clips on the video and overlay tracks.

Displaying and hiding the overlay track

As we have just seen, the overlay video and audio
tracks are displayed when you add your first overlay
clip. Similarly, when you remove the last clip from
these tracks, Studio again hides them from view.

This default behavior help keep the Movie Window
uncluttered, but if you are making frequent use of
overlay video, you might prefer to have the track
visible at all times. This can be achieved by activating
the Always show overlay track command on the pop-up
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“context” menu that appears when you click on the
Movie Window with your right mouse button.

v Clip Properties
130 ko Title/Menu Editar
Always show overlay brack P

=1 B cmnh ar

00|
A/B editing

The second video track in Studio Plus often simplifies
the editing tasks — insert edits, L-cuts and J-cuts —
discussed under “Advanced Timeline editing” on page
98.

An insert edit, for instance, becomes a trivial operation:
simply drag the clip to be inserted onto the overlay
track, and trim it as desired. (See “The Picture-in-
picture tool” below if you want the second video to
appear at reduced size so that only part of the main
video is obscured.)

= o] Come and go *

An insert edit on the overlay track. The main video is
obscured while the B clip is playing.
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In the J-cut and the L-cut, the audio portion of a clip
begins a little before (J) or a little after (L) the video.
They are often used together to soften the start and end
of an inserted clip.

"E: ]2 Come and go *

Split editing on the overlay track. The overlay video
track has been locked, allowing the B clip’s audio to
be trimmed. The main audio can be reduced or
muted as needed.

The Picture-in-picture tool

Picture-in-picture (often abbreviated to “PIP”) — the
inclusion of an additional video frame within the main
video — is a versatile effect familiar from its use in
professional TV productions.
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Picture-in-picture with optional border, shadow and
rounded corners (left). Split-screen effects, like the
vertical split at right, are among the variations that
show off the versatility of the PIP tool.

To use picture-in-picture, start in the usual way by
dragging some video clips onto the Movie Window
Timeline. Drop the clips you want for background
video onto the video track. The foreground clip — the

PIP clip — goes on the overlay track underneath the
main clip.

Note: If you are planning a split-screen effect, like the
one shown at right in the illustration above, it doesn’t
matter which of the two clips goes on which track.

With the clips in place, select the foreground clip | g
and open the Picture-in-picture and Chroma key
(PIP/CK) tool. It is the seventh tool in the Movie
Window’s video toolbox.

We usually refer to the two aspects of the tool
separately as the Picture-in-picture and the Chroma key
tools.
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The Picture-in-picture and Chroma key (PIP/CK)
tool is really two tools in one. Because they are used
independently, we treat them as separate tools. This
illustration shows the PIP side of the tool. Click the
Chroma Key tab at the top of the tool to switch.

Picture-in-picture tool controls

Most of the left-hand side of the PIP tool is taken up
with an interactive layout area where you can both
view and modify the dimensions, placement and
cropping of the overlay video. The adjustments that

you make are reflected in the Player preview as you
work.

The layout area has two modes, selected by the Scale
and Crop radio buttons.

Scale mode: The gray, checked region in the layout
area represents the transparent portion of the overlay
frame, through which any underlying video can be
seen. In typical PIP usage, this accounts for most of the
screen, the overlay being sized small enough that the
main video is not unnecessarily obscured. You can
modify the PIP frame in three ways:

e Click on the PIP frame and drag it within the layout
area to reposition it within the main video frame.
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o Use the center control points on the edges of the PIP
frame to change its dimensions arbitrarily.

e Use the control points at the corners of the PIP frame
to change its size but not its proportions (“aspect
ratio”).

Crop mode: In this mode the layout area represents the
entire overlay frame, regardless of its actual dimensions
as set in Scale mode. The rectangle defined by the
control points shows which portion of the frame is
visible. QOutside the visible area, the frame is semi-
transparent, letting the checked pattern show through.

As in Scale mode, the side control points allow for free
adjustment of the crop rectangle, whereas the corner
control points preserve its aspect ratio.

® Scale O Crop O Scale @ Crop

The PIP tool in Scale (L) and Crop (R) modes.

Presets: Choose a preset name to set up all the PIP
controls at once to the predetermined values associated
with that name. You can choose a preset as a first
approximation to your desired settings, then adjust
them manually until you get exactly what you want.

Transparency: Use this slider if you want the
underlying video to show through the overlay itself.
Moving the slider to the right makes the overlay, with
its border and shadow, increasingly transparent.
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Border: These controls set the  — Border
color, width and transparency m
of the border that will be drawn
around the overlay frame. Set Width

the width to zero (slider all the ol . is

way to the left) if you don’t | [raneearency
want a border at all. See page | zitnees -
167 for information on how to | Iz @ v

use the color controls.
& Rounded cormers

The Softness slider controls the
amount of blurring on the outside edge of the border.
Move the slider left for a hard edge, or right to blend
the border with the background video. Check the
Rounded corners box if you want to round off the
corners of the PIP rectangle.

Shadow: These controls setthe  — shadow———
color, width, angle and _ I:l
transparency of the drop o=
shadow effect that gives the Distance ~ —
illusion of the overlay frame ol = —
floating above the background Transparency

video. Set the width (using the | ™ - -

Distance slider) to zero if you
don’t want a shadow to appear.

The dial-shaped shadow-angle control gives you eight
choices for the placement of the shadow relative to the
frame.

Enable picture-in-picture: This checkbox allows you
to turn the PIP effect on and off.

Apply to new clips: This option is handy when you
want to set up the same PIP settings for a number of
different clips. As long the option is checked, PIP will
automatically be applied to each new clip that you drag
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onto the overlay track, using the same settings that
were displayed the last time the tool was open.

The PIP effect interface

If you prefer to enter your PIP parameter settings
numerically rather than graphically, you can turn to an
alternative interface provided by the Video effects tool.
You can also combine the two methods, using the PIP
tool’s graphical interface to specify the initial settings,
then fine tuning them with the numerical effect
parameters.

The available parameter settings of the Picture-in-
picture effect are almost identical to those offered by

the PIP tool:
'/‘" Picture-in-Picture Presets: | j
Position d
Haorizontal ==
Wertical =
Size

Wiidth =

Height =
Cropping

Tnn - n ﬂ
O Use keyframes Reset

Parameter settings for the Picture-in-picture effect.

Position: The Horizontal and Vertical sliders set the
offset of the center of the PIP frame from the center of
the background frame.

Size: The Width and Height sliders set the size of the
PIP frame as a percentage of its original dimensions.
Cropping, if used, can further reduce the final size of
the PIP frame on the screen.
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Cropping: The four sliders in this group trim away a
percentage of the original PIP video frame, allowing
you to remove unnecessary portions of the image and
focus on the main subject.

Video: The Transparency slider lets the background
video show through the PIP overlay to any desired
degree.

Border: The parameters in this group are equivalent to
the Border settings on the PIP tool, allowing you to set
the overlay border’s color, thickness, transparency and
edge softness, and to select the rounded corners option
if desired. One bonus of the effect interface is that there
are separate Width and Height controls to control the
border thickness, rather than the single setting provided
by the tool.

Shadow: As with the Border group, these parameters
are essentially the same as those on the PIP tool, except
that the Horizontal offset and Vertical offset parameters
afford slightly more flexibility in positioning the
shadow than do the tool’s Distance and Angle settings.

The Chroma key tool

Chroma key is a widely-used technique that allows
foreground objects to appear in a video scene even
though they were not present — and often could not
have been present — when the scene was shot. When an
action star tumbles into a volcano, or battles a giant
cockroach, or saves the crew with a daring space-walk,
the chances are that chroma key or a related technology
was involved in the scene.

Pinnacle Studio



Chroma key effects are often called “blue-screen” or
“green-screen” effects because the foreground action is
shot in front of a uniform blue or green background.
The background is then electronically removed, leaving
only the foreground action to be superimposed on the
actual background of the final scene, which has been
separately prepared.

Blue and green are the generally-preferred colors for
chroma key use because their removal from an image
will not affect human skin tones, but in principle any
hue can be used with Studio’s chroma key tool.

10 & 2 = el O
i i L0

Creating a scene with chroma key: A clip on the
video track (L) is chosen as the background for a
green-screen clip on the overlay track (C). Chroma
keying removes the green to complete the scene (R).

As with picture-in-picture, the first step in using
chroma key is to drag some video clips onto the
Timeline. Drop the clips you want for background
video onto the video track. The foreground clip, which
should have a uniform, highly-saturated background
like the center clip in the illustration above, goes on the
overlay track below the main clip.

‘E With the clips in place, select the foreground clip

and open the Picture-in-picture and Chroma key
(PIP/CK) tool. It is the seventh tool in the Movie
Window’s video toolbox. Select the Chroma key tab to
display the controls you will need.
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The chroma key side of the PIP/CK tool.

Chroma-key tool controls

The chroma key tool constructs a “mask”, shown in the
Key channel graphic on the left side of the tool, where
the transparent part of the frame is drawn in black, and
the opaque part — the part you will see in the final video
— is drawn in white. Most of the remaining controls are
used to define exactly which areas of the frame will be
included in the transparent part of the mask by setting
the “key color” and related properties.

Transparency: Use this slider if you want the
underlying video to show through the normally opaque
overlay. Moving the slider to the right makes the
overlay, and its border and shadow, more transparent.

Presets: The tool provides two presets, called “Green
screen key” and “Blue screen key”. These provide good
starting points for setting up the tool if you are using
one of the standard chroma key colors.

Key color: Use the color swatch or eye dropper buttons
to select the color that will be removed from the video
frame leaving only the desired foreground. See page
167 for information on how to use the color controls.

Rather than an actual color, you are really selecting
only a hue, without regard to the other properties —
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saturation and intensity — that in combination with hue
make a complete color specification. The chosen hue is
shown by the position of the highlighted region on the
circumference of the color circle display.

The color circle on the Chroma key tool highlights a
range of hues (around the circumference) and color
saturation values (along the radius). Any pixel in the
overlay frame whose hue and saturation fall within
the highlighted region will be treated as transparent.

Color tolerance: This slider controls the width of the
range of hues that will be recognized as belonging to
the “key color”. Moving the slider to the right increases
the angle of the arc covered by the highlighted region
on the color circle.

Saturation minimum: Saturation is the amount of hue
in a color. A pixel with zero saturation (corresponding
to the center of the color circle) has no hue: it falls on
the “gray scale”, whose extremes are white and black.
Chroma key works most effectively when the
background is highly and uniformly saturated, allowing
a high setting of this slider. In the real world, vagaries
of lighting and apparatus often result in a background
that falls short of the ideal. Moving the slider left
allows a wider range of saturation values to be
matched, indicated by a highlighted region that extends
farther towards the center of the color circle.
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Softness: This slider controls the density of the
underlying video. When it is all the way to the left, the
main video is entirely black. As you move the slider to
the right, the main video is brought up to full density.

Spill suppression: Adjusting this slider may help
suppress video noise or fringing along the edges of the
foreground object.

Enable chroma keying: This checkbox allows you to
turn the chroma key effect on and off.

Apply to new clips: This option is handy when you
want to set up the same chroma key settings for a
number of different clips. As long as the option is
checked, chroma key will automatically be applied to
each new clip that you drag onto the overlay track,
using the same settings that were displayed the last
time the tool was open.

The chroma key effect interface

If you prefer to enter your chroma key parameter
settings numerically rather than graphically, you can
turn to an alternative interface provided by the Video
effects tool. You can also combine the two methods,
using the chroma key tool’s graphical interface to
specify the initial settings, then fine tuning them with
the numerical effect parameters.

The Studio Plus Chroma key plug-in provides
parameter settings almost identical to those offered by
the chroma key tool, but provides one more option,
Invert Key. When this option is activated, the normally
opaque parts of the key are treated as transparent, and
the transparent parts as opaque, so that the underlying
video shows through everywhere except for the area
masked by the colored screen.
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Parameter settings for the Chroma key effect.
The chroma key tool lets you inspect its transparency

key. To get this view in the Player while working with
the effect parameters, click the Show Key checkbox.
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Using Show Key: At left the key, at right the real thing.

Chroma key tips

No matter how good your software may be, successful
use of chroma key depends on carefully setting up your
shot, and may require experimentation to get the details
just right. Here are some tips to get you started:

Light the backdrop as evenly as possible: Very often,
background coloring that looks flat to the naked eye
will prove on playback to have areas that are too dark
or too washed out to work well for chroma keying,
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which favors even, saturated color. Use multiple lights
on the backdrop to ensure that it is well-lit across its
whole area and without hotspots. Diffuse sunlight, as
produced by a light overcast sky, can work well when
shooting out of doors is an option.

Note: A professional background cloth for chroma key
work is available for purchase at the Pinnacle web-site.

Don’t let the subject shadow the screen: Arrange
your subject and foreground lighting to avoid shadows
across the backdrop. The subject should be not less
than one meter (three feet) in front of the backdrop.

| BLUE OR GREEN BACKDROP |

Subject's
Minimum shadow

3ft/1m. doesn't
l reach
—————— backdrop
SUBJECT,

Setting up a chroma key shot. The backdrop is well
and evenly lit, and well behind the subject to prevent
shadows. The lighting of the subject should suit the
background that will be keyed into the shot.

Choose foreground colors carefully: Don’t have your
subject wear green if you are shooting on a green
screen, or blue for a blue screen; those areas will be
removed if they are taken to match the key color. You
have to be especially careful about this when working
with less even backdrops that require you to set a wider
color tolerance in the chroma keyer.

Make a smooth profile: Chroma keyers do better with
a smooth edge than a jagged or complex one, so try to
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have your subject present a smooth profile to the
camera. Hair is particularly tricky, and should be
slicked down if possible. If the subject can wear a hat,
so much the better.

Use tight framing: The wider your frame, and thus the
larger your background, the harder it is to control your
shot. One way to keep things simple is to shoot your
subject from the waist up rather than in full view.

Selecting colors

[l # To select colors in tools and effects that

provide a color parameter, click either on the
color swatch (left) or the eye dropper button. The first
opens a standard color picker dialog; the second lets
you choose a color by clicking anywhere on the screen.

Color
Basic colors:
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Two ways to set colors: The Windows color picker
dialog (L) opens when you click the color swatch
button provided in some tools and effects. Click the
eye-dropper button to select a color from the Player
preview window or elsewhere using a mouse pointer
in the form of an eye-dropper (R).
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CHAPTER 9:

Transitions

A transition is an animated effect that eases — or
emphasizes — the passage from one clip to the next.
Fades, wipes and dissolves are common types of
transition. Others are more exotic, and may even
involve sophisticated 3-D graphics.

Transitions are stored in their own section of the
Album (see “The Transitions section” on page 55). To
use a transition, drag it from the Album into the Movie
Window and drop it beside any video clip, theme clip
or still image. (You can also apply transitions directly
to audio clips. See “Transitions on the audio tracks” on
page 247.)

A series of transitions (the icons between the video
clips) in Storyboard view.

In Timeline view, you can drop the transition on either
the main video track, the overlay track, or the title
track. On the video track, the transition provides a

Chapter 9: Transitions 169



170

bridge between two full-screen clips (or between one
clip and blackness if the transition has only one
neighbor, as at the beginning of the movie). On the
overlay and title tracks, the transition bridges two
neighboring clips (or one clip and transparency).

0.0s 0.5s 1.0s 1.5s 2.0s
Diagram: Five snapshots from the life of a 2-second
diagonal wipe transition.

If a transition is to last for two seconds (the default
transition duration in a fresh Studio installation), the
second clip begins to run two seconds before the first
clip is finished. At the outset, only the first clip is
visible; by the end, the second clip has completely
replaced the first.

The details of what happens in between, as the first clip
is gradually removed and the second gradually appears,
depend on the transition type. Since the video clips
overlap, the total duration of the pair of clips is reduced
by the duration of the transition.

Here is the same transition as above, this time using
actual video. For clarity, the transition boundary in
the three center frames has been emphasized in
white. Both clips continue to run while the transition
is in progress.

Pinnacle Studio



I——_—_—_——
Transition types and their uses

Like all effects, transitions should be used not for their
own sake but to serve the overall needs of your movie.
Well-chosen transitions can subtly reinforce the
meaning of the movie and how it plays without
drawing attention to themselves.

Observing the way transitions are used in
professionally-produced video on television will
suggest many ways to improve your own movies.
Generally, it is advisable to refrain from overusing
transitions that cause abrupt changes or otherwise draw
attention to themselves: there’s a big difference
between a subtle dissolve and a heart-shaped wipe.

The basic transitions discussed below - fades,
dissolves, wipes, slides and pushes — are all among the
first group of standard transitions (the “2D transitions™)
in the Album.

A set of more elaborate transitions is found in the
Alpha Magic group, which is the second entry in the
dropdown list of transition groups in the Album.

The many other groups on the list all belong to the
Hollywood FX, a large set of complex transitions
featuring three-dimensional graphics. The Hollywood
FX transitions are discussed at the end of this section
(page 173).

Cut: A cut is the minimal transition — an instantaneous
shift from one scene to the next. In Studio, it is the
default transition. A cut is appropriate when there is a
strong inherent connection between one clip and the
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next; for instance, when the camera changes position or
angle within a scene.

Fade: This transition fades into the beginning of |§‘
a video clip from a black screen, or from the end

of a clip to a black screen. A fade dropped between two
clips creates a fade down followed by a fade up. The
fade transition is the first transition icon in the Album.

A fade is usually used at the beginning and end of a
movie, or when there is a large break in continuity, as
when a new section begins. For example, a movie of a
play might benefit from inserting a fade between acts.

Dissolve: A dissolve is similar to a fade, except |;‘
that the new scene begins to fade up even while

the old one is fading down. The visual overlap this
produces is less dramatic than a fade, but less abrupt
than a cut. A short dissolve can take the edge off a cut,
while a long dissolve is useful to suggest the passage of
time.

Wipe, slide and push: In each of these ‘E|§‘ ‘

standard transition types, the incoming

video is gradually revealed behind an edge that moves
across the frame in a certain direction. The Album
icons shown with this paragraph represent a leftward
wipe, a down-and-left slide and a rightward push
respectively.

In a wipe transition, both the old and new video occupy
their normal position in the frame throughout the
transition. The new video comes into view as the
transition edge crosses the frame, rather like new
wallpaper being rolled on over old.

A slide is similar to a wipe, but in this case the frame of
the new video slides across the screen until it reaches
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its home position. The effect is reminiscent of a blind
being pulled down over a window.

A push is similar to a slide, except that the old video is
pushed out of the frame as the new video enters, like
advancing a filmstrip from one frame to the next.

Hollywood FX for Studio

| 187 |
LY

Pinnacle Systems’ Hollywood FX includes a
large number of dramatic 3-D transitions and
effects. These are ideal for opening sequences, sports
and action footage, or music videos. Hollywood FX
satisfies professional expectations for quality without
sacrificing ease of use.

A basic set of fully-functional Hollywood FX is
included with Studio, and many more are available for
purchase online. For more information, see “Expanding
Studio” on page 11.

Also available for purchase on-line is the HFX Creator
editing tool for Hollywood FX. This software lets you
customize your Hollywood FX, or create new ones
from scratch. HFX Creator includes advanced
keyframe editing for flight paths and all parameters,
powerful warp plug-ins, and a 3D text generator. You
can also create a wide range of 3D Multiwindow

Effects using external video sources,

Edi and add real-life 3D objects and
lighting.
™ Reverse To initiate the purchase of HFX

o.00.00.00 2| Creator, click the Edit button in the
we w » o| Clip properties tool for any
Hollywood FX transition.
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Previewing transitions in your movie

Studio lets you preview transitions in the Player. Just
drag and drop a transition into the Movie Window,
click the Play button (or hit [Space]) and see how the
transition works with your material.

You can also preview transitions by scrubbing through
them in the Player or on the Timeline of the Movie
Window.

Background rendering of Hollywood FX

Background rendering is an optional feature in which
the computation needed to create a detailed preview of
Hollywood FX transitions and other effects is carried
out as a “background task” with no interruption of your
workflow. You can configure background rendering on
the Video and audio preferences options panel (Setup
» Video and Audio Preferences). See “Video and audio
preferences” on page 290 for details.

Until the rendering of a transition is complete, the
Player will preview it at reduced resolution and frame
rate. A colored bar appears in the Timescale above the
clip while background rendering is in progress.

Audio transitions

Video clips in the Movie Window normally have
synchronous audio. In the absence of a transition, both
video and audio cut from one clip to the next. When a
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transition is placed between two clips, the audio cross-
fades (the audio equivalent of a dissolve).

The only exception to this rule is the Fade transition,
which takes the audio completely out then back in
again.

Normal transitions cause a cross-fade in
the audio (left). In a Fade transition
(right), the audio fades down then up
along with the video.

The Ripple Transition command

This Studio feature is especially useful for creating a
quick slideshow from a set of still images, or a video
pictorial from a set of short clips. Such a presentation is
more interesting if you connect each pair of clips with a
transition. Ripple Transition gives you a quick and easy
way of achieving that.

Begin with a set of a clips on the Timeline, then add a
transition of the desired type between the first two
clips.

Now select all the clips except the first, click on any of
them with the right mouse-button, and select Ripple
Transition from the pop-up menu.
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omoine cips

Find Scene in Albuni ——

Shiow Full picture
Zoom pickure to fill Frame

Ripple Transition %

Set Thurmbrail

Studio inserts a duplicate of the original transition
between each pair of selected clips.

® TRIMMING TRANSITIONS

Although transitions are not true clips, they are handled
very similarly to clips within Studio’s editing
environment. Like clips, you can trim transitions either
directly on the Movie Window Timeline, or by using
the Clip properties tool.

See “Trimming on the Timeline using handles” on page
89 for a discussion of the first method. The maximum
allowed duration of a transition is one frame less than
the shorter of the neighboring clips.
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Trimming with the Clip properties tool

The Toolbox » Modify Clip Properties menu |@
command invokes the Clip properties tool for

the selected clip. For all transition types, this tool
provides previewing controls, and the ability to set two
properties:

e To set the duration of the transition, change the value
in the Duration counter. A transition’s duration must
always be less — if only by a single frame — than the
shorter of its neighboring clips.

e The Name text field lets you assign a custom name to
the clip to replace the default one assigned by Studio.
The Name field is provided on the Clip properties
tool for all clip types. Clip names are used by the
Movie Window’s List view, and can also be viewed
as fly-by labels when your mouse hovers over clips
in the Storyboard view.

Many transition effects also support a *“reverse
direction” option, which causes the transition animation
to run backwards, allowing a rotary wipe, for example,
to be either clockwise or counterclockwise. The
Reverse checkbox is enabled when the current
transition supports this option.

If you have purchased the HFX Creator application,
you can open it within Studio by clicking the Edit
button on the Clip properties tool for Hollywood FX
transitions. HFX Creator is an external editing program
with many options, whose use is described in its
accompanying documentation.
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Previewing in the Clip properties tool

The Clip properties tool provides previewing controls
for transitions similar to those for video clips. See
“Trimming with the Clip properties tool” on page 94
for more information.

The preview areas show the last full frame of the
outgoing clip and the first full frame of the incoming
one. The preview frames update as you edit the
Duration field.

The transport controls let you preview the transition
effect in the Player either frame by frame or at full
speed. The Loop play/Pause button || cycles through
the transition repeatedly at normal playback speed.

Both the counter (with its associated jog buttons) and
the scrubber give you direct access to any desired point
within the transition.

Name field Duration field

1
o e e [r—, (IR ]

. u _aﬂ—‘—‘-__ I8 _ o Transition type

~ Click to reverse effect
© | L N - End frame

frame & = wincaral
=
= L ‘
Trim scrubberJ Transport controls End frame preview
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CHAPTER 10:

Still images

Video usually means images in motion, but most
productions also include stationary titles or graphics,
and may include other types of still image as well.

The still images you can use in your movies include:

e All types of text captions and graphics, including
scrolling credits and “crawled” messages.

e Photos or drawings stored in disk-based image files.

e Individual video frames obtained with the Frame
grabber tool.

e “Disc menus” for DVD and VCD authoring. These
specialized images are covered in Chapter 11: Disc
menus.

Any of these still image types can be treated in either of
two ways, depending on which track you drop them
onto in the Movie Window Timeline:

e To add a full-screen image with a solid background,
add the image to the video track.

e To add an image so that it appears in your movie
with a transparent background, superimposed over
the clips on the video track, place it on the title track.
To be used in this way, the image must be in TIFF
format (usually with the tif file extension), with the

Chapter 10: Still images 179



180

transparent area defined by means of an alpha
channel as this format allows.

Note: Studio Plus users have an additional option, the
overlay track, for adding their images to the Timeline.
See Chapter 8: Two-track editing with Studio Plus, for
details.

The Album has separate sections for titles, bitmapped
images and disc menus. All these resources are stored
as separate files on your hard drive. You can also create
titles and disc menus of your own in Studio’s Title
Editor and add them directly to your movie without
first saving them as separate files (see Chapter 12: The
Title Editor). Similarly, still video frames can be added
directly from the Frame grabber tool (see “The Frame
Grabber” on page 189).

Full-screen images

A full-screen image is one that is placed on the video
track. It fills the entire screen, replacing the video.
When the preceding video clip ends, Studio plays the
still image clip. The visual effect is that the video ends,
and is replaced by the graphic until the next clip begins.

Overlay images

An overlay image is one that is placed on the title track.
It is superimposed on the current video clip, without
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replacing the video. The transparent area of the image
must be defined by means of an alpha channel.

Making a slideshow

If you would like to assemble a quick slideshow of still
images or video clips, you may want to take advantage
of Studio’s Ripple Transition feature to quickly insert a
chosen transition between each pair of clips or images.
See page 175 for details.

Applying effects

Most of Studio’s plug-in video effects can be applied to
still images. (The exceptions are effects like Speed that
only make sense for moving video.) See “Using video
effects” on page 125 for detailed information.

“‘ EDITING STILL IMAGES

¢

As with other types of clip, you can trim still images
directly on the Movie Window Timeline, or by using
the Clip properties tool.

See “Trimming on the Timeline using handles” on page
89 for a discussion of the first method. The difference
with a still image clip is that you can extend it to any
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duration you choose, whereas a video clip can be no
longer than the original Album scene.

Effects like Blur, Posterize and Color correction can be
applied to still image clips of all types in the same way
as to video clips. See “Video effects — the basic set” on
page 136.

Editing image clip properties

The Toolbox » Modify Clip Properties menu |@
command opens a version of the Clip properties

tool appropriate for the type of the selected clip. The
topmost tool icon in the video toolbox can also be used.

With bitmapped images, including ordinary photos and
image files, and with disc menus, double-click the clip
for a third way to access the tool. Double-clicking a
title, however, opens it in the Title Editor instead.

All versions of the Clip properties tool allow you to set
the duration and name of the current clip, as follows:

e To set the length of time the still image is displayed,
change the value in the Duration counter.

e The Name text field lets you assign a custom name to
the clip to replace the default one assigned by Studio.
Clip names are used by the Movie Window’s Text
view, and can also be viewed on the fly-by labels
that appear when your mouse hovers over clips in the
Storyboard view.

The Clip properties tool for disc menus is described in
Chapter 11: Disc menus. See Chapter 12: The Title
Editor for details about editing the properties of titles.
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Editing photos and graphics

The Clip properties tool for editing bitmapped images
allows you to perform several important image-
processing tasks:

e Zoom in on your pictures and photos in order to crop
away unneeded material and focus on only the
essential part of the image;

o Rotate the image in 90-degree increments to permit
the use of photos taken in “portrait” mode;

e Remove the “red-eye” effect that can occur when the
subject of a photograph looks directly into the
camera when the flash goes off;

e In Studio Plus, put together “pan-and-zoom”
animations in which a high-resolution image is
viewed as a succession of smoothly-connected close-
ups at various degrees of magnification. This
technique is closely associated with the well-known
documentary filmmaker Ken Burns.

Mame: HOGARTH - AN ELECTION ENTERTAINMENT - 2% Dwration:|0:00:04. 00| £

~ Eal

Click and drag below to set pan position Pan and Zoom

o e = Animate from start to end
T ® Set start O Set end
Zoomm:

fd ™ VO

g
B hiatch previous clip Reset |
> Rotate Red eye —
= 1 @ W ? Actiuste fastura

The Clip properties tool for photos has pan-and-
zoom controls for focusing on an area of interest. In
Studio Plus, pan-and-zoom can be animated to
create the effect of traversing the image from one
focus to another. Animated “P&Z” can be obtained
in other versions by upgrading to Studio Plus.
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If an image needs rotating by 90 degrees to  Rutate
bring it into “landscape” mode (wider than @ @
high), start by clicking one of the image
rotation buttons. If needed, click the button more than
once until the clip is properly oriented.

If you want to reframe the image, click directly on
the tool’s preview window and, while holding the left
mouse-button down, drag the image in any direction
until it is properly positioned. Release the button to
complete the operation. Next, use the Zoom slider to
magnify or reduce the image size as desired. Adjust the
position and magnification with these controls until the
image is cropped and framed to your satisfaction.

The Reset button removes all your position and zoom
changes, restoring the original framing of the image.

The red-eye reduction feature helps restore  Red eye
a natural appearance to photos in which the (@) (£))
subject’s eyes are tinged with red. (This
problem is caused by light from the flash unit bouncing
off the retina of the eye when the subject is looking
directly into the camera.)

To activate red-eye reduction, click the left button in
the red eye group. The button stays down when clicked.
Now click the image preview with the left mouse-
button above and to the left of the area in which red-
eye reduction should be applied. While holding the
button down, drag down and to the right until the area
is fully enclosed. When you release the mouse-button,
the red-eye reduction effect is instantly applied within
the rectangle you have outlined.

It is usually not necessary to be highly precise when
marking out the red-eye reduction area. In fact, a larger
rectangle may even yield a better result than a smaller
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one that encloses the eyes and no more. If the red-eye
reduction does not clear up the problem entirely on the
first attempt, try again with a different rectangle size.

Studio’s red-eye reduction algorithm provides excellent
results with a wide variety of photos. However, some
photos are better-suited to the process than others.

To remove red-eye reduction once applied, click the
right-hand button in the red eye group.

Animating Pan-and-zoom in Studio Plus

If you own Studio Plus, or purchase an activation key
by clicking the activate button on the pan-and-zoom
controls, you can create effective animations from your
photos and graphic images. Use the highest-resolution
images available with this technique, since they allow
greater magnification levels before there is perceptible
loss of quality.

Start creating a pan-and-zoom & Animate from start to end

animation by clicking the |—-:::- Set start O Set end
Animate from start to end

checkbox to activate the animation feature for the
current clip. This enables the Set start and Set end radio
buttons, with Set start initially selected. Use the pan-
and-zoom controls to set the framing you want to see at
the start of the clip. Finally, click the Set end button,
then use the controls to set up the framing you want for
the end of the clip.

When the clip is played back, Studio will generate the
intervening frames to connect your start and end views
in a smooth animation.
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The procedure above describes the simplest form of
pan-and-zoom animation. Effective uses include:

e Moving from a full-frame photograph to a detail
view of a person or thing somewhere in the image.
This gives a similar result to zooming in while
shooting video. This might be used to prepare the
viewer for a sequence of shots exploring the same
close-up subject in multiple views, or providing
further close-ups of different parts of the same scene.

e Moving out from a detail to the full-frame view, as
though zooming out with the video camera. In the
above scenario, this returns the viewer to the original
context, perhaps closing a chapter or episode within
your movie.

e Panning across a wide scene to absorb its details one
by one. This technique can be used to impart a sense
of discovery when a dramatic or humorous detail
finally comes into view.

Complex pan-and-zoom animations

When you apply pan-and-zoom to a number of copies
of the same image in succession, it is as though you are
taking your viewer on a guided tour. In effect you are
telling a story, one that gradually unfolds as you draw
attention to one detail after another.

Story-telling may be difficult or not, but implementing
your story in Studio is very simple. Once you have set
up the first clip, with the first pan-and-zoom “camera
move”, simply copy it as often as necessary, and
change the end setting for each clip.

You almost always want the start framing of a new clip
in the sequence to match the end framing of the
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previous clip, in order that the sequence of moves will
be smoothly connected. On the second clip, and all
those that follow, click the Match previous clip button
wherever you want continuity.

In order to allow the movie to dwell on each detail for a
while after you pan to it, insert a non-animated copy of
the image between each move. Connect these static
clips into the sequence as usual with the Match
previous clip button.

The pan-and-zoom controls are used here to focus in
turn on four vignettes in the satirical painting “An
Election Entertainment” by English artist William
Hogarth. A fifth view pulls back to show as much of
the entire canvas as will fit in a wide-screen frame
without black sidebars. The tool automatically
generates smooth motion from one view to the next,
panning and zooming simultaneously as needed.
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Animating pan-and-zoom with keyframes

Studio Plus users have another option for animating
their pan-and-zoom productions: keyframing. The use
of this feature enables a string of pan-and-zoom
movements to be associated with a single clip, instead
of having a single movement on each of a series of
clips. See “Keyframing” on page 130.

The pan-and-zoom effect interface

As an alternative to pan-and-zoom with the Clip
properties tool, you can enter the framing properties
numerically with the Pan and zoom video effect. This
alternative interface is provided by the Video effects
tool. You can also combine the two methods, using the
tool’s graphical interface to specify the initial settings,
then fine tuning them with the numerical effect
parameters.

The Pan and zoom effect is found in the Fun Effects
group. The parameters for pan-and-zoom are exactly
parallel to those offered by the tool interface: you can
use the sliders to set Zoom, Horizontal position and
Vertical position. The “red-eye reduction” controls of
the tool interface do not have equivalent parameters,
however.

Tip: Studio Plus users can use keyframing to create
Pan and zoom slideshows using the effect parameters.

(2) Pan And Zaam Presets: | |
Zoom = Static Presets
Fan And Zoom
Horizantal Positi. . = Keyfrarned Prasets
Small Zoomer
“ertical Pasition == Big Zoom

Reduce flickering &

Parameter settings for the Pan-and-zoom effect.
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¢ THE FRAME GRABBER

The Frame Grabber can capture a still image from any
video capture source supported by Studio, or extract a
single frame from any video clip in your current
project. The grabbed frame can be added directly to
your movie or saved out to disk in any of a number of
standard graphics formats.

Once you have saved a grabbed frame to disk, you can:
e Use it in other software applications.
e Manipulate it in image-editing software.

e Import it back into your movies as a still image via
the Album or the Title Editor.

The Frame grabber tool

Use the Frame grabber tool in conjunction with |@
the Player. To access it, open the Toolbox and
click the Frame grabber button.

Play the movie or source video until the frame you
want is displayed in the Player, then click the Grab
button. The grabbed frame appears in the tool’s
preview area, ready to be added to your movie or saved
as a file on disk.

Grab from: Select a source for the frame grabber by
clicking either the Movie or the Camcorder button at
the top of the tool. Choosing Camcorder means that the
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frame grabber will use your current video source, as
configured in the Capture source options panel (page
284) and the Capture format options panel (page 287).

Note: Grabbing a frame from the camcorder is not
supported for HDV equipment.

h Gtah from:  Movie O Camcorder v

& 5@ &

N

@m|

( Add to Movie

4
( Save to Disk )

The Frame grabber in grab-from-movie mode. When
you grab from an external source (e.g. a camcorder),
the Camcorder Controller is displayed. With DV
equipment, you can navigate the source tape from
within the tool.

Transport controls: If your source video is a digital
camcorder or VCR connected to a 1394 port, Studio
provides convenient on-screen transport controls for
locating the frame you wish to grab. For a description
of these controls see “The Camcorder Controller” on
page 22.

Reduce flicker: If the source video of the frame grab
contains a large amount of motion, the grabbed frame
may show flickering, which can be reduced or
eliminated by checking the Reduce flicker option.
Because Reduce flicker also reduces resolution
somewhat, you should not use the option if the overall
result is undesirable for a particular image.
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Grab: Click the Grab button when you have located
the frame you want to grab in the Player and configured
the Reduce flicker option. The grabbed frame is
displayed in the tool’s preview area, and the two output
buttons (Add to Movie and Save to Disk) are enabled.

Add to movie: This button inserts the grabbed frame
into the Movie Window video track ahead of the
currently-selected clip.

Save to disk: This button opens a Save As dialog so
that you can select a folder, file name and image format
for the file in which the grabbed frame will be stored.
The dialog also provides controls that let you set the
resolution of the saved image to any of several standard
sizes, to the original size of the grabbed frame, or to a
custom size that you enter.

If the “aspect ratio” (the ratio of the width to the
height) of the size you choose is different from that of
the grabbed frame, the image is stretched as necessary.
This can introduce visible distortion of shapes; for
instance, people may appear either unnaturally thin or
unnaturally squat.
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CHAPTER 11:

Disc menus

With the advent of the DVD, VCD and S-VCD disc
formats, video became an interactive medium, with
new possibilities for both videographer and audience.

Developing — “authoring” — a disc in one of these
formats means going beyond the old idea of creating a
movie to be viewed in strict sequence from beginning
to end. Now the audience can decide which parts of the
movie to view, and in what order.

The essential new feature that makes disc authoring
possible is the menu. A particular disc may have one, a
few or many menus, each consisting of a still image or
short video sequence. Areas within the menus, called
buttons, can be selected by the viewer to activate links
to other content on the disc. Activating a link causes an
immediate transfer to any of:

e A normal video sequence, which in this context is
called a “chapter”. Chapter buttons often show a
thumbnail frame from the video to which they link.

e Another page of the same menu. Multiple pages, with
the same page design but different chapter buttons,
are used when a menu has too many buttons to fit on
a single page.

o A different menu.
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Unlike any other kind of clip, menus automatically
loop. When the end of a menu clip is reached during
disc preview or playback, it is immediately restarted.
This produces a jJump in the playback position affecting
all clips that run simultaneously with the menu,
regardless of type — video (if the menu is an overlay),
audio or still image.

Menu title Links to "chapters"

Link to previous Link to Link to next
menu page another menu menu page

The following diagram is patterned after the Movie
Window storyboard. It shows how the menu pictured
above, which appears in the diagram as M1, might fit
into the overall scheme of a simple movie with two
menus.

| B I N R .
Each menu is followed in the movie by several
chapters, all but one consisting of a single clip. Our
menu, M1, has links to five chapters. Our menu is

designed to display two chapter links per page, so three
pages are required to accommodate all the links. (The
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second page is the one appearing in the illustration.)
We’ve also given each page a link to the M2 menu.

The simple layout of this short movie can easily be
extended to organize large numbers of clips. Much
more complex movies are also constructed from the
same elements: multi-page menus with links to
chapters and to other menus.

Availability: Discs with multiple menus are supported in Studio Plus
only.

Disc authoring in Studio

For the purposes of editing in Studio, a disc menu is
just one more type of clip. As with titles, you can use or
adapt the menus provided in the Album, or construct
your own from scratch in the Title Editor (see Chapter
3: The Album and Chapter 12: The Title Editor).

To get a feeling for what is involved, try creating the
pair of “instant” projects described below. You don’t
have to go as far as making discs, but you can preview
your movie using the DVD playback controls on the
Player (see “The DVD Player Control” on page 198).

Instant video scene catalog: In an empty project,
multi-select a good number of scenes from the Album
and drag them onto the video track. Now switch to the
Disc Menu section of the Album (the bottom tab) and
drag any of the menus to the beginning of the Timeline.
When Studio asks if you would like it to “create
chapters at the start of each video clip”, click Yes (see
“Using menus from the Album” on page 196). A new
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track appears at the top of the Timeline, and a small
“flag” appears over each of your clips. These represent
links from the menu you just added. And that’s it — sit
back and watch the show.

Instant slideshow: This time, start in the Still Images
section of the Album. Drag as many images as you like
onto the video track of an empty project, then drag in
any disc menu as the first clip on the Timeline, and
again click Yes when asked if you want links
automatically created. Turn next to the Transitions
section of the Album, pick any transition, and drag it
between the menu and the first of your still images.
Finally, select all of the still images (click the first,
then shift-click the last), click with the right mouse
button, and choose Ripple Transition from the pop-up
menu. Instant slideshow!

Menus and titles

The similarity noted on page 195 between titles and
disc menus is not just on the surface: a menu is
essentially “a title with buttons”. Any title on the
Timeline’s main video track can be converted to a disc
menu simply by adding one or more buttons in the Title
Editor.

Using menus from the Album

| & The Disc Menus section of the Album contains
== a collection of menus that have been designed
for particular occasions, authoring styles and chapter
counts. Each menu provides a background picture, a
title, a set of chapter buttons (generally with spaces for
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thumbnail frames), and a pair of Next page and
Previous page buttons.

The number of chapter buttons per page varies from
one menu design to another, so one criterion for
selecting a menu is the number of clips you want it to
handle. It is generally more convenient for the viewer
to browse a few menu pages with many buttons per
page than many pages of a few buttons each.

During editing, you see all the buttons that the menu
provides. During playback, the only buttons visible are
those to which you have assigned links.

Menus with fewer buttons have more space for
captions; those with many buttons will have abbrevi-
ated captions or none at all. Whether you need
captions, and if so whether they should be simple
(“Chapter 1”) or descriptive (“Cutting the cake”) is a
matter of your authoring style and the content of your
movie.

In the VCD and S-VCD formats, the viewer must select
chapters numerically (by keying numbers on the remote
control), so it is usual to provide button captions that
include the chapter number when authoring for these
formats.

Dropping menus on the Timeline

When you drag a menu from the Album and drop it
onto the video track or the title track, Studio gives you
the option of automatically generating links to all video
clips to the right of the menu on the Timeline. Multiple
clips are combined into chapters if necessary to achieve
the minimum chapter length you specify.

This is the quickest, easiest way to link in a disc menu,
but may not be what you want in a particular authoring
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situation. If you check the Don’t ask me again
checkbox, your choice of Yes or No becomes the
default action when you drag in a menu in future. You
can also set the default action, or reinstate the
confirmation window, in the When adding a disc menu
area of the Project preferences options panel (see
“Project preferences” on page 290).

Adding Menu to Movie

1~ Would wou like Studio to create chapters at the start of each video clip?
& ¥es, with a minimurm chapter length of 1z seconds

T Mo, Iwill create chapters manually

| Automatically return ko menu after chapter finishes playing

[ Dan't askme this again

To create your chapter links manually, rather than
using the automatic linking feature, use the Set disc
chapter command on the pop-up context menu for each
video clip you want to add, or use the Set chapter
button on the Clip properties tool for disc menus.

The DVD Player Control

«~ ap Studio’s Player provides a specialized

set of controls for previewing movies

that contain menus, patterned after the button layout on

a typical DVD remote control. Switch the Player to

DVD mode by clicking the DVD toggle button at the
bottom right corner of the Player.
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A grouping of DVD controls appears and activates
below the Player preview screen:

: el

I« i |l

Here are the functions of the individual DVD controls:

Main menu: Jumps to the first menu in your
movie and begins (or continues) playing.

Previous menu: Jumps to the most recently active (<
menu and begins (or continues) playing. Clicking the
button again jumps back from the menu to the most
recent clip.

Previous chapter, Next chapter: Clicking the (i
Previous chapter button takes you to the start of (i«
the current chapter if you aren’t there already. Click
again to move on to the previous chapter. The Next
chapter button takes you forward to the next chapter in
the movie. Within a menu, these buttons step
backwards and forwards through the menu pages.

Button selection: The four arrow controls

in this cluster move the on-screen cursor

within a disc menu to select one of its

buttons. The oval button in the middle of

the cluster activates the currently-selected on-screen
button, which is indicated by highlighting.

Activating menu buttons directly

One feature of the Player that set-top DVDs don’t have
is the ability to click the buttons directly on the screen.
Whenever a button is visible in the Player preview area
in DVD mode, you can click it to follow the button
link.
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Editing menus on the Timeline

Menus can be trimmed on the Timeline just like any
other still image clip (see “Trimming on the Timeline
using handles” on page 89).

Setting the clip duration is generally less crucial for
menu clips than for other types, since menus cycle
during playback while waiting for user input. If you
want a looping video background or looping audio with
your menus, though, you will want to match the menu’s
duration to that of the clips involved.

The menu track

Menu buttons link to particular points within your
movie. Those points are marked by flags on the menu
track, which materializes above the video track the first
time a menu is added to your movie (and vanishes
again if all menus are removed).

The menu itself is marked by a colored rectangle in the
menu track (M1 and M2 in the illustration above). Each
link to a chapter is shown by a “C” flag. Here is a
close-up of the first part of the Timescale, showing the
rectangle identifying the first menu, and the chapter
flags for three of the clips it links to.
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The next part of the Timescale in the overview
illustration above includes the fourth chapter link from
M1, and a link (the left-pointing arrow) from the end of
the previous clip back to the menu. A result of setting
this link is that the C4 clip can only be reached from
the menu. The C4 clip is followed by menu M2, which
— along with the flags that belong to it — is
automatically drawn in a new color.

I:I2EI.EID | D:DD:IBD.EID | D:EIEI:I4EI.

Availability: Discs with multiple menus are supported in Studio Plus
only.

Editing on the menu track

Flags on the menu track can be moved by dragging
them with the mouse, thereby changing the location at
which the link takes effect in the movie. When a video
clip is moved, any flags attached to the clip are moved
along with it.

To create a link:

Right-click the menu track or the video track and
choose either Set Disc Chapter or Set Return to Menu,
depending on the kind of link you want to create.

Return to menu links are always created at the end of
the current clip, rather than at the exact point where
you click. You’ll rarely want to return from the middle
of a clip, but you can drag the link flag to a new
position if the occasion arises.
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To reposition a link:

Click the flag for the link and drag it along the menu
track to its new position.

To delete a link:

¢ Right-click the link flag and choose Delete from the
pop-up menu; or,

o Select the flag, highlighting it, then press the Delete
key.

Editing with the Clip properties tool

The Clip properties tool for disc menus allows |.z
you to create, edit and fine-tune chapter links, —
and provides access to the Title Editor for adjusting the
visual content of the menu.

Like the Clip properties tool for other clip types, this
tool lets you set a custom name for the menu by editing
the Name field and trim the clip by editing the
Duration field.

4 . IName: Family - Summer V acation | Duration:[0:00:12 00| & X
Menu type: ( Edit Menu )
.
© Auto scene index @ Manual
T
[ 14 v J
> |
e "h'} Set Mation
£ ~ thumbnail thumbnails
B
=] [ Retum after every chapter
ik . R 5 @ (Fj Set chapter @ Set returm

The Edit menu button at the top right of the tool opens
the menu in the Title Editor. There you can change
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every visual aspect of the menu: its background and
button images, the appearance and contents of its
captions, and more. For full information about the
many capabilities of the Title Editor, see Chapter 12:
The Title Editor.

The preview area on the left side of the tool shows how
the menu looks and also has interactive features you
can use when establishing chapter links. (These are
describped on page 206 under “Chapter-editing
controls™.)

The other controls are in four groups:

e Menu-previewing controls
e The Menu type options

e Link property controls

o Chapter-editing controls

Menu-previewing controls
These controls are located below the preview area.

Page selector: For menus with multiple [ «[z]»
pages (those with more links than a single

page can accommodate) the arrow buttons let you
select which page is active in the preview area. You
can select any page in the menu for which links have
been defined.

Alternative methods of selecting menu pages:

e Step through the pages by clicking the page link
buttons in the preview area.

e Use the Button selector control (described on page
204) to choose a button on any page of the menu.

Show link numbers checkbox: Check this box & e
to cause link numbers to be displayed in the preview
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area over every button in the menu. The link numbers
match the format and color of the chapter flags on the
menu track.

The Menu type options

This pair of options determines whether you or Studio
will organize the chapter links for this menu.

Menu type:

= Auto scene index ) Manual

If you choose Auto scene index, Studio will ensure that
your chapter links are in the same order on the menu as
they are in the movie itself, seven if you shuffle the
order of the clips in the Movie Window. With the
Manual setting, the order in which chapters are shown
on the menu is up to you. If you want to sort your
chapter links yet still retain future control of their order,
you can click Auto scene index first (to sort the links),
then Manual.

Availability: The option of manually ordering menu chapters is
available in Studio Plus only. In standard Studio, the Auto scene
index feature is permanently enabled.

Link property controls

The controls in this area set the display properties of
the chapter links on the menu.

Button selector: Every link button in your 4 4 >
menu, no matter which page it is on, has a

unique sequence number. Use the arrow buttons on this
control to select the menu button you want to work on.
The selected button is highlighted in the preview area.
You can also select a button by clicking on it in the
preview area.
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Button caption text field: Edit the text for [chapter B
the current button without going to the Title

Editor. The “#” character in button captions has a
special meaning: Studio replaces it with the button’s
sequence number. Use this feature to ensure that your
buttons are correctly numbered regardless of changes in
the layout of the menu. To edit other characteristics of
a button caption — its position, font, and styling — click
the Edit menu button to invoke the Title Editor.

Set thumbnail button: By default, the =
thumbnail frame displayed on a menu button is
the frame to which the button links. You can choose
any frame in your movie to be the thumbnail, however.
Just move the Timeline scrubber to the exact frame you
want (as shown in the Player), and click the set
thumbnail button.

Motion thumbnails checkbox: Check - Mation
this option if you would like your menu’s ~ thumbnails
buttons to show moving video from their target
chapters rather than a static thumbnail frame. Because
this feature requires that the moving thumbnails be pre-
rendered, the results won’t appear immediately when
you preview your movie in the Player. Instead you will
typically see a colored bar appear in the Timescale over
the menu clip. This bar indicates that the clip is being
rendered in the background, without interrupting your
session.

Background rendering is optional. You can disable it, if
required, in the Video and audio preferences options
panel (Setup > Video and Audio Preferences). See
page 290 for more information.

Availability: The Motion thumbnails feature is available in Studio
Plus only.
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Chapter-editing controls

The controls in this area select or modify the individual
chapter buttons within a menu.

The Set chapter buttons: These
set or sever the link between the
selected chapter button on the menu and its target clip.

To set a link: Position the Timeline scrubber within a
menu, video, theme or still image clip, and click the
Create chapter @ button. For video and still image
clips, the chapter point is set to the exact location of the
scrubber within the clip.

To clear a link: Click the Clear chapter (&) button.

\[:';' [;[:‘:] Set chapter

Set return button: This creates a “return-to- O
menu” link at the end of the current clip, which ™~
is where you almost always want it. During playback,
the link causes an immediate jump to its menu. To
create a return-to-menu link in the Clip properties tool,
position the Timeline scrubber in the clip where you
want the link, and click Set return to menu.

Availability: The Set return button is available in Studio Plus only.

The Return after every chapter checkbox: Set this
option to add a return-to-menu link after every chapter
in this menu. Clicking this checkbox, whether to set or
clear it, removes all existing return-to-menu links for
the menu. Return-to-menu links are normally
draggable, but while this box is checked they remain
anchored to the end of their clips.

Creating links with drag-and-drop

The Clip properties tool for disc menus supports drag-
and-drop as a quick and convenient way to establish
links for menu buttons.
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To create a link using drag-and-drop:

o Click the clip in the Movie Window that you want to
link to, and drag it onto a button in the Clip
properties tool preview area. The button is linked to
the first frame of the clip. Or,

e Click the button for which you want to create a link,
and drag it onto a clip in your move. In this case you
are linking to the point within the clip at which you
“drop” the button — generally not the first frame.

The Disc menu tool

If you open this tool while a menu is selected, it | e
is equivalent to opening the Clip properties tool,
otherwise, it provides a Create Menu button that takes
you into the Title Editor to begin creating a new disc
menu. (See “Editing with the Clip properties tool”,
page 202, and Chapter 12: The Title Editor.)

Because developing a menu is a relatively intricate
operation, Studio takes the opportunity to remind you
that pre-built menus are available in the Album. When
you decide that this reminder is no longer needed,
check the Don’t ask me this again box before clicking
the OK button.

Create Menu

Yau cah drag a reenu from the Menu Alburm inta vour project, ar
wou can create a menu from seratch in the Menu Editar.

‘what would you like to do?

" Open the Menu Album
o] ditcr

I™ Dont ask me this again

Ok \:: Cancel
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CHAPTER 12:

The Title Editor

Studio’s Title Editor is a powerful facility for creating
and editing titles and other graphics. Its extensive suite
of text and image effects and tools provides endless
possibilities for the visual design of your movie.

Tkt e = |
EHE E u v .

\TOL

Creating a title in the Studio Title Editor tool. The
large area containing the picture and the text is the
Edit Window, while the panel occupying most of the
right-hand side is the Title Editor Album. Other
controls are in clusters around the Edit Window.

The Title Editor is not limited to creating passive titles.
For disc projects, you can also add and edit the special
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buttons needed for handling viewer interaction with the
menus of VCD, S-VCD and DVD movies.

0000000000000
Launching the Title Editor

Reflecting the versatility of the Title Editor is the
variety of ways of accessing it from Studio’s Edit
mode, using either one of the tools in the Video toolbox
(see page 76) or a mouse command on one of the
Timeline tracks (see page 67).

e To create a full-screen title or menu: Select Go to
Title/Menu Editor from the right-button context
menu in the main Timeline video track.

e To create an overlay title or menu: Double-click
the Timeline title track.

e To create a title from the toolbox: Open the Create
title tool and click Title Overlay or Full Screen Title.

e To create a disc menu from the toolbox: Open the
Create disc menu tool and click Edit Menu.

e To edit a full-screen title: Double-click the title in
any Movie Window view, or right-click the title and
select Go to Title/Menu Editor.

e To edit a full-screen menu: Double-click the menu
in any view and click the Edit Menu button, or right-
click the menu and select Go to Title/Menu Editor.

e To edit an overlay title: Double-click the clip on
the title track or in List View, or right-click it in any
view and select Go to Title Editor.

e To edit a title or menu from the toolbox: With the
clip open in the Clip properties tool, click the Edit
Menu or the Edit Title button.
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0’0 THE TITLE EDITOR CONTROLS

¢

The main Title Editor controls are laid out in clusters
around the Edit Window (see the picture on page 209).

Title-type buttons

] The four buttons in this cluster sit on

the left side of the screen above the
Title Editor’s Edit Window. Only one of them can be
selected at a time. Choose the first button if you are
creating a still title. The second creates a roll, in which
the title text and graphics travel upwards on the screen
as the title displays, like the credits at the end of a
move. The third creates a crawl, in which the title is
displayed as a single line of text moving from right to
left across the screen like the bulletins on a TV news
show.

Availability: Rolls and crawls are supported in Studio Plus only.

The fourth button is for creating disc menus, which you
can usefully think of as “titles with buttons”. In fact, a
menu is just like any other title except for two
attributes:

e A menu has at least one button. A title has none.
Adding a button to a title turns it into a menu, and
deleting the last button on a menu turns it into a title.
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By the same token, if you click the Menu button
while editing a title, Studio automatically adds a
button to the title.

e A menu cannot have rolling or crawling text. The
Title Editor does not allow you to add menu buttons
to a rolled or crawled title.

Because disc menus are allowed only on the main
Video track of the Movie Window Timeline, the button
for creating disc menus does not appear when a title
from one of the other tracks is being created or edited.

Object toolbox

T O [ This cluster of four Title Editor tool
buttons is located at left below the Edit Window.

The first tool (the arrow) is used for
all editing operations upon the
currently-selected object. A selected
object is surrounded by a number of
control points with which you can
change its size, position, proportions,
and other geometrical features.

The other three tools are for creating objects in the Edit
Window — text boxes, ellipses and rectangles.

Each is used in the same general way.
Click one of the three tools, then
click the Edit Window at the point
where one corner of the object should
be. Drag the mouse to outline the new
object as indicated by the dotted line.
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When the object has the size and proportions you want,

release the mouse. Whatever its type, the object is

created with the specified dimensions. Its other
attributes — color, shading, shadow,
etc. — are determined by the currently
selected look in the Title Editor
Album. All attributes can later be
changed at will.

After the object is created, the object tool you used
deselects, and the selection arrow again becomes
active. The object itself is selected — shown in the usual
way by its control points — and can now be manipulated
with the mouse.

Reordering objects in three dimensions

123 = ] Because objects can overlap

45 one another, it is easy to get
into situations where an object
that should be completely
visible is partly or wholly
obscured by one or more other
objects. In such cases, use the four reordering
commands on the Title Editor’s Layers menu. These
commands affect the currently-selected object,

symbolized by rectangle “3” in the diagram.

e Bring to Front: The object is moved out in front of
all other objects. In the diagram, object 3 is now in
front of object 1.

e Send to Back: The object moves behind all other
objects. Object 3 is now behind object 5.

e Bring Forward One Layer: Object 3 now lies in
front of objects 2, 4 and 5, but behind object 1.

e Send Back One Layer: Object 3 is now behind
objects 1, 2 and 4, but is still in front of object 5.
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About text objects

Selecting a text object is different in one important way
from selecting a rectangle or ellipse: the object’s text
field is put into a “ready” state in which any keyboard
activity will cause the field to activate and start
displaying the input text.

The activation of the text field is indicated by a text
insertion cursor, the changed appearance of the object
frame, and the disappearance of the control points.

When a text object is not selected, you can activate its
text field directly by clicking in the middle of the
object. If you want the selection frame and control
points to appear, you must click on the edges of the
object. With other types of object, you can click
anywhere in an object to select it.

To deactivate a text field, click anywhere in the Edit
Window outside the text object.

Because text plays a central role in most titles and
menus, the Text Editor will automatically create and
activate a text object in the center of the Edit Window
if you simply begin typing at a time when no text
object already exists.
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Advanced text editing features

As in a word processing program, the Title Editor
allows you to format a selected range of characters.
Simply mark an adjacent set of characters with the
mouse and apply the formatting you desire.

Supported operations on character ranges include text
styling (font, style and look), clipboard operations (cut,
copy, paste), delete, and a number of special
positioning, spacing and scaling commands that are
accessible only from the keyboard. For details on these,
please consult Appendix G: Keyboard Shortcuts.

Editing-mode selection buttons

< gk These two buttons form the second cluster

along the bottom of the Title Editor’s Edit
Window. Their function is to govern which of two sets
of editing operations is available for the currently-
selected object.

e The first button is on by default when an object is
newly created. It enables the move, scale and rotate
operations with a selection frame containing nine
control points:

Top contral point
allows rotation

Corner contral point resizes
without changing proportions

Edge control point changes
Haold down mouse the width or height only

button and drag to
move object when the

"drag" cursor is visible,
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e Clicking the second button enables the skew
operation, which requires only a single control point.

Drag this control point to
ry—skew (tilt) the object

With text objects, the second button provides two
further operations, kern and change leading, accessed
by control points in the center of each edge of the text
frame:

Kern (L) and Change leading (R)
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Object layout buttons

rr 2| @ The two left buttons in this cluster are

for grouping and ungrouping Title

Editor objects. The first button is available when

multiple objects are selected. Its action is to link the

objects into a group — a composite object that is treated

as a single entity by editing operations. When a group

is selected, all its control points are visible

simultaneously, and any of them may be used to
manipulate the group.

A grouping of three objects

The second button, which is available whenever a
group object is selected, separates the group into its
constituent objects.

Although it is possible to “group groups”, grouping is
always just one level deep, so ungrouping a supergroup
will result in all the constituent objects being
individuals again.

The next button opens a pop-out menu of 11 operations
that apply only to groups. The first six let you align a
set of objects along any one of their four edges or either
of their two mid-lines. The next pair of commands
provides for spacing the objects at equal intervals in
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either the vertical or horizontal directions, and the final
three resize the objects so that they have equal width,
equal height, or both. All of these commands are
particularly useful in menu creation, since you
generally want menu buttons to be laid out in a regular
fashion.

4 The final object layout button opens
another pop-out menu, this one concerned
with object justification. The nine options
here are in a graphical form resembling a
tic-tac-toe board. Clicking one of the nine
areas moves the object to the corresponding corner of
the screen (as defined by the “text-safe” area delimited
by red dashed lines), or to the center.

Multiple selection of objects

The first step in making a group is to select the multiple
objects that will comprise it. This can be accomplished
in either of two ways:

e By clicking and dragging with the mouse to mark out
a selection rectangle (a “marquee”) that encloses all
the objects you want to group; or,

e By clicking the first object you want to group, then
Ctrl-clicking each of the others.

Temporary groups

Any selection of multiple objects functions as a
temporary group, and can be moved, aligned, rotated,
colored etc. as a unit. The temporary grouping loses its
identity as soon as you click elsewhere in the Edit
Window, however, whereas a group created with the
group button persists until explicitly ungrouped.
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Clipboard and delete buttons

M Oy €y The buttons in this cluster provide the

familiar editing operations Cut, Copy,
Paste and Delete, all of which operate on groups,
individual objects, or on selected text within a Title
Editor text object. The first three work with the
Windows Clipboard, while the fourth simply deletes
the chosen material without affecting the Clipboard.

Text-styling controls

Y
-

B ~ 1 = [u | » [20. |

The controls in this cluster at the top right of the Title
Editor’s Edit Window should look familiar to anyone
who has used word-processing software. The controls
apply both to currently-selected text and to any new
text that may be entered until the settings are changed
again.

At the left are three font style buttons, which select the
bold, italic or underlined styles respectively.

Perhaps surprisingly, the underlined style button -
alone among these controls — can be applied to any type
of object, not just text (try it!). This makes it possible to
use the underlined highlighting style with buttons
created from graphic objects: rectangles, ellipses and
pictures.
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7 The fourth button opens a pop-out
menu of text-formatting options.
Left . .
Unlike the other controls in the
E_e”te' cluster, which govern the appearance
Fiight of individual characters, the options
[ swink ot on this menu apply to all the text in a
é% . given text box.
Scale bofit
Wiord wrap on The three justification options — Left,
B2 word wnap off Center and Right - affect the

placement of the text within its box
(and not the placement of the box itself within the Edit
Window, which is the function of the object
justification menu ).

Shrink to fit, Scale to fit, Word wrap on and Word wrap
off are options that determine how your text is treated
when you resize a text box. With Word wrap on, which
is the default for a new text box, resizing the box
results in the text being reformatted — word-wrapped —
to the new box width (while the resulting new height of
the text in turn governs the height of the box). Word
wrap off removes all “soft” line breaks (line breaks
added for word wrapping), then makes the box as wide
as necessary to contain the text. Word wrap mode is
automatically turned on again if you type further
characters into the text box.

With Scale to fit, the text is stretched during resizing to
follow both box dimensions. With Shrink to fit, the text
remains its original size unless the box is made smaller,
in which case the text is resized as in Scale to fit.
Neither to fit command changes the line divisions of
the text.

The font dropdown list and the font-size selector
complete the text-styling controls group.
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€ THE TITLE EDITOR ALBUM

The Title Editor Album is the rectangular panel on the
right-hand side of the Title Editor screen. It contains
resources for building menus and titles in the same way
that the main Studio Album contains resources for
creating movies.

/fm  The Title Editor Album is controlled by the four
buttons shown at left, which are located

M7 between the Edit Window and the Album itself.

- Each button opens one of the four Album
sections: the Looks Browser, the Backgrounds

r=4 section, the Pictures section and the Buttons
section.

The fourth of these buttons, the one that opens the
Buttons section, appears only when a menu or a title
from the main Video track is being created or edited.
This is because disc menus (which to the Title Editor
are just titles with buttons), are not allowed on the
Movie Window’s other Timeline tracks.

The Looks Browser

Ak This section of the Title Editor Album has three
subsections, accessed by the Standard, Custom
and Favorites tabs across the top.

The Standard tab is a collection of styles that can be
applied to the text and other objects you use in your
titles. Each style consists of a color (or color gradient,
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or transparency) for each of the “face” (surface), edge
and shadow of the object to which it applies, plus a
separate blurring parameter for each. A final parameter
is shadow direction, for which there are eight
possibilities.

To change the look of an existing object, simply click
on the look you want while the object is selected. New
objects are created with the most recently selected look.

Aa
An

fa
Aa

Selecting a look in the Looks Browser: Each button
in the Standard tab is available in eight styles, which
are presented to you as a submenu. Each look has a
numeric ID that displays as a tool-tip under your
mouse. Above, the mouse is on look 27-3.

e B
ElE)5 S

The Custom tab lets you customize the supplied looks
or create your own by adjusting the parameters listed
above. Three identical sets of controls adjust the
parameters for face, edge and shadow respectively.
Here are the face controls:

Face
Ol @@ ©
A T
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The three option buttons across the top select a solid
color, a gradient, or no color (transparency). Clicking
the color swatch beside the first button invokes an
otherwise standard Windows color-picker dialog to
which an Opacity slider (0-100%) has been added.

lwwi| The swatch beside the second button
pops up a gradient designer that lets you
define a gradient by assigning the
starting colors to each corner of a square
surface. Click the color swatches in the
corners of the gradient window to set the
color for that corner in a color-picker dialog.

Note: Some of the more elaborate supplied looks em-
ploy special internal features and so cannot be edited.

-] The Favorites tab lets you save particular

custom looks that you may want to re-use in
the future, to spare you from having to remember or
record the parameters you used. Click the left-hand
button to save the current look as one of your favorites.
Click the right-hand button to delete the currently-
selected “favorite”.

The Backgrounds section

A title or menu can have four types of

background: a solid color, a gradient,
transparency (no background at all) or an image file
(such as a drawing, photograph or saved video frame).

Solid color_J!‘ .Graﬂje; ’rTEnsparency
Picture— @ [J—Select folder
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The color and gradient options in the Backgrounds
section of the Title Editor work in just the same way as
those described above for the Looks Browser (page
221), except that the color or gradient you select is
instantly applied to the background of the title you are
editing.

If you are working on an overlay title, you may find
interesting ways to use the Opacity setting on the color-
picker dialogs for these buttons, especially when the
overlay is coupled with transitions. Normally, though,
you’ll use a transparent background for titles, and
transparency is the default background selection for a
new title or menu.

The final option for backgrounds is picture — an image
file in any standard format. As with many of the
sections of Studio’s main Album, the backgrounds are
drawn from a source folder that may be changed using
the folder button. The image file you select with the
folder button becomes the new background, and the
image files in the folder are displayed as thumbnails on
the Album panel. If necessary, the Title Editor stretches
the background image until it fills the width or height
of the screen but does not change its proportions.

Adding a motion background

In Studio Plus, disc menus can have a background of
moving video, not just a static image. To create such a
motion background, or replace one, simply click the
folder button and browse for a movie file in AVI,
MPEG or WMV format.

The following rules apply when you add or change a
motion menu clip:

e The length of the movie you add as a background
does not affect the length of the menu clip in the
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Movie Window. If the movie is shorter than the clip,
it is simply repeated as necessary to fill out the
required time; if longer, it is truncated. You can
adjust the length of the menu by trimming on the
timeline or in the Clip properties tool as usual.

e If you add a widescreen movie as a menu
background in a project in standard format, or a
standard movie to a widescreen project, the movie is
stretched or squeezed as required to match the
project format.

Windows Metaniles | wmi|
Portable Metwork Graphics files [°.pnog)

AW Files [ avil .

MPEG Files [*.mpg.”.mpd,”.mod,” 3gp] L@

Wby Files ["wmy] !
All Files [7.7) d

To see movie files listed while browsing for a folder
on your hard drive, select the desired movie type (or
“All Files™) in the ““Files of type” box.

]
The Pictures section

As with the background pictures just discussed,

the images in the Pictures section of the Title
Editor Album can be of any standard type. Instead of
being stretched to fill the Edit Window, however, these
pictures are added to the title as picture objects and
displayed at normal size with eight control points that
allow them to be repositioned and resized (though not
rotated or skewed).

Picture objects behave just like text objects and the two
types of graphic object with respect to grouping,
alignment and similar controls.
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The Buttons section

r=1 Since buttons are the magic ingredient that turns

titles into interactive menus, this section of the
Title Editor Album is available only when the menu or
title being edited is on the main video track, the only
track on which menus can be placed.

Broadly speaking, a button is an area of the screen with
which the user can interact in some way. Buttons are
classified according to the action they produce when
the user activates them, and not by their appearance,
which generally should be chosen to give a strong clue
to their behavior, but is not required to. The four types
of button are:

e Normal: Clicking the button causes playback to
jump to a chapter (that is, ordinary video) or another
menu. The link between the button and its target is
created in the Clip properties tool, not in the Title
Editor.

e Thumbnail: This special form of the normal button
type displays a thumbnail frame (or a moving
thumbnail preview) from the part of the movie to
which it links.

e Previous: This button appears on the second and
later pages of multi-page menus (menus with more
links from normal or thumbnail buttons than will fit
on one page). It links to the previous menu page.

e Next: This button appears on all but the last page of
multi-page menus; it links to the following page.

The button art supplied with Studio includes several
examples of each type. Each button is an image file in
Targa (tga) format. Examination of the files in an art
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program like Adobe PhotoShop or Paint Shop Pro will
show that the transparent portion of the button image,
and the special area for the display of thumbnails
(where applicable), are defined by an alpha channel
included with the image.

As usual, a folder button lets you select the disk
directory from which the displayed images are
obtained.

To use a supplied button, simply drag it from the
Album into the Edit Window, where it becomes a
button object — essentially an identical twin of the
picture object.

IPrevious button =] The default action of the supplied
Mot a buiton buttons is determined by their file

Mormal button

Thmbral BIBAIIES)  names, but a new action can be
Previous buthon .

Neat button assigned to the currently-selected
Flool bulton button object from the dropdown list
in the Buttons section of the Title Editor Album. The
first choice on this list, “Not a button”, removes the
action from the object — now it is merely a graphic. The
other choices correspond to the button types listed

above.

Tip: Remember, it’s not the button’s appearance that
determines its behavior, but the button type you select
from the menu.

Button highlighting

& Highlight style DVD menus (but not VCD and S-VCD
O @49 O —  menus), give visual feedback by high-
[ seive [ seeces  11GNTING the current button as the user
scrolls around the menu. Special active

highlighting distinguishes a button that is in the process

of being actuated, just before the action is performed.
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(You can preview this highlighting effect in the Player,
and interact with the menu using either the mouse or
the Player’s DVD controls.)

The Title Editor lets you assign the color that will be
used for each type of highlight, and a style option that
governs how the highlights will be drawn. The controls
for these settings are located below the button-type list.

Click the Active and Selected color swatches to set the
highlight colors that work best with your menu. It may
help to make your menus clearer if you use consistent
highlighting colors for all the menus on a disc.

The three highlight style options, from left to right, are:
e Box: The highlighting is drawn as a rectangle
enclosing the button.

e Follow shape: The highlighting covers the visible
area of the button, whatever its shape.

o Underline: The button is underlined.

These highlight options can be applied to any type of
button made from any type of object, not just the button
images brought in from the Album. Clear the Highlight
style checkbox if you want to disable button
highlighting while working in the Title Editor.
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CHAPTER 13:

Sound effects and music

Video may be thought of as primarily a visual medium,
but the role of sound in your movies is often no less
important than that of the images on the screen.

Feature film and television productions include
numerous types of audio, beginning with the dialog and
other sounds created during live action. In your movies,
that raw soundtrack is brought in along with the video
during Capture mode. It appears in the Movie Window
Timeline view on the original audio track below the
video track. In Studio Plus, original audio may also
appear on the overlay audio track.

Most commercial productions also require sound
effects — slamming doors, crashing cars, barking dogs,
etc. — and incidental music, which may consist of music
created especially for the production, songs taken from
recordings, or both. Voice-overs and other customized
audio are also often needed.

You can use all these types of add-on sound in your
own movies:

e A good starter set of wav format effects is installed
with Studio, and others are widely available.

e The Background music tool automatically creates a
music track with your selected duration and style.
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e You can drop mp3 files from the Album onto the
Timeline or import audio or MP3 tracks from a CD
with the CD audio tool.

e The Voice-over tool lets you add narration or
commentary as you preview your edited video.

Audio, whatever its type, is added to your production
as clips in the Movie Window. These can be moved
around, trimmed and edited in much the same way as
video clips and still images.

Once a sound clip is part of your movie, you can
modify it with fades and other volume adjustments. An
easy way to create audio fades and cross-fades is to add
transitions to your audio clips as described on page
247.

You can adjust the positioning of your clips within a
stereo or surround mix, and even change that
positioning arbitrarily within the clip. You can also
apply Studio’s audio effects, including noise reduction
and reverb among others.

Availability: Surround sound is supported in Studio Plus only.

About surround sound

A “surround” mix goes beyond the two channels of
stereo to provide a theater-style enveloping sound field
for your DVD productions. Studio lets you set the
apparent position of each audio track independently
within the mix, and to “pan” the track (reposition it,
whether smoothly or abruptly) in any desired direction
as often as necessary over the course of your movie.

To preview surround sound while editing in Studio,
you need a sound card that supports 5.1 channel output.
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A surround soundtrack can be output to the DVD in
either of two forms:

e In Dolby Digital 5.1 format, each of the six surround
channels is stored discretely on the disc and will be
routed directly to the corresponding speaker when
played back on a full 5.1 surround playback system.

e In Dolby Digital 2.0 format, the surround mix is
encoded onto two channels. When your DVD is
played back on systems with a Pro Logic or Pro
Logic 2 decoder, and a 5.1 or better speaker layout,
the original surround information is recreated. On
other systems, the encoded soundtrack will be heard
as conventional stereo.

Note: Even if you cannot hear your surround mix when
previewing, it will still appear on your DVDs, but a
surround preview allows more accurate mixing.

Creating a soundtrack file

Studio lets you output your movie soundtrack as an
audio file in wav (PCM), mp3 or mp2 format. Simply
open the File tab in Make Movie mode as usual and
select Audio as your file type. Several presets are
available, with some typical settings for standard file
types. The Custom preset lets you configure the type
and settings of the output file as desired.

@ File: Type

Dize: |'A'L“:”cl j
D Preset
=2 |PCM Stereo 44kHz =l
et MP3 Stereo 44kHz
WA TP Steren 44kHz
Tape WAY (PO Steren 48kHz RE
oy Custom

Soundtrack file output presets
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The Timeline audio tracks

The Movie Window’s Timeline view contains several
audio tracks:

Original audio track: This contains the audio captured
along with your video clips. It is sometimes called
“synchronous” audio because it is recorded
simultaneously with the video track.

Overlay audio track: The original audio for video
clips on the overlay track.

Sound effect and voice-over track: Sound effects and
voice-overs are the typical content on this track. Sound
effects are brought into your project from the Sound
Effects section of the Album (see “The Sound Effects
section” on page 61). Voice-overs are created with the
Voice-over tool (described on page 237).

Timescale
3 of: Lincoln Park

Menu & [m
Video =
Audip , [ R NN s
Title
Sound effect  «:

Music &

The Timeline audio tracks: original audio, sound
effect and voice-over, and background music. When
the overlay track is visible, a fourth audio track; it
contains the original audio for video on that track.

Background music track: Use this track to include
mp3 or wav audio files, ScoreFitter background music
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generated by Studio, and music (or other content) from
audio compact disks (CDs). Audio files are imported
via the Music section of the Album (see page 62).
Create ScoreFitter clips with the Background music
tool, and CD audio clips with the CD audio tool (see
“The Background music tool” on page 235 and “The
CD audio tool” on page 234).

Switching audio tracks

Although the audio tracks do have their specialized
roles, as described above, these mainly control the
choice of track where new clips will appear. Original
audio will always be placed on the original audio track
when a new video clip is brought in; new voice-overs
will always be created on the sound effects and voice-
overs track; and new CD audio and ScoreFitter clips
will be added to the background music track.

Once a clip has been created, however, you can move it
to a different audio track if it is convenient to do so:
each track is actually able to accommodate any type of
audio clip. This gives you the flexibility to use two
sound effects simultaneously, for example, simply by
placing one of them on the background music track.

The only audio track with special status is original
audio, either for the main video track or, when it’s in
use, the overlay track. By default, audio clips on this
track are edited in parallel with the contents of the
video track at the same time index. To treat the original
audio as a separate clip for trimming, or to drag it onto
another audio track while leaving the video intact, or to
drag other sound clips onto an original audio track, first
lock the video track (by clicking the padlock icon on
the right side of the Movie Window). See “Advanced
Timeline editing” on page 98 for more information.
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The CD audio tool

Use this tool to create an audio clip from a CD |@
track. You can preview tracks within the tool,

and select either a whole track or an excerpt to add to
your movie.

h Mameg: Track 1 [Boccherini Trios op] Duration:| 0:01:56 04 : A

e
K CD Title [Baccherin Trios ap. 47 | ——
Track |Track1 j
"@ 0:01:20.22|%
[|o:00:57.01 5| | e w B & | |5 0:02:53.04]]
Jd
L Smmr —

If there is a CD in the drive that you have not
previously used in a Studio project, Studio will ask you
to enter its name before continuing. The controls on the
tool will become available only when Studio can offer
at least one entry on the CD Title dropdown list.

Select the CD from which you wish to capture audio in
the CD Title dropdown list, and a track on that CD
from the Track list. Since CD Title is also an editable
text field, you can change the name by which Studio
refers to this CD, if desired. The name change applies
to both the current and future sessions.

Having selected the CD and track, you can now
optionally trim the clip and give it a custom name using
the other controls on the tool. These controls are
common to most audio clip types, and are used for
editing as well as creating clips. They are covered on
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page 240 under “Trimming with the Clip properties
tool”.

Finally, click the Add to Movie button. Studio captures
the music clip from the CD drive and adds it to the
background music track beginning at the current time
index (as shown by the Timeline scrubber and the
preview frame in the Player).

The Background music tool

Studio’s  ScoreFitter automatically creates
background music in the style of your choice.
Within that style, you select one of several songs, and
within that song, any of a number of versions. The list
of versions available also depends on the duration of
background music you specify.

h Source Scarefiter™ - Duration:[0:00:30. 04| 2 X
%@ « Style " Library Song Wersion
Classical Full Moon Rising Desert Stampede
[(|{ Electronica Joumey To Arabia The Streets Of Cairo
Ethnic Silk Road The Secret Gathering Place
ﬁ FilmiTy The Great Pyramid
FolkMraditional Saudi Expedition
Inspirational Tunis Excavation
@ JazmziBlues Arduous Pilgrimage
MNowelty Arabian Odyssey
‘ =) Wiarld Crassing The Mile
@k
About Scorefitter™... Get More Songs Preview Add to Movie

To create music for a particular set of clips, select those
clips before opening the Background music tool. (To
select your whole movie, use Edit > Select All or press
Ctrl+A.) The total length of the selected clips will
determine the initial setting for the music duration,
though you can modify the value at any time by
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trimming on the Timeline or directly editing the
Duration counter in the tool.

In the Background music tool, choose a style, song and
version from the lists provided. Each style offers its
own selection of songs, and each song its own selection
of versions. Use the Preview button to audition the
song while the tool is open.

Enter a name for the clip in the Name field and adjust
its duration with the Duration counter, if desired. The
music clip you create will be adjusted to fit exactly the
duration you select.

When you have made your choice, click the Add to
Movie button. Studio creates the new clip on the
background music track beginning at the current time
index (as shown by the Timeline scrubber and the
preview frame in the Player).

Expanding your song collection

ScoreFitter songs come in collections called “libraries”.
The Standard library, which is included with Studio,
includes more than 40 songs in styles ranging from
Folk to Electronica. Additional libraries may be
purchased from within Studio as they become available
by clicking the Get More Songs button. Click the
Library radio button to see your song collection
categorized by library rather than by style.

Using SmartSound®

If you have installed songs in SmartSound format on
your computer, these too will be available for use in the
Background music tool. To switch between your
ScoreFitter and SmartSound song collections, make the
appropriate choice on the Source dropdown list at the
top of the tool window.

Pinnacle Studio



The Voice-over tool

Recording a voice-over in Studio is as easy as |ﬁ
making a telephone call. Just open the Voice-

over tool, click Record and speak into the microphone.
You can narrate as you watch the movie play so your
words match the action on the screen. You can also use
the tool as a quick way of capturing ambient music or
home-made sound effects via your microphone.

i

£ » 7
IE 2

dd =

Tk ‘ ‘ “Record )

Before you can record audio using the Voice-over tool,
you need to connect a microphone to the input jack of
your PC sound board. You must also have at least one
video clip in the Movie Window.

Review the video scenes in your movie and decide
where you want the voice-over to begin and end. When
you are ready, open the Voice-over tool. Note that the
recording lamp — the dark rectangle in the upper left of
the above illustration — is not lit.

Select your starting point on the Movie Window
Timeline. You may do this by selecting a clip, playing
the movie and stopping it at the desired point, or by
moving the Timeline scrubber.
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Position the microphone for use and try speaking a test
phrase to check your recording level (see “Voice-over
level” below). When you are satisfied, click the Record
button (which toggles to a Stop button). Wait for a few
moments as the recording lamp first signals STAND BY
then steps through a 3-2-1 countdown.

SN O © © 0024000

When the recording lamp signals RECORDING, and the
movie begins to play back in the Player, perform your
narration.

fcoroill

Finally, click the Stop button. The lamp goes out, and
the voice-over clip is automatically placed on the sound
effects and voice-overs track. Review the clip by
selecting it then clicking the Play button.

Voice-over level

when you create the voice-over and cannot
be changed thereafter. However, you can
adjust the playback volume at any time.
The record level is set with the Recording
level slider and its accompanying level
meter on the Voice-over tool.

Recording-
level slider

The record level for a voice-over clip is set [

Level
meter

Watch this meter to make sure your recording levels
don’t get too high or low. The indicator changes color
from green (0-70% modulation), through yellow, to
red. Generally, you should try to keep your audio
peaking in the yellow (71-90%) and out of the red (91-
100%).
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Voice-over recording options

The Studio setup dialogs include several settings that
affect your recording configuration and quality. This
section provides a brief summary. See “Video and
audio preferences” on page 294 for detailed
information.

To access these options select Setup > Video and audio
preferences from the main menu bar.

aoice-over recording
Microphone:
|Micr0phone - NYIDIA(R) nForcel(TM) .C\udj

Channels: Sample rate:

[te-bicmone x| [ezoske |

The Microphone dropdown list on this dialog lists the
multiple ways a microphone can be connected to your
particular sound card. The entries on the list should
look something like the following, from a system with
an NVIDIA® sound card:

IMicrophone:
Microphone - MYIDIAR) nForcelTr) nudj

Line In - MWIDIA(R) nForcelTH) Audio

D Audio - MVIDIAR) nForce{TM) Audia
Video - NVIDIA(R) nForce(TM) Audio

Aux - NYIDIA(R) nForce(TM) Audio h

Choose from this list, then connect your microphone in
the manner indicated (e.g. Microphone or Line In).

The Channels and Sample rate adjustments on the
options dialog control the quality of voice-overs or
other recorded audio. Set them at the highest quality
level you anticipate needing, but keep in mind that
increasing quality requires more disk space.
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® TRIMMING AUDIO CLIPS

As with other clip types, you can trim audio clips either
directly on the Timeline or by using the Clip properties
tool. See “Trimming on the Timeline using handles” on
page 89 for a discussion of the first method.

Most types of audio clip can be trimmed from a
minimum of one frame up to the full original length of
the clip content. ScoreFitter clips can be trimmed on
the Timeline down to as little as three seconds, and
upward without limit.

Trimming with the Clip properties tool

The Toolbox » Modify Clip Properties menu |@
command invokes the Clip properties tool for

the selected clip. You can also access the tool by
double-clicking any audio clip.

To begin with, the tool provides controls that let you
view or edit two properties shared by all clips:

e To set the duration of the clip, change the value in
the Duration counter.

e The Name text field lets you assign a custom name to
the clip to replace the default one assigned by Studio.
The clip name is used by the Movie Window’s List
view, and can also be viewed as a fly-by label when
your mouse hovers over the clip in the Storyboard
view.
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The other controls provided by the tool depend on the
type of audio clip you give it.

Original audio, sound effects and voice-overs

The Clip properties tool provides the same kind of
trimming controls for sound-effect and voice-over clips
as for video clips, but displays a graph of the audio
waveform instead of visual preview areas.

To learn how to trim with these controls, see
“Trimming with the Clip properties tool” on page 94.

Remember that clips on the original audio and the
overlay audio tracks can only be edited independently
when the corresponding video track is locked. See
“Advanced Timeline editing” on page 98.

. Mame: Gearirind Duration:[0:00:21.20| 3 .o

k4
u +
A
© 0:00:09. 08| %
s [[o:o0:04.09/ 5[ | w » & [[2[0:00:25 28]
i =
I 1B
CD Audio

For CD Audio clips, the Clip properties tool uses the
same trimming controls as above, but additionally
provides dropdown selectors for CD Title and Track.
You can use these to change the source of the clip at
any time. CD Title is also an editable text field, so you
can enter the actual title of the CD.

Chapter 13: Sound effects and music 241



®
%

242

ScoreFitter

ScoreFitter clips can be edited to almost any length,
except that very short clips at some particular durations
may not be available in every combination of Style and
Song. This tool is essentially identical to the tool for
creating ScoreFitter clips (described under “The
Background music tool” on page 235), except that the
Add to movie button is replaced by the Accept changes
button.

© AUDIO VOLUME AND MIXING

The audio levels and stereo positioning of individual
clips can be adjusted either directly on the Timeline, or
with the Volume and balance tool.

Each technique offers its own advantages. Adjusting on
the Timeline gives you a good sense of time versus
volume or balance, whereas the Volume and balance
tool facilitates mixing — separately adjusting the volume
and stereo balance of each of the audio tracks.

For disc authoring, the Volume and balance tool lets
you choose to create a surround soundtrack, rather than
stereo. The tool lets you dynamically position any of
the audio tracks from front to rear as well as left to
right.

Availability: Surround sound is supported in Studio Plus only.
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Anatomy of an audio clip

An audio clip icon on the Timeline has several parts.
The boundaries of each clip are denoted by vertical
bars. The actual content of the audio is indicated by a
waveform graph:

0D BN 4D

Waveform graph excerpt from three neighboring clips.

The appearance of the waveform graph tells you
something about the character of the sound. A quiet
sound has a narrow waveform, close to the centerline of
the clip. A loud sound has a waveform with larger
peaks and troughs, reaching almost to the borders of the
clip. A continuous sound, such as a car engine, has
many pulses packed closely together. A staccato sound
has brief pulses separated by silences where the
waveform is a horizontal line.

Adjustment lines

The orange volume line graphically models the volume
changes you have made to the track and clip. If you
have not adjusted the volume at all, the line runs
straight along the clip at about three-quarters of the clip
height. This is the “zero gain” (0 dB) level, where the
clip’s original volume has been neither increased nor
decreased.

If you raise or lower the volume of the entire track, the
volume line remains horizontal, but is now higher or
lower than the zero-gain base level.
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Finally, if you make volume adjustments within the
clip, the line consists of sloping segments that meet at
volume adjustment handles.

I Clip length | — Adjusted audio level

| Symbolic waveform | Adjustment

representing sound ~handle

—EBase (0dB) level

Unlike the waveform graph, or the adjustment lines for
balance and fade (see below), the volume adjustment
line is scaled logarithmically. Perceived volume varies
logarithmically with the strength of an audio signal, so
this feature allows the adjustment line to model more
accurately what you really hear. For instance, an
upward-sloping line segment will produce a smooth,
steady fade up from the starting to the ending level.

The green stereo balance line and the red front-back
balance (“fade) line work similarly to the volume
line, except that in both cases the neutral position is the
vertical center of the clip, and the adjustment scale is
linear.

Raising the stereo balance line positions the audio
clip’s output further to the listener’s left, while
lowering it positions the clip further to the listener’s
right. Similarly, raising the fade line moves the clip
away from the listener, and lowering it brings the clip
towards the listener.

Note: You can only view and edit a clip’s fade line
when the Volume and balance tool is in surround
mode. The effect of adjusting the line can be previewed
only on systems where surround-sound playback is
available.
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To select which of the three adjustment lines is
currently displayed, use the audio clip’s right-button
context menu:

Select Yolume Display
v Select Balance Display %
Select Fade Display

Availability: Surround sound is supported in Studio Plus only.

Adjusting audio on the Timeline

Audio levels can be adjusted directly within a clip on
the Timeline. Use the mouse pointer to adjust the
volume line or either of the balance lines (see
“Anatomy of an audio clip” on page 243).

When you add a new audio clip to the Timeline:

e The volume adjustment line of the newly-created
clip connects the lines from the preceding and
following clips if any are present.

e If no volume adjustments have been made to other
clips on the track, the volume line through the new
clip is horizontal. Its height reflects the overall track
volume as set in the Volume and balance tool.

e If no volume adjustments have been made either to
other clips or to the overall track volume, the volume
line through the new clip is at three-quarters height.

To adjust the volume of a clip on the Timeline, select it
(by left clicking), then move your mouse pointer close
to the line.
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The volume adjustment cursor will appear:

|E:: T T'T- ':'FT-'i

Click the left mouse button, and drag up or down in the
clip. The volume line bends as it follows the mouse.

When you release the mouse, Studio creates an
adjustment handle on the volume line.

When your mouse pointer is positioned over an
adjustment handle on a selected clip, a highlighted
version of the volume adjustment cursor appears. With
this cursor, you can click and drag the adjustment
handle both vertically and horizontally.

Right-click an adjustment handle to access the context
menu command Delete volume setting. This command
removes one adjustment handle. Use Remove volume
changes to remove all the handles from the clip.

Adjusting balance and fade

The left-right and front-back balance lines have the
same editing features as the volume line just discussed,
except that with them the neutral setting is at half the
clip height, instead of three-quarters as it is for volume.

In the case of left-right (stereo) balance, adjusting the
line upwards from the center positions the audio further
to the left. With front-back balance (“fade”), adjusting
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the line upwards moves the apparent source of the
audio away from the listener; adjusting it downwards
brings the audio closer (towards the rear speakers).

Removing changes

Audio adjustment handles can be removed -either
individually or for an entire audio clip at once. Select
the appropriate command on the clip’s right-button
pop-up menu:

Remove Yolume Changes
Remove Balance/Fade Changes
Add Fade Setting [}x

Transitions on the audio tracks

A quick way to create a fade at the beginning or

end of an audio clip is simply to add a Fade
transition as you would for a video clip. See Chapter 9:
Transitions for details.

To get a cross-fade between two adjacent audio
clips, simply drop a Dissolve transition onto the
Timeline track between them. (Actually, any transition
type other than Fade has the same effect, but Dissolve
gives the best visual reminder of a cross-fade.)

S

Transitions on the audio track: Placed at the
beginning of a clip, the Fade transition fades in;
placed at the end, it fades out. The Dissolve
transition creates a cross-fade between clips.
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The Volume and balance tool

Compared to adjusting audio on the Timeline, @
the Volume and balance tool offers a greater
degree of adjustment functionality organized into one
convenient location. It also provides both left-right and
surround-sound balance controls. The tool operates in a
similar way to a traditional audio mixer.

Availability: Surround sound playback is supported in Studio Plus
only.
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The Volume and balance tool provides individual level
controls for each of the audio tracks: original
audio (left in illustration), overlay audio, sound effect
and voice-over, and background music (right). The
overlay audio controls are displayed only when the
overlay video and audio tracks are open in the Movie
Window.

The balance control, located in the right-hand part of
the tool, can position the audio of any clip — or part of
one — in stereo (one-dimensional) or either of two
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surround (two-dimensional) modes. The mode is
selected in the dropdown list above the control.

Each audio track has its own set of level
controls. The set for the original audio
track is shown at left.

The individual controls and displays
include a track mute button @. When
this button is in its down position, no
audio clips from the track will be used in
your movie. The track mute button’s
icon has a second purpose: it identifies
which track the level controls apply to.
This is the only visible point of
difference amongst the three sets of
controls (four if the overlay track is
visible) .

The track level knob @ raises or lowers the overall
volume for the track. It therefore affects the vertical
position of the volume adjustment lines on all clips on
the track, but does not change their contour. Click on
the knob and drag it with a clockwise rotation (up to
the 2 o’clock maximum position) to increase the
volume. Use a counterclockwise rotation (down to the
6 o’clock minimum) to lower the volume.

Level knobs, full off (L), default (C) and full on (R).

A sliding knob, the track fader ©, sets the current track
level on a relative level scale @, which is calibrated in
decibels (dB). The 0 dB mark corresponds to the level
at which the clip was recorded. The current level is
displayed numerically in a separate readout ©.
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The position of the fader knob shows the volume level
at the current playback position in your movie, relative
to the original level. Drag the knob up or down to
modify the level. The knob is “grayed” (disabled) if
there is no clip on the track at the current time index. If
the track is muted, the knob is grayed and set to the
bottom of its range. Adjusting the fader results in a
volume adjustment handle being added to the track as
described above.

A track’s playback volume contour, or envelope,
combines the overall track level with the relative level
at each point on the track. This combined level, which
is shown graphically by the volume adjustment lines on
audio clips, is applied to the actual audio data to
produce the track’s output level, as represented on the
level meter @, which illuminates during playback to
show the level at the current time index.

To avoid audio “clipping” - the unpleasant sound
produced by attempting to set volume levels outside the
range of a digital signal — ensure that the meter level
never quite reaches the top of the bar. The clipping
indicator @ lights up during and for a short time after
any occurrences of clipping.

The fade buttons ® produce a fade-in from or a fade-
out to the current position of the movie. For a visual
confirmation of their effect, watch the behavior of the
clip’s volume adjustment line when the fade buttons are
clicked.

The fade duration is variable from zero to fifty-nine
seconds. Adjust it in the Project preferences options
panel (Setup > Project Preferences) under Volume
fades. Fades are not available too close to the beginning
or end of a clip.
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The balance control

This control has three modes, stereo, surround and
dialog, which you select from the dropdown list above
the control. The mode can be changed whenever
desired — even within an individual audio clip.

Stereo -

FBIBO S

Surround %

‘L Dialog \
TS T

Availability: Surround sound is supported in Studio Plus only.

In any mode, the position of each track at each point in
the movie is shown by its speaker icon, or “puck”. The
icon matches the one on the muting indicator for the
corresponding track.

In stereo mode, you set the position of the track by
dragging its puck left and right between a pair of main
speakers:

Stereo i

&)

Positioning the original audio in the middle of a
stereo mix with the sound effects track (L) and the
overlay track (R) on opposite sides. In this example
the music track icon (right of center) is ““ghosted™,
indicating either that the track has been muted or
that there is no clip on the track at this time index.

In surround mode, you can position each track from
front to back (“fade”) as well as from left to right
(“balance”). Each track can be independently placed
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anywhere within the rectangular listening area defined
by the four corner speakers.

Dialog mode is similar in concept, but includes the
center speaker at the front of the listening area. Sending
a portion of a clip’s audio through the center helps
stabilize the apparent location of the sound within the
shifting surround mix. At the same time, the placement
of the sound source can be freely varied in two
dimensions as with the standard surround mode.

ISurrUund LJ |Dialug L]

Surround and Dialog modes: At left, the music track,
in Surround Mode, is positioned at the rear of the
listening field. The original audio track at the same
time index is in Dialog Mode, shown at right. The
Dialog mode focuses the original audio by including
the center speaker in the mix.

There are two ways to set the position of a track’s icon
in the balance control. Either click on any track’s icon
and drag it to the desired position, or move it by
dragging the triangular locator knobs below and to the
right of the control. The locator knob below the balance
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control adjusts the left-right positioning of the audio
output from the currently-selected clip, while the knob
on the right adjusts the front-back positioning.

@ ()

| @

I,

Drag track icon directly (L) or with locator knob (R).

Viewing volume and balance contours

Each audio clip in your project displays a contour line
showing one of its volume, left-right balance or front-
back balance. To select which of the three types of line
is displayed, use the commands on an audio clip’s
right-button context menu (see “Anatomy of an audio
clip” on page 243).

The contour lines can be modified directly on the
Timeline using adjustment handles. For details, see
“Adjusting audio on the Timeline” on page 245.

Chapter 13: Sound effects and music 253






CHAPTER 14:

Audio effects

You can modify any audio clip in your project |E
using Studio’s plug-in audio effects, which are
accessed with the Audio effects tool, the sixth tool in
the Audio toolbox. The operation of this tool is
identical to that of the Video effects tool. See “Using
video effects” (page 125) for a complete description.

As with video effects, your library of audio plug-ins is
expandable. Any audio effect using the popular VST
standard can be used in Studio just like effects supplied
with the program.

Icons for audio effects

In Timeline mode, any special effects
you have applied to an audio or video
clip are indicated by small icons
along the bottom of the clip. These
correspond to the categories shown
by the Add new effect browser in the
Audio effects and Video effects tools.
Those categories are explained under
“Video Effects Library” on page 136.

You can open the appropriate tool for
parameter editing by double-clicking
any of the icons.
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In the illustration, the Noise reduction effect has been
applied to both audio clips. The star icon below the
video clip shows that one or more of the effects in the
Fun category has been applied to it.

About the effects

The powerful Noise Reduction filter is provided in all
versions of Studio. It is covered immediately below.

Studio Plus includes an extra group of audio effects.
These are each briefly described starting on page 258.
Full documentation of the parameters for the Plus
effects is included in their context-sensitive on-line
help which can be viewed by clicking the help
button (?) at the top left of the parameters panel for
each effect, or by pressing the F1 key when the panel is
open.

In a special category is the Studio Plus Speed effect,
which is currently unique in that it operates on video
and audio simultaneously. It is covered on page 140.

Noise reduction

This advanced filter suppresses unwanted noise in any
audio clip. The filter responds dynamically to the
changing noise conditions within the clip. The preset
you choose provides the starting point from which the
adaptive algorithm proceeds.

You can often further improve your results by adjusting
the Noise reduction and Fine tuning parameters. There
is a lag of about a second before any new setting has an
audible effect, so you should make changes in small

256 Pinnacle Studio



amounts then pause to check if there is an

improvement.
'./"?:' Moige Reduction Presets; |Musicresturation j
Moise reduction -
Auto adapt [}
Fine tuning = 0.40
Remove wind ]

Noise reduction: When a camcorder is used outdoors
with the actors distant from the microphone, the
“source noise” may be very high, and to make matters
worse the internal noise of the camcorder may be
amplified to intrusive levels. If a lapel microphone
connected to the line input of the camcorder were used
when taping the scene, however, the source noise could
be quite low. Adjust this control to match the noise
conditions of the actual signal.

Fine tuning: This controls the amount of cleaning to
be used. It is only needed when the Noise reduction
level is low, since at higher levels the noise has already
been eliminated.

Auto adapt: When this option is checked, the filter
automatically adjusts to changes in the type or amount
of noise in the clip. The Fine tuning is not used when
Auto adapt is active.

Remove wind: This checkbox engages a filter that
reduces wind noise and similar unwanted background
sounds in the audio clip.

Note: The Noise reduction filter will help with a wide
range of material, but it is not a panacea. Your results
will vary depending on the original material and the
severity and nature of the problems.
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€ PLUS EFFECTS

The Studio Plus pack of audio effects is included with
Studio Plus only. Users of other Studio versions can
obtain these effects by upgrading to Studio Plus.

This section briefly introduces each effect in the group.
Full descriptions, including all parameters, are
available in the context-sensitive help when the effect
parameters window is open in Studio Plus.

ChannelTool

The basic action of this Studio Plus effect is to route
your stereo audio signal. It allows you to connect either
or both of the left and right input channels to either or
both of the output channels. In addition, ChannelTool
offers special-purpose presets, including Phase reverse
and Voice removal — the “karaoke” effect.

Chorus

The Studio Plus Chorus creates a richer sound by
repeatedly reintroducing “echoes” into the audio
stream. By controlling properties like the frequency
with which the echoes recur, and the decay in volume
from one repetition to the next, a variety of results is
possible, including flanger-like sounds and other
special effects.
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DeEsser

This Studio Plus audio filter unobtrusively removes
excessive sibilance from recorded speech. Parameters
allow you to fine-tune the effect to the particular
recording you need to correct.

Equalizer

Graphic equalizers like this one in Studio Plus are
similar in concept to the treble and bass “tone” controls
on audio equipment, but provides a much finer degree
of adjustment. Studio’s equalizer divides the audio
spectrum into ten bands, each centered on a different
sound frequency.

Note: In musical terms, each equalization band covers
one octave, and the center frequency is close in pitch to
the note B.

&1 5 L i) i3 K
24 24
24 -

The sliders let you increase or decrease the contribution
of each band’s frequencies to the total sound over a
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range of 48 dB (-24 to +24). The adjustment to a band
is applied full strength at the center frequency, and
tapers to zero in either direction.

The display above the slider shows the activity across
the audio spectrum as your project is played back.

Grungelizer

The Studio Plus Grungelizer adds noise and static to
your recordings. It can make your clips sound as
though you were hearing them on a radio with bad
reception or a worn and scratched vinyl record.

Leveler

This Studio Plus effect helps compensate for a common
problem in recording audio for video productions: the
imbalance in the recorded volume of different elements
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in the original audio. For instance, your commentary as
you shoot the video may be recorded at such a high
level that it overwhelms other sounds at the location.

The trick in using the Leveler is to find a target volume
somewhere between that of the loud and soft audio in
the original clip. Below that volume, Leveler acts as an
expander, increasing the original level by a fixed ratio.
Above the target volume, Leveler acts as a compressor,
reducing the original level. With careful adjustment of
the parameters, the internal balance of the audio can be
significantly improved.

Reverb

The Studio Plus Reverb effect simulates the effect of
playing back the source sound in a room of a given size
and sound reflectivity. The interval between the arrival
of the original sound at the listener’s ears and the first
echoes is greater for a large room than a small one. The
rate at which the echoes die away depends on both the
room size and the reflectivity of the walls.

The presets for Reverb are named for the type of room
they simulate — from the passenger cabin of a car all the
way up to a huge underground cavern.

Stereo Echo

The Stereo Echo effect, available in Studio Plus, allows
you to set separate delays on each of the left and right
channels, with feedback and balance controls to
provide a variety of interesting sounds.
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Stereo Spread

This Studio Plus effect allows you to decrease or
increase the apparent width of the stereo listening field
in an audio clip. Most often it is used to create a mix
that sounds more open and spacious.
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CHAPTER 15:

Making your movie

One of the great things about digital video is the large
and growing number of devices that can make use of it.
Studio lets you create versions of your movie for
whatever video viewers your audience will be using,
from hand-held DivX players and mobile phones to
HDTV home theaters.

When you have finished editing your project, switch to
Make Movie mode by clicking the Make Movie button
at the top of the screen.

i J 2z 2t

This opens the Output Browser, which lets you tell
Studio with a few clicks everything it needs to know to
output your movie in the form you want.

Begin by selecting the media type of your finished
movie from the four tabs at the left side of the window:
Disc, File, Tape or Web.

Disc output lets you copy a movie onto a
recordable disc in your computer’s CD, DVD, HD
DVD or Blu-ray recorder (also called a “burner”). You
can also ask Studio to create for you a copy, or
“image”, of the disc on your hard drive, without
actually burning it. See page 265 for more information.
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File output creates files that can be viewed from
your hard drive, your web-site, your portable
movie player, or your mobile phone. See page 270.

Tape output records your movie onto tape in a
camcorder or VCR. This tab also lets you output the
movie to your monitor screen. See page 277.

Web output creates a file including for uploading

to YouTube or Yahoo! Video. On these popular
web sites, your work has a potential audience of
millions. See page 279.

( | Disc Type
RO
[ [sveo E piver) )
| Wideo Quality / Disc Usage
T | |Aulumal\c Quality j Free: 32968
| Used: 22268
e Click the Craate buton to chaoss =
destination PO file and begin disc
@ image creation
izh o

SYCD(1:) 700 MB @

Available: 40 minutes

Used: 7 seconds \

; i Quality: 100%
| Createimage.. | | Settings.. |

The Output Browser. The tabs at left let you save to
disc, file, tape or the Web. Other controls let you set
output options as needed for the chosen media type.
On the right is a graphical display o f disc usage.

Configuring output

Output can be configured quickly within each media
type using the dropdown lists in the Output Browser.

: @ | Disc Type
| |
[ iz |DVD j
D | Widen Quality / Disc Usage
fa | |Mostvideo On Disc -
— | |Autornatic Quality
| {Best Quality I
Tep= | [Mostvideo On Disc "
oy | Custom
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If you need hands-on control, click the Settings button
to open the correct panel of options for your chosen
media type. When you have confirmed your settings,
click the Create button to begin output.

(' Create disc | [ Settings... |

Preparing your movie for output

Before your movie is completely ready for output some
preprocessing will usually be required. In general,
Studio will need to “render” (generate video frames in
the output format for) any transitions, titles, disc menus
and video effects you’ve added to your movie. Any
files generated by Studio during this process are stored
in the auxiliary files folder, whose location you can set
using the folder button at the top of the Output
Browser.

0‘0 OUTPUT TO DISC MEDIA

¢

Studio can output movies directly onto VCD
(VideoCD), S-VCD (Super VideoCD), DVD, HD DVD
and Blu-ray discs, if the requisite disc burning
hardware is available on your system.

Whether or not you have a disc burner, Studio can also
create a “disc image” — a set of files containing the
same information that would be stored onto the disc —
to a directory on your hard drive. The image can
subsequently be burned to disc.
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CD formats

If your system is equipped with a CD burner or a DVD
burner, Studio can create VCD or S-VCD discs on
either CD-R or CD-RW media.

Your VCD discs can be played back:

On a VCD or S-VCD player.

On some DVD players. Most DVD players can
handle CD-RW media, but many will not reliably
read CD-R. A majority of DVD players can handle
the VCD format.

On a computer with a CD or DVD drive and
MPEG-1 playback software (such as Windows
Media Player).

Your S-VCD discs can be played back:

On an S-VCD player.

On some DVD players. Most DVD players can
handle CD-RW media, but many will not reliably
read CD-R. DVD players sold in Europe and North
America usually cannot read S-VCD discs; players
sold in Asia often can.

On a computer with a CD or DVD drive and
MPEG-2 playback software.

DVD, HD DVD and Blu-ray

If your system has a DVD burner, Studio can create
three types of DVD disc: standard (for DVD players),
HD DVD format for HD DVD players, and AVCHD
format for Blu-ray players.
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If your system has an HD DVD or Blu-ray recorder,
you can record onto any recordable media supported by
the device.

Your standard DVD discs can be played back:

e On any DVD player that can handle the recordable
DVD format your burner creates. Most players can
handle the common formats.

e On a computer with a DVD drive and suitable
playback software.

e Onany HD DVD player.

Your DVD or HD DVD disc in HD DVD format can
be played back:

e On any HD DVD player, including a drive-equipped
Microsoft Xbox 360.

e On a computer with an HD DVD drive and suitable
playback software.

Your Blu-ray disc, or DVD disc in AVCHD format
can be played back:

e On the Panasonic DMP-BD10, the Playstation 3, and
other Blu-ray players (not all players support the
AVCHD f ormat, but most do).

e On a computer with a Blu-ray drive and suitable
playback software.
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Outputting your movie

Studio creates your disc or disc image in three steps.

1.

First the entire movie must be rendered to generate
the MPEG-encoded information to store on the
disc.

Next, the disc must be compiled. In this phase,
Studio creates the actual files and directory
structure that will be used on the disc.

Finally, the disc must be burned. (This step is
skipped if you are generating a disc image rather
than an actual disc.)

To output your movie to disc, or to a disc image:

1.

Click the Disc tab to bring up this display:
N o ——

| Video Guaiiy ¢ Disc Usage
| |Most¥ideo On Disc -
| |Autormatic Quality

| [Best Quality %
| [Mostvideo on Disc
| |Custom

5

5D

( Create disc | ( Settings... |

The two circular displays summarize your disc
usage. The upper one shows the amount of hard
drive storage that will be required during the
making of your movie, and the other shows an
estimate of the time the movie will occupy on your
writable disc.

Use the upper folder button [C1] to change the hard
drive location Studio uses for storing auxiliary files.
If you are creating a disc image, it will also be
stored in that folder. The matching button on the
lower display lets you choose which burning
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hardware to use, if you have more than one device
available.

2. Select the Disc Type you are using, then whichever
Video Quality / Disc Usage preset best matches

your intent.
@ Disc Type
Dige |DVD j
D Yideo Quality / Disc Usage
L Mostvideo On Dist =
e Autamatic Quality
Best Quality I
LzEe Mastvideo On Disc by
y Custom

If you wish to fine-tune your output settings,
choose the Custom preset then click the Settings
button to bring up the Make Disc options panel (see
“Make disc settings” on page 299).

3. Click the green Create disc button. Studio goes
through the steps described above (render, compile,
and if necessary burn) to create the disc or disc
image you have specified in the Make Disc options
panel.

4. When Studio has finished the burning operation, it
ejects the disc.

Quality and capacity of disc formats

The differences amongst the various disc formats can
be boiled down to these rules of thumb regarding the
video quality and capacity of each format:

e VCD: Each disc holds about 60 minutes of MPEG-1
video, with about half the quality of DVD.

e S-VCD: Each disc holds about 20 minutes of
MPEG-2 video, with about two-thirds the quality of
DVD.

Chapter 15: Making your movie 269



*
%

270

DVD: Each disc holds about 60 minutes of full-
quality MPEG-2 video (120 minutes if the disc
recorder supports dual-layer recording).

DVD (AVCHD): Each disc holds about 40 minutes
of full-quality AVCHD video per layer.
DVD (HD DVD): Each disc holds about 24 minutes
of full-quality DVD HD video per layer.

DVD HD: Each disc holds about 160 minutes of
full-quality DVD HD video per layer.

¥ OUTPUT TO FILE

Studio can create movie files in all of these formats:

3GP

Audio only

AVI

DivX

Flash Video
iPod compatible
MPEG-1
MPEG-2
MPEG-4

Real Media
Sony PSP compatible
Windows Media

Choose whichever format matches the needs of your
audience and the details of their viewing hardware.
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The size of the output file depends on both the file
format and the compression parameters set within the
format. Although compression settings can easily be
adjusted to produce small files, heavy compression
comes at the expense of quality.

The detailed settings for most formats can be adjusted
by choosing the Custom preset and clicking the
Settings button. Other presets load settings designed for
typical situations. See Appendix A: Setup options for
information about options in Studio.

When your output options are in place, click the Create
file button. A file browser opens to let you specify a
name and location for the video file you are creating.

As a convenience, the Output Browser
also provides buttons for launching any {‘ﬂ @
desired media file in Windows Media Player or Real

Player, so you can view your output file in an external
player as soon as you have created it.

@ | File Type
= |MPEG 4 ﬂ
[ D | Preset
| |High Definition |
| | Use this presst to create high
i dehmllon vldeos for p\ayback ah your
@ computer TV
L | Settings
| ~ Video:  1260x720, G000 Kbits/sec. 29.97
Clck th Ciateon below o ) Frames/sec
hiegin making vour
= Audio:  MPEG-4, 192 Khits/sec, 16 Bit Steren,
e
| Createfile.. | { Settings.. |

The File tab of the Output Browser

3GP

Studio can generate movies in this widely-used file
format using your choice of MPEG-4 or H.263 video
compression, along with AMR audio compression. The
format is adapted to the comparatively modest
processing and storage capabilities of mobile phones.
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@ File Type
Dizc |SGP j
Prezet
% |5rmall - MPEG-4 Video ~|

ot Wery Small - H263 Yideo

Vary Simall - MEEG-4 Video T
S Small - H263 Video %
Pra) Srnall - MPEG-4 Video

The list of presets for this file type offers two frame
sizes in either encoder. Choose Small, at 176x144, or
Very Small, at 128x96.

Audio only

Sometimes a movie’s soundtrack can stand alone
without visuals. Live entertainment footage, and video
recordings of interviews and speeches are instances in
which an audio-only version might be desirable.

Studio lets you save your soundtrack in wav (PCM),
mp3 or mp2 format.

@ File Type

e | [audio ~|
B Prezet

| — |PCM Stereo 44kHz ~|
A, P 3 Stereo 44kHz
PCM Steren 44kHz "
== PCh Steren 48kHz by
oy Custam

Click the preset that best meets your needs; or choose
Custom, then click the Settings button to open the Make
File options panel (see page 304).

AVI

Although the AVI file type for digital video is itself
widely supported, the actual coding and decoding of
video and audio data in an AVI file is performed by
separate codec software.
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Studio supplies a DV and an MJPEG codec. If you
wish to output your movie as an AVI in some other
format, you can use any DirectShow-compatible codec
installed on your PC, as long as that codec is also
installed on the PC that will play your movie.

@ File Type
Dize: |AV| j
Preset
% | Medium j

T Full screen (DV)
Fuil seraer (MIPEGT
=22 Medium

Small
@ Custarm
nfeh

Click the preset that best meets your needs; or choose
Custom, then click the Settings button to open the Make
File options panel (see page 304).

DivX

This file format, based on MPEG-4 video compression
technology, is popular for video files disseminated over
the Internet. It is also supported by a range of DivX-
compatible hardware devices, from DVD players to
portable and handheld units.

@ File Type
Dizc |Di'\"}{ j
Prezet
% |small 16:0 -
Small 16.9
Medium 16:9

T2 Fuil screen 16:9

@ High Definition 16:9 [
ik

Custom 16:9

Click whichever of the quality presets matches your
needs; or choose Custom, then click the Settings button
to open the Make File options panel (see page 304).
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Flash Video

Studio supports output in Flash Video (flv) format,
version 7. Virtually all current web browsers are able to
display this popular format, which has been widely
adopted by social networking sites and news sites.

File Type
== | |Flashvideo -
B Prezet
File |Fu|l5creen15:9 j
i Full screen 16:9
Wedium 16:9
Tape Small 169 N
@ Custorn 16:9 by

Click the quality preset that matches your needs; or
choose Custom, then click the Settings button to open
the Make File options panel (see page 304).

iPod compatible

Like DivX, this file format is based on MPEG-4 video
compression technology. The combination of powerful
compression with a small 320x240 frame size produces
very small output files relative to the more expansive
formats. The generated files are compatible with the
popular Video iPod devices, and may work with some
other devices types as well.

File Type
Disc |iPod Compatible -
D Fresst
= | |smallFile Size -
et Small File Size
Good Gt f
=28 High Quality "

The three quality presets select different data rates,
each providing a different balance of quality and file
size.
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MPEG

MPEG-1 is the original MPEG file format. MPEG-1
video compression is used on VideoCDs, but in other
contexts it has given way to newer standards.

File Type
Disc: |h'|l”:'EG_‘1 j
D Preset
e | |video oD Compatible |
video CD Compatible
= WS Guaiy
v oo el »\[\g
o) Custom

MPEG-2 is the successor format to MPEG-1. Whereas
the MPEG-1 file format is supported on all Windows
95 and later PCs, MPEG-2 and MPEG-4 files can only
be played on PCs with appropriate decoder software
installed. Two of the MPEG-2 presets support HD
(High Definition) playback equipment.

File Type

= | |MPEG-2 -
Prezet

% |DVD Compatible -

et DD Compatible

SVCD Compatible

T HD 73ip N
HD2 1080i by

@ HD 1080i

Custom

MPEG-4 is another member of the MPEG family. It
offers image quality similar to MPEG-2 but with even
greater compression. It is particularly suitable for
Internet use. Two of the MPEG-4 presets (QCIF and
QSIF) create “quarter-frame” video sized for cell-
phones; two others (CIF and SIF) create “full-frame”
video suitable for handheld viewers.

Custom presets. With all MPEG variants, Custom lets
you configure movie output in detail by clicking the
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Settings button to open the Make File options panel
(see page 304).

File Type
@ |MPEG-4

Disc: j
D Frezet

= |Medium j
TR Small

Medium

== Full size

Al

High Definition
@ Custom

Real Media

Real Media movie files are designed for playback on
the Internet. Real Media movies can be played back by
anyone around the world who has the RealNetworks®
RealPlayer® software, which is a free download from
www.real.com.

See page 308 for information about configuring your
output with the Make File — Real Media options panel.

Sony PSP compatible

This is another file format based on MPEG-4 video
compression technology. As with the iPod-compatible
type, the combination of powerful compression with a
small 320x240 frame size produces very small output
files relative to the more expansive formats. The
generated files are compatible with the popular Sony
PlayStation Portable devices, and may work with some
other devices types as well.

File Type

- |50ny PSP Compatible -
Iﬁ Preset

e | |High quality -
00 Emal File Gize "
Good Quality 23

TR High Quality
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Windows Media

The Windows Media file format is also designed for
streaming Internet playback. The files can be played on
any computer where the Windows Media player — a
free program from Microsoft — is installed.

See page 311 for information about configuring your
output with the Make File — Real Media options panel.

0’0 OUTPUT TO TAPE

4

Choose the Tape tab on the Output Browser when you
want to send your output to an external video device —
a television, camcorder or VCR - or to “VGA”, for
viewing on your monitor screen.

Configuring the camera
or video recorder...

Make sure your recording device is properly connected
before you begin to generate the movie.

Output via IEEE-1394 cable

If your recording device has a DV input, just connect it
to your digital video hardware with an IEEE-1394 (or
“i.LINK”) cable. The connector at the camcorder end
should be labeled DV IN/OUT.
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Note: On machines that don’t support recording back
to the camcorder, including many PAL devices, the DV
connector is called simply Dv OUT.

Output with analog audio / video cables

If you have a Studio product with an analog (TV or
video) output, such as Studio DVplus or DC10plus,
connect the video outputs of the capture card to the
inputs of the video recorder and the audio outputs of
the sound card (or the capture card, if it has them) to
the audio inputs of the video recorder.

Connecting a TV set or video monitor

Many camcorders have an integrated display, making it
unnecessary to attach a video monitor.

Otherwise, to view your movie as it is recorded, a TV
set or a video monitor must be attached to the video
outputs of your recorder. Video outputs are not always
available on DV camcorders.

Computer (CPU)

TV or monitor
(optional)

>
B

IEEE-1394

DV Camcorder

Audio out
Video out

Audio out
Video out

L B J

S
IEE===1

o0
Analog VCR
(optional)
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I——_—_—_——
Output your movie to videotape

Verify that the camcorder/VCR is powered on and
configured, and that you have inserted a tape cued to
where you wish to begin recording. You now have two
options:

1. If you are recording your movie onto DV tape,
Studio gives you the option to control the DV
device automatically. Click the Settings button then
activate the check box in the Output options area.

With most DV devices there is a small delay
between receiving the command to record and the
actual start of recording. Since it varies from one
device to another, you may need to experiment with
the Record delay time value for best results with
your particular device.

2. If you are recording onto analog tape, or have not
checked the Automatically start and stop recording
option on the Make tape options panel, start your
VCR recording now.

Finally, click Play in the Player.

¢ OUTPUT TO THE WEB

Studio can upload your video directly to either Yahoo!
Video or YouTube, for sharing with a potential
audience of millions of other Internet users.
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@ Upload To This Web Site
o |Yahuu j
B Presst
= IBest Quality j
Upload completed successfully! Click.
——— | | the button to the nght to see your
| @ video online.
-

Settings

Video:  480x420, 2400 Kbits/sec, 29.97
Frames/ssc

Audio:  MPEG Layer 2, 224 Kbits/sec, 16 Bit
Stereo, 44.1kHz

( Create .. )

The Yahoo option offers two preset formats, Best
Quality and Fast Upload. These provide different
combinations of frame size and video data rate:

e Best Quality scales your video to a 480x480 frame
size, and requires a data rate of 2400 Kbits/second.

e Fast Upload uses a 352x240 frame size, and requires
a data rate of 1150 Kbits/second.

Web Upload

Title

] Helena Handcart

Description

Thorkney puts it all in perspective - then pulls it out again!

Tags
I Made by Pinnacle Studio, dadaism, penguin studies, ringtone tricks

Category Max. 3 selections per upload
[v] Animals [CIMusic
[1Animations [WiNews
[JAutos [[15ports
[1Games [WiTravel
[ 1Humor [[1Video Blogs
[ IMovies

I™ Login as a different user

Cancel )

The YouTube option offers only one preset, Best
Quality. The frame size is 320x240, and the data rate is
256 Kbits/second.
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No additional format settings are required for either
destination.

After selecting the upload site and preset you want,
click the Create button. This opens the Web Upload
dialog box, where you can enter editorial information
about your production.

Set the title, description and comma-separated search
tags as desired, then check up to three categories in
which your movie should be listed.

If you have previously logged into your Yahoo!
account from Studio, but this time want to use a
different user ID, check the Login as a different user
box.

Unless you are already logged in, the Yahoo! Desktop
Login dialog is now displayed. If you have an existing
Yahoo! Identity, enter your user information now;
otherwise, you must first click the Sign up link to set up
a new Yahoo! account.

* Welcome to Yahoo! Desktop Login

Please Sign In to Yahoo! Video

YaHoO!

VIDEO Yahoa! 1D

Password:

Remember my ID

Studio now automatically creates and uploads
your movie. Click the Watch video online button
if you would like to visit the Yahoo! Video site in your
web browser to confirm the success of the upload.
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APPENDIX A:

Setup options

Settings are provided to adjust various aspects of
Studio’s operation. The default values have been
chosen to work well for the majority of situations and
hardware. However, you may wish to modify them to
suit your work style or equipment configuration.

About Studio setup options

Studio’s setup options are divided between two tabbed
dialog boxes, both with several panels.

The Main Options dialog box has four panels covering
options relating to Capture mode and Edit mode. Open
this dialog box to any panel by selecting one of the
commands in the first group on the Setup menu.

Pinnacle Studio Plus Setup Options

| Capture source ] Capture fomat ] Project preferences ] Video and audio preferences ] ‘

The Make Movie Options dialog box has three panels,
one for each of three media types: disc, file and tape.
Access this dialog box by selecting one of the
commands in the second group on the Setup menu.

Pinnacle Studio Plus Setup Options

Make Disc | Make Fie | Make Tape| |

Option settings in Studio apply to both the current and
future Studio sessions. There is no master reset.
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Capture source settings

Remember that any changes you make on this panel
affect all future captures. If you want to configure only
one capture session, make sure you restore the old
values before the next session.

The settings are grouped into areas: Capture devices,
Scene detection during video capture and Data rate.

Capture devices

Studio senses which capture hardware you have
installed on your system for both video and audio. If
you have more than one available capture device in
either category, choose the one you want to use for the
current capture session.

Capture devices
Wideo T¥ Standard Aspect Ratio

|Pinnacle Studio Deluxe ﬂ | J | J

Audio

|Pinnacle Studio Deluxe j IV Capture preview

Video: The devices listed here may include both digital
equipment connected via an IEEE-1394 cable and
various types of analog video source (Studio DC10plus,
TV tuner card, USB-connected camera, etc). Your
selection determines the availability of some other
Capture source settings, and of many settings on the
Capture format panel.

Audio: Your choice of audio devices is constrained by
which video device is selected. With most analog
devices, for instance, you can choose any of your sound
card inputs; your equipment configuration determines
which one you should use.
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TV standard: Choose the standard that is compatible
with your capture device and your TV or video monitor
(NTSC or PAL). NTSC is the standard used in North
America and Japan. PAL is the standard used in most
other places. With some capture devices you may have
an additional choice: the SECAM standard used in
Russia, France and some other countries. If you
purchased your Studio product in North America, the
option is permanently set to NTSC.

VCR input: This option, which is available with some
analog capture devices, is available to help deal with
the video instability that can arise from using old
playback equipment — not necessarily but typically a
VCR - or worn videotape. When the option is
activated, capture will be more tolerant of A/V
synchronization problems in the incoming signal.

Capture preview: This option controls whether the
incoming video will be previewed in the Player during
capture. Because generating the preview uses a
significant amount of processor time, previewing may
cause dropped frames during capture on some systems.
Only turn off the option if you are having a problem
with dropped frames.

Aspect ratio: This dropdown list specifies whether the
video source for future analog captures should be
interpreted as having normal (4:3) or widescreen (16:9)
format.

Scene detection during video capture

The effect of these scene detection options is described
under “Automatic scene detection” on page 26. The
options that are actually available depend on the
capture device being used: not all devices support all
modes.

Appendix A: Setup options 285



286

The first option, “Automatic scene detection based on
shooting time and date”, is available only if you are
capturing from a DV source.

Scene detection during video capture
{+ Automatic based on shooting time and date
" Automatic based on video conkent
(" Create new scene every 'T sgconds

" Mo auto scene detection -- press space bar ko create scene

Your DV camcorder records not only images and
sound, but also the time, date, and various camera
exposure settings (see your camcorder manual for more
detail). This information is termed data code, and is
transferred through the IEEE-1394 link along with the
video and audio.

Under the default setting, Studio uses the data code
information to determine when each new scene begins.
It grabs the first frame of each new scene to use as an
icon for display in the Album.

Data code does not work if the tape:

e includes one or more blank (unrecorded) sections

e is unreadable due to tape damage or electronic noise
o was recorded without the camcorder time or date set
e is acopy of another tape

e was shot on an 8mm or Hi8 camcorder, and is now
being played back on a Digital8 camcorder.

Under the final option — “No auto scene detection” — a
new scene is created each time you press the [Space]
key.
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Capture format settings

The options available here depend on the capture
device you are using (from the Capture source tab).
You will not see all the settings described below
displayed at once.

Presets

The settings in the other areas on the Capture format
panel depend on your choice in this Presets area. The
available presets depend in turn on your capture
hardware.

Presets

|MPEG-1j2 | |High quality (ovD) | DvD Compatible

For a DV capture source, the main capture options are
selected in the first of two dropdown lists. (The other
list provides any applicable sub-options.) The choices
are:

e DV: Full quality DV capture, which uses about 200
MB of disk space per minute of video. There are no
sub-options with this setting. DV capture is
recommended over MPEG if outputting your project
to videotape is a possibility.

e MPEG: Capturing to MPEG takes less space than
DV but more time — both when capturing and later,
when you output your movie. The quality presets
(High, Medium and Low) are available as sub-
options, plus a Custom preset that lets you configure
the video settings manually. The best preset to use is
the lowest one that meets the requirements of all the
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devices on which your movie will be played. Use
Low if you are outputting only for VCD; Medium if
you need to accommodate S-VCD; and High if your
movie will be output for DVD.

Other types of capture device provide a single list of
quality options — generally Good, Better, Best and
Custom.

Presets

|Better | wHs videa

Studio AV/DV Analog captures use fixed capture
settings with no further options.

Video settings

The settings available in this area depend on both the
capture device and the options selected for it in the
Presets area. Only applicable settings are shown. The
settings are editable only if you are using a Custom
preset.

Options: This button gives you access to any setup
options offered by the codec (compression/decom-
pression software) you have chosen.

Compression: Use this dropdown list to select the
codec you want to use.

Width, Height: These fields control the dimensions of
the captured video.

Frame rate: The number of frames per second you
wish to capture. The two numerical options represent
full-speed and half-speed video respectively. The lower
number (14.985 for NTSC, 12.50 for PAL or SECAM)
saves disk space at the expense of smoothness.
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Quality, Data rate: Some codecs present quality
options in terms of a compression percentage (Quality),
and others in terms of the required data transfer rate in
KB/sec (Data rate).

MPEG type: Select one of the two flavors of MPEG
encoding: MPEG1 or MPEG2. The former is almost
universally supported on Windows computers; the
latter gives better quality for a given compression ratio.

Resolution: This is a dropdown list giving the
resolutions available with the capture options you have
picked. Increasing both the width (the first figure) and
the height by a factor of two increases the amount of
data to be processed by a factor of four.

Fast encode: This option speeds up the encoding
process with some reduction in quality when capturing
to an MPEG file. You may want to evaluate the effect
of this option in your production using a short test
capture.

Audio settings

These audio capture settings are editable only if you are
using a Custom preset.

Audio settings
¥
COMmpression:
|MPEG Layer 2 |

Sample rate

| 52 I TR

Include audio: Clear this checkbox if you are not
planning to use the captured audio in your production.
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Options: This button gives you access to any setup
options offered by the codec (compression/
decompression software) you have chosen.

Compression: This dropdown shows the codec that
will be used to compress the incoming audio data.

Channels, Sample rate: These settings control audio
quality. “CD quality” is 16-bit stereo, 44.1 kHz.

MPEG capture

This area is visible only when an MPEG preset for the
capture format has been selected.

The three options on the dropdown list control whether
MPEG encoding is performed during capture, or as a
separate step when capture is complete.

e Use default encoding mode lets Studio decide which
of the other two choices to use given the speed of
your computer.

e Encode in real time means that capture and encoding
occur in one step. This will produce good results
only on a fast enough machine.

e Encode after capturing means that encoding will not
be performed until the capture itself is complete.
This takes longer but is more reliable if you have a
slower CPU.

I——_—_—_——
Project preferences

These settings are split into five areas, which are
covered in the subtopics below. Hardware settings

290 Pinnacle Studio



relating to editing are on the Video and audio
preferences panel (see page 294).

Editing environment

Automatically save and load my projects: If this
option is checked, Studio will continually update your
stored project while you work without you having to
save your changes explicitly. If you would prefer to
look after your own loads and saves, leave this option
unchecked.

Show large storyboard thumbnails: Check this box
to get more detail in the thumbnail frames shown by
Storyboard view in the Movie Window.

Show premium content, Show premium features:
Premium content and features allow you to expand
Studio easily and conveniently when you need more
resources or more power to enhance your movies.
Premium content refers to add-on effects, transitions,
titles, menus and sound effects. Premium features
refers to pan and zoom, chroma key, and other
advanced capabilities.

Check the boxes if you would like the premium items
to be listed in the Album and other appropriate places
in Studio.

In general, when you click on a premium item you will
be offered the chance to purchase and install it
immediately, without leaving Studio, if you have an
Internet connection available. See “Expanding Studio”
on page 11 for further information.

Project format

By default, your Studio movie project is in the same
video format as the first clip you add to it. If you want
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to force new projects to a different format, click Use
this format for new projects, and select your desired
format from the dropdown list.

Project format

(™ Set from First clip added to project
{* Use this Farmat For new projects:

MNTSC Widescreen ﬂ

MTSC Standard -~
CUNTEE Widescreen ™

MNTSC Progressive

MTSC Progressive Widescreen

PaL Standard

PaL Widescresn

PAL Progressive

PAL Progressive Widescreen

HD 1280x720/25p

HD 1280x720/30p

HO' 1440:1020/50i

HD' 1440: 1030600

HD 1520 1 050/50i i

Default durations

These duration times are measured in seconds and
frames. The seconds counter advances every 30 frames
for NTSC, or 25 frames for PAL.

Default durations

Transitions: Titles)stills: Wolume fades:

- - -

0z.00 21 ‘o400 S ‘nzoo d

The three settings here control the initial duration value
for transitions, still images and volume fades when
added to your movie. The durations can be trimmed to
custom values during editing. The default values upon
installation are as shown in the illustration above.

When adding a disc menu

When you place a disc menu on the Timeline, Studio
inquires whether you want to generate chapter links
from the menu to all the clips that follow it (at least
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until the next menu). The choices on this dropdown list
let you avoid the confirmation dialog by specifying that
you always don’t or always do want the links to be
created, or that you want Studio to create links from a
new menu to its chapters and also return links back to
the menu from the end of each chapter. A final option,
“Ask if chapters should be created”, enables the
confirmation dialog, restoring the factory default.

when adding & disc menu...

Create chapters and returns ﬂ
Don't create chapters

Create chapters automaticall

Create chapkers and returns [~

sk if chapters should be created M

Minimum chapter length: If you have specified that
Studio should create chapter links automatically when
you add a menu, multiple clips are combined into
chapters if necessary to achieve this minimum duration.

Folder for auxiliary files

Studio generates auxiliary files in many circumstances
as you edit and output your project. These are all stored
under the disk folder specified here. Click the Folder
button to change the auxiliary files’ location — usually
because you need to save space on a particular drive.

Folder For auxiliary files
EI H:%PontiachRender'.

" Delete.. )

Delete: This button opens the Delete Auxiliary Files
dialog, which lets you recover hard drive space by
deleting files created while your project was being
rendered.
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Video and audio preferences

The five areas on this panel provide hardware and
previewing settings.

Video preview

Because of the central role of previewing during
interactive video editing, Studio provides a number of
settings that affect preview behavior.

Video previews

|~ Enable full-resolution prewview:

|v Enable hardware acceleration

Show full-screen preview on;
|Se-:0nd WiEA monitar j

External:

|N0ne ﬂ

For previewing on a computer monitor, the default
preview, at quarter-frame resolution, is probably quite
good enough. If you have exacting requirements for the
preview, and particularly if you are targeting an
external output device for preview (by selecting it on
the External dropdown list), you may need to check
Enable full-resolution preview. On some machines
there may be a noticeable performance cost to this
option.

Enable hardware acceleration takes advantage of the
advanced capabilities of your graphics card where
applicable. The option should be checked unless you
are having display problems during preview.

The Show full screen preview on dropdown list lets you
specify how Studio should preview when you click the
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full-screen button on the Player. The options available
on the list depend on your display hardware.

On a single monitor system, a full-screen preview
(other than external) must obviously use the same
screen as Studio’s own interface. This is the Main VGA
monitor option. In this special instance, full-screen
playback begins from the current play position when
you click the full-screen button, and ends either at the
end of the movie or when you press the Esc key.

Safe mode second WiGA, small preview j

Main Y¥&d monitor
Second WiaA monitor

Safe mode second YGA, small preview

With a dual-monitor computer system, you would
normally use your second screen as a full-size preview
monitor and leave Studio unobscured on your main
screen. The display on the second monitor is controlled
entirely by the full-screen button, independently of
whether your movie is playing back or paused.

The most straightforward option for full-screen preview
is Second VGA monitor. In this mode, the preview is
scaled to use as much as possible of the monitor display
(without disturbing the aspect ratio of the video). The
Player preview on the main screen remains blank,
conserving processing power. When a second display is
available, this is the recommended mode for most
users.

The remaining two options are special modes that allow
full-screen output on one monitor while still providing
a normal preview within the Studio window. These
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modes are offered only if your dual-output video card
is one of the following types:

e ATl Radeon 9600 (or better) with version 5.8
(minimum) of the Catalyst™ display driver.

In order to use the additional preview modes, you
must deactivate the second monitor in the Display
Properties dialog (or the Catalyst control center)
before launching Studio.

e nVidia GeForce Fx5xxx or better, or an equivalent
card in the Quadro series. The minimum driver
versions are 81.85 (GeForce) and 81.64 (Quadro).

Before launching Studio, the second monitor must be
activated as a Windows desktop extension (not in the
Span or Clone modes).

Studio checks on start-up to see if these conditions are
met. If so, the remaining options are made available:

Second VGA, small preview on main VGA: This option
goes beyond the other full-screen modes by
reconfiguring the monitor display to match the exact
format of your project’s video specifications for frame
format and refresh rate. For instance, if your project
format is 720x480 with the NTSC refresh rate of 60
Hz, the monitor will be put into that mode for the most
accurate possible preview. At the same time, the usual
small Player preview is displayed on the main screen.

Note: Even if you have the correct graphics card, the
desired format may still not be supported by a
particular monitor. If Studio determines that to be the
case, it tries to fall back to the final preview mode
(next paragraph). If any instability occurs with your
hardware set-up, reverting to one of the basic modes
covered above is strongly recommended.
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Safe mode second VGA, small preview: In this mode,
Studio matches your project video format as well as
possible to the formats supported by the monitor. For
instance, if the 720x480 frame format is unavailable,
Studio will set the display to 800x600 and center the
frame on the monitor screen. Similarly, if the monitor
does not support 50 Hz (PAL) output at a particular
screen size, it will display at 60 Hz instead.

Voice-over recording

Microphone: A dropdown list of choices for attaching
a microphone to your hardware.

Channels, Sample rate: These settings control audio
quality. A typical setting for voice-overs is 16-bit mono
at 22.05 kHz.

oice-aver recording
Microphane:
|Microphone - NYIDIA{R) nForce(TM}) P.udj

Channels: Sample rate:
[t6-bitmora ~|  [ezioske |

Background rendering

Rendering is the process of generating video for
footage that uses HFX transitions, effects or other
computationally demanding features of Studio. Until
such video has been rendered, it may not display
smoothly and with full detail during preview.

Studio is able to carry out rendering behind the scenes
while you work, a feature called background rendering.

Background rendering

| Enable background rendering

(" Set coder autornatically
{* Use this codec For background rendering:

DV best For output to DY tape j

Current: DY
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Enable background rendering: Uncheck this box if
you do not want to use background rendering at all.
One might do this on a slower computer if intensive
rendering were causing other operations to become
sluggish.

Set codec automatically: Let Studio decide which
codec to use for encoding your rendered video.

Use this codec for background rendering: If you
know that your project is going to DV tape, choosing
DV as your background rendering format may reduce
the rendering time of your final movie. You would
normally choose MPEG for as the rendering codec for
disc-bound movies for the same reason.

Another consideration arises if you are planning to
preview your video on an external device (Studio Plus
only). In such cases you may need to set the project
format and the background rendering codec to suit the
device. For instance, if you are previewing on an
analog monitor plugged into your DV camcorder, you
should do your background rendering in DV.

Surround-sound playback

Check Enable discrete 5.1 playback if the audio system
you use when previewing your Studio project supports
discrete 5.1 audio. Leave it unchecked if you are
previewing in surround-sound with a Pro Logic
compatible system, or in stereo.

Surround sound

I Enable discrete 5.1 surround sound playback
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CD drive (for ripping audio files)

If you have used any music from CD in your project,
Studio digitally transfers (“rips”) the audio data from
the disc to the computer. The dropdown list here lets
you select which CD device to use for ripping, if you
have more than one available.

D drive (for ripping audio Files)

—
I EEEEEEEEEES———

Make Disc settings

These settings allow you to adjust options for creating
VCD, S-VCD, DVD, HD DVD or Blu-ray discs, and
for creating a disc image on a hard drive.

To create a VCD or S-VCD requires a CD or DVD
burner; to create a DVD requires a DVD or HD DVD
burner; to create an HD DVD requires an HD DVD
burner; to create a Blu-ray disc requires a Blu-ray
burner.

You can burn DVDs in standard format for DVD
players, in AVCHD format for Blu-ray players, or in
HD DVD format for HD DVD players. For details, see
“Qutput to disc media” (page 265).

Format

Disc Type: Select VCD, S-VCD, DVD or Blu-ray to
create a disc (or disc image) of the corresponding type.
Select HD DVD to create either a DVD or an HD DVD
for playback in an HD DVD player. If you want to
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create a DVD readable in most Blu-ray devices, choose
AVCHD.

Video quality / disc usage: These settings (Automatic,
Best video quality, Most video on disc and Custom) are
available except in the case of VCDs, where the format
is fixed. The first three settings are presets that
correspond to particular data rates. The Custom option
lets you set the data rate to another value. In each case,
an estimate is provided of the amount of video the disc
can accommaodate at the current setting.

Kbits/sec: When the Custom option has been chose in
for the previous setting, this combination dropdown list
and edit field lets you choose or specify the data rate —
and hence the video quality and maximum duration —
of the disc. Higher values correspond to better quality
and lower capacity.

Audio compression: Depending on the format, some
of all of the following methods of storing your movie’s
soundtrack are offered:

e PCM encoding for stereo sound is supported by all
DVD players, but takes up more space on the DVD
than MPEG.

e MPEG audio, in MPA (MPEG-1 Layer 2) format, is
always provided on PAL DVD players. On NTSC
players it is broadly supported, but theoretically
optional.

e Dolby ® Digital 2-channel encoding can be used to
compactly store either a stereo or a surround
soundtrack. To hear the surround mix requires
equipment with Dolby Pro Logic compatibility. On
other systems, it will sound like a normal stereo mix.

e Dolby ® Digital 5.1-channel encoding stores the
surround channels discretely. To hear the surround
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mix on playback requires a surround amplifier and
speaker system.

Use progressive encoding: Each frame of a normal
television picture is displayed as two successive
“fields”, each containing half of the several hundred
horizontal video lines that make up the entire image:
the odd-numbered lines in one field, and the even-
numbered lines in the other. The eye sees the
superimposed fields as a single image.

This system, called “interlaced scanning”, produces
reasonably good results because of the characteristics
of television screens and the human visual system.

However, high-definition TV systems and typical
computer monitors provide “progressive scanning”, in
which the image is drawn from top to bottom at a
higher screen refresh rate, potentially producing a
clearer image with less flicker. If your project mainly
consists of progressive-scanned video, and/or still
images, checking this box may provide superior output
quality. Usually, however, this option should be left
unchecked.

Always re-encode entire movie: This option forces
your movie to be completely re-rendered for output. It
is recommended only if you are experiencing problems
with your output movie and want to narrow the
possible sources of error.

Farmat

Disc Twpe ‘Wideo quality | disc usage

|DVD j |Aut0matic Quality j
Audio compression:
| MPA& (MPEG-1 Layer 2) j Approx. 53 minutes of video on disc
Kbits/sec: [ Use progressive encoding
:| I Always re-encode entire movie
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Burn options

Create disc content and then burn: This is the default
option for creating discs. In the first phase, the data that
will be written to disc is generated and stored
temporarily on your hard drive. In the second phase,
the generated data is burned to the optical disc.

Create disc content but don’t burn: =

With this choice, your disc burner is not rgﬁzit:eﬂ'i‘uiﬁ”tf”t
used. Instead, the same files that would ~
normally be saved onto a disc are stored T

to a hard drive folder as a “disc image”. < Gy
With some disc types, you may have a

choice of disc image formats. Choose

the one you want on the Image Type list in the Media

and device options area (see page 302).

Burn from previously created disc content: Instead
of using your current project directly to burn a disc, a
previously-created disc image is now sent to your
burner. This lets you divide the work of creating a disc
into two separate steps that can be performed in
separate sessions if desired. It is particularly useful
when you want to make several copies of the same
project, or when you want to generate the disc on one
computer but burn it on another.

Media and device options

Target media: Choose an entry from this dropdown
list matching the type and capacity of the disc to which
you are burning your project.

Disc writer device: If you have more than one disc
burner on your system, select the one you want Studio
to use.
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Copies: Select or enter the number of copies of this
disc that you want to create.

Write speed: Choose one of the available speeds, or
choose Auto for the default selection.

Image type: When you are generating a disc image
rather than burning an actual disc, this dropdown list
lets you choose amongst available formats, if
applicable. Your choice may be important if you are
planning to access the image with other software.

Media and device options
Current Media:
DWD-R 4.7 GB

Target media: Copies:
oD 4.7 cB = v =
Disc writer device: ‘Write speed:
|SOMY  DWD Rt DRU-5104 1.0b | Jae +]
Image bype:

| [ |

Eject disc when done: Check this box if you would
like Studio to automatically eject the disc after the burn
process has been completed.

General options

These options are provided for both the Make Disc and
Make File option tabs. Separately or in combination
they let you specify special actions to be taken after
your movie disc or file has been created.

General Options
[¥ Play sound when Finished
[ 5hut down PC when Finished:

Play sound when finished: As soon as Studio has
finished outputting your movie, a sound effect will be
played back through your computer’s speakers to alert
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you. This is handy if you want work nearby while the
CPU-intensive work of generating the movie gets done.
Make sure that your speakers are switched on and that
the volume is suitably set when you rely on this feature.

Shut down PC when finished: Upon outputting your
movie, Studio instructs Windows to shut down your
computer. This option ensures that the system will be
powered down even if you are away from your desk, or
even asleep, when output is completed.

Make File settings

The File Type and Preset lists, which head the Make
File settings panel for all file types, correspond to the
Format and Preset lists in the Output Browser (see
Chapter 15: Making Your Movie). Most file types share
a common control panel. The Real Media and
Windows Media file types have special-purpose control
panels, covered separately in “Make Real Media file
settings” on page 308 and “Make Windows Media file
settings” on page 311.

The common panel, to be described here, is used by all
the other supported file types: 3GP, AVI, DivX, Flash
Video, MPEG-1, MPEG-2 and MPEG-4 (including
iPod Compatible and Sony PSP Compatible), and the
audio-only types.

The panel lets you manipulate file and compression
settings when the Custom preset has been chosen. Most
of the file types support customization to some degree.

Custom settings may be used to minimize the size of
the output file, to increase its quality, or to prepare it
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for a special purpose (such as distribution via the
Internet) where there may be requirements involving
characteristics such as frame size.

Farmat

File Type: Preset:
|A'v'I j |Cust0m j
Yideo settings Audio settings
v Include video v Include audio

I List all codecs

 Options... | Options...
Compression: Compression:
|mIrEG | | =l
Resolution: width:  Height: Channels: Sarmple rate:
Customn ~| | 720 480 |Stereo j |48 kHz j
Frame Rake: Frames|Sec: Data rate (Kbits/sec)
| Custom EREED
* Quality Percent
T

The common Make File settings panel is shared by
all file types except Real Media and Windows Media.
Not all the options are available for all file types.

Note: MPEG-2 and MPEG-4 files require special
decoder software. Without a matching decoder

installed on your PC you will not be able to play files
of these types.

Video settings

Include video: This option is on by default. Clearing
the checkbox causes the output file to have audio only.

List all codecs: By default this checkbox is not
checked, so only those codecs are listed that have been
certified by Pinnacle Systems for use with Studio. If
you check the option, all codecs installed on your PC
will be listed, whether certified or not.
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Using codecs that have not been certified by Pinnacle
Systems may produce undesirable results. Pinnacle
Systems cannot provide technical support for problems
associated with the use of uncertified codecs.

Options: The Options button opens a codec-specific
option panel if one is available.

Compression: Choose the compressor (codec) that is
most suitable for your intended use. When making an
AVI file, you’ll want to choose your compression
settings for the capabilities of, and codecs supported
by, the intended viewer’s computer platform.

|MIPEG |
x

Dy
MIPEG

Inden® viden 5,10 Compression Filker
Cinepak Codec by Radius

Inkel IndeoiR) Videa R3.2

Intel Indeo® Video 4.5

Indeo® video 5.10

Resolution: This is a dropdown list of presets
providing standard Width and Height options. The
Custom preset lets you set the dimensions directly.

Width, Height: The frame size is measured in pixels.
The default setting is the resolution at which Studio
captures. Decreasing the width and height greatly
decreases file size.

Resolution: Width:  Height:

Custom - | | 720 450

Frame rate: The standard frame rate is 29.97 frames
per second for NTSC, and 25 frames per second for
PAL. You may want to set the frame rate lower for
applications such as Web video.

Frame Rate: Frames/Sec:

BIREES
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Quality, Data rate: Depending on the codec being
used, you can adjust the quality percentage or data rate
with the slider. The higher the percentage or rate you
choose, the larger the resulting file.

* Quality Percent

O o

Audio settings

If you want to keep file sizes to a minimum, audio for
many digital uses can be set to 8-bit mono at 11 kHz.
As a rule of thumb, try 8-bit 11 kHz for audio that is
mostly speech, and 16-bit stereo at 22 or 44 kHz for
audio that is predominantly music. As a benchmark,
CD-ROM music is 16-bit stereo sampled at 44 kHz.
Another convenient rule of thumb for audio
compression is that 11 kHz is roughly equivalent to
AM radio quality; 22 kHz equates to FM radio quality;
and 16-bit stereo, 44 kHz is audio CD quality.

Include audio: This option is on by default. Clearing
the checkbox causes the output file to be silent.

Options: The Options button opens a codec-specific
option panel if one is available.

Compression: The codecs listed here will vary with
the file type.

Channels: Possible choices on this list include Mono,
Stereo and MultiChannel, depending on the file type.
File size increases when additional channels are used.

Sample rate: Digital audio is produced by taking
regular instantaneous samples of the continuous analog
waveform. The more samples, the better the sound. For
example, audio CDs are recorded at 44 kHz, 16-bit
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stereo. Audio can be sampled at frequencies as low as
11 kHz for some digital uses, particularly for speech.

Data rate: This dropdown controls the data rate, and
hence the compression ratio, for audio. Higher data
rates yield higher quality at the cost of larger files.

Channels: Sample rate:
|Stereo ﬂ |48 kHz ﬂ

Data rate (Kbits/sec)

224 hi

Data settings

The Sony PSP Compatible file type provides an area
named Data in which you can specify a title for your
saved movie.

General settings

These are the same as described for the Make Disc tab
on page 303.

Make Real Media file settings

The Make Real Media File options panel allows you to
adjust Real Media file settings. These configure the
creation of files that are to be played back with the
popular RealNetworks® RealPlayer®, free for the
download from www.real.com.

Title, Author, Copyright: These three fields are used
to identify each Real Media movie, and are encoded
into it so that they are not visible to the casual viewer.
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Keywords: This field accepts up to 256 characters, and
allows you to encode keywords into each movie. It is
typically used to identify the movie for Internet search

engines.
Format
File Tvpe: Preset:
Real Media j |Large j
Data Target audience
Title ¢ Author ; " Dial-up Modem
Leave it to Thorkney | Tharkney Grillmarket " Single ISDM
Copyright : Keywords " Dual ISDN
| 2005 TG Productions | comedy, trumpet, fishing trips " Carporate LAN
Wideo Quality Audio Quality : ¢ 258K DsL/Cable

Mormal Mation Video - |Voice with Background Music j (" 384K DSL/Cable

(" 512K DSL{Cable

Web server
" RealServer

+ HTTP

Video quality: These choices let you balance the rival
requirements of image quality and frame rate.

No video: When this selection is made, the output
file will contain audio only.

Normal motion video: Recommended for mixed
content clips to balance video motion and image
clarity.

Smoothest motion video: Recommended for clips
that contain limited action, such as newscasts or
interviews, to enhance overall video motion.

Sharpest image video: Recommended for high-
action clips to enhance overall image clarity.

Slide show: The video appears as a series of still
photos, providing the best overall image clarity.

Audio quality: This dropdown menu lets you choose
the characteristics of your audio track. Studio uses this
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information to select the best audio compression for
your Real Media file. Each successive option provides
better audio quality but a larger resulting file.

e No audio: When this selection is made, the output
file will contain video only.

e Voice only: This option provides adequate quality
for spoken audio in clips without music.

e Voice with background music: This option is
designed for situations where, even though
background music may be present, the spoken audio
predominates.

e Music: Use this option for a monaural track in which
music is prominently featured.

e Stereo music: Use this option for a stereo music
track.

Web server: The RealServer option allows you to
create a file that can be streamed from a RealNetworks
RealServer. The RealServer supports a special feature
that senses the connect speed of the viewer’s modem,
and adjusts its transmission rate to suit. The option
allows you to select up to seven Target audience data
rates. Because the file size, and your upload time,
increase with each data rate you add, select only those
target audiences you think are actually needed.

To make use of the RealServer option, the ISP hosting
your web-site must have the RealServer software
installed. If you are unsure, contact your ISP for
confirmation, or use the standard HTTP option, which
allows you to optimize playback for exactly one of the
Target audience options.

Note: GeoCities provides RealServers to their
“homesteaders”.
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Target audience: This selects the target audience
modem connect speed. The lower the speed, the lower
the quality of the video. If you wish your viewers to be
able to view your movie as it loads, you should select a
target audience rate that their modems can handle.

When you select a target audience, you are actually
specifying a maximum bandwidth for your RealMedia
stream. Bandwidth, measured in kilobits per second
(Kbps), is the amount of data that can be sent through
an Internet or network connection in a given time span.
Standard modems (those that use ordinary telephone
lines) are classified by the bandwidth they are able to
process. Common values are 28.8 and 56 Kbps.

In addition to these standard audiences, you can record
clips for connection speeds of 100 Kbps, 200 Kbps, or
higher. These higher bandwidths are suitable for
audiences that use corporate Local Area Networks
(LANS), cable modems or Digital Subscriber Line
(DSL) modems.

Make Windows Media file settings

The Make Windows Media File panel lets you adjust
options for creating Windows Media Player files.

Title, Author, Copyright: These three fields are used
to identify each Windows Media movie, and are
encoded into it so they are not visible to the casual
viewer.

Description: This 256-character field lets you enter
keywords for encoding into the movie. It is typically
used to identify the movie for Internet search engines.

Appendix A: Setup options 311



312

Rating: Entering a rating in this field if it will be
helpful to your viewers.

Farmat
File Type: Preset:
Windows Media j |Cust0m j
Data Markers For Media Flaver "Go To Bar"
Title : Author
&
| Thorkney's Birds | Thorkney Grillmarket D (il M
; (™ Markers For every cli
Copyright Description © S
| 1 2005 TG Productions The unearthly beauty of [ Markers For named clips anly
Thorkney's backyard bird
Rating : sanckuary,
G
Prafile
windows Media & Best Quality based VBR, for Broadband. j

Video:  320x240, 30 Frames/sec
Audio: WA, 16 bit Stereo, 44.1 kHz

Profile: Choose the playback quality of your movie
based on the capability of the target platform — the
computer(s) that will play the movie. The exact audio
and video parameters corresponding to the current
choice are displayed in the space below the list. The
Custom option lets you fine-tune the settings by
selecting from a list of possible combinations.

Praofile:
Windows Media Video & for Broadband (PAL, 700 Kbps) ﬂ

‘Wind based VBR for Broadband, S
ind ;

‘Windows Media 8§ Fair Quality based VBR for Broadband
‘windows Media Yideo & for Broadband (PAL, 700 Kbps)
windows Media Yiden 8 For Broadband (PAL, 384 Khns)

Py

Markers for Media Player “Go To Bar”: You have
the option of including Windows Media “file markers”
in the movie file. These markers allow viewers to go
directly to the beginning of any marked clip by
choosing its name from a list.
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o No markers: The movie file will be created without
markers.

e Markers for every clip: Markers are automatically
created for every clip in the movie. If you have not
given the clip a custom name, a default one will be
generated for it based on the project name.

e Markers for named clips only: Markers are
generated only for those clips to which you have
given a custom name.

0000000000000
Make tape settings

Studio automatically senses the hardware you have
installed, and configures the Make Tape playback
destination accordingly.

Fatmak
Qutput Type Device
DY Camcorder ﬂ |Sony DV Device (DY NTSC) ﬂ

Audio

| [ |

2ukpuk options

Iv &utomatically start and stop recording

{Turn this on to automatically send Record
and Stop commands to wour DY camcorder)

Record delay time:

1 seconds 27 [frames

If you are printing (making tape) to a DV device, you
can choose to have Studio start and stop the device
automatically instead of having to do it yourself.
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To control printing automatically:

1.

Click the Make Movie button on the main menu bar.

The upper half of the screen changes to display the
Make Movie window.

Click the Tape tab.

Click the Settings button. The Make tape options
panel opens.

Check the Automatically start and stop recording
box to enable the automatic function. This setting
makes it unnecessary to manually start recording in
step 6.

With most DV devices there is a small delay
between receiving the command to record and the
actual start of recording. In Studio, this is referred
to as the “record delay time”. It varies from device
to device, so you may need to experiment with the
value for best results with your particular device.

Click OK.
Click Create.

Studio renders your movie, then prompts you to
press the play button on the Player. If you did not
check the automatic option (step 4), you must
manually start the device recording before pressing
the play button; otherwise Studio itself sends the
record command. Studio outputs the first frame of
your movie (without audio) for the duration entered
as the record delay time, giving the device time to
bring the tape up to speed and begin recording.

Hint: When you play back your tape, if the first
part of your movie was not recorded, you should
increase the Record delay time setting. On the other
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hand, if your movie begins by holding onto the first
frame as though it were a still photograph, you
should decrease the setting.

Hint: If you wish to send black to your recording
device during its record delay time, place a blank
title in the video track just before the start of your
movie (a blank title is video black). If you wish to
record black at the end of your movie, place a blank
title in the video track following the final frame of
your movie.

Analog output

If you are printing to an analog device, the choice of
Composite or S-Video format may be available if
supported by your hardware.

Cutput options
Format

" Composite ™ 5Video

Output to the screen

One of the options on the Video dropdown in the
Playback devices area is “VGA display”. With this
option, your completed project will be played back
onto your monitor screen rather than to an external
device.
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APPENDIX B:

Tips and tricks

Here are some hints from Pinnacle technical specialists
on choosing, using and maintaining a computer system
with video in mind.

]
Hardware

To use Studio effectively, your hardware should be
optimally prepared and configured.

Preparing your hard drive

Prior to capturing video, consider working through the
following steps, especially if you have an older system,
if your capture drive is running low on space, or if you
have already seen evidence of possible hard drive
problems:

e Close down as many other applications and
background programs as possible. This includes
important security software such as anti-virus and
anti-spyware utilities, so Pinnacle recommends
strongly that you also disconnect from the Internet
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(or set your firewall to block all Internet traffic)
when taking this step. Software utilities are available
to assist with closing background processes.

Right-click on the name of your capture drive in
Windows Explorer, and select Properties on the pop-
up menu. On the Tools tab of the Disk Properties
dialog, click Check Now and run a detailed scan of
the drive to make sure that it is error free. When this
is complete, click Defragment Now; the system
defragmenter utility will arrange your drive contents
to leave the largest possible contiguous free area for
your capture files.

Scanning and defragmenting a drive are both lengthy
operations, so you may wish to let them run during
times when you are planning to be away from the
computer.

Temporarily turn off your screen saver and any
power management features you have set up on the
Windows Screen Saver dialog box.

Note: Video-editing programs do not multitask very
well. Do not use any other program while outputting
your movie to videotape or optical disc, or when
capturing. You can multitask while editing.

RAM

The more RAM you have, the easier it is to work with
Studio. You will need at least 512 MB of RAM to work
with the Studio application, and we highly recommend
1 GB (or more). If you work with HD video, or are
running Windows Vista, the recommendation rises to
2 GB. Editing AVCHD video calls for 2 GB at
minimum.
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Motherboard

Intel Pentium or AMD Athlon 1.4 GHz or higher — the
higher the better. Windows Vista and AVCHD editing
both demand a more powerful CPU. The minimum
recommendation ranges up to 2.66 GHz for editing
1920-pixel AVCHD video.

Graphics card

To run Studio, your DirectX-compatible graphics card
needs:

e For typical use, at least 64 MB of onboard memory
(128 MB preferred).

e For Windows Vista, at least 128 MB (256 MB
preferred).

e For HD and AVCHD, at least 256 MB (512 MB
preferred).

Graphics card settings

If you need to minimize system load while maintaining
acceptable color performance, Pinnacle recommends
setting your display to use 16-bit color.

To adjust the display in Windows XP:

1. Position your mouse over your Desktop, right click,
and select Properties, When the Display Properties
dialog box appears, click on the Settings tab.

2. If you have multiple monitors, select the one to
which the new setting should apply.

3. Under Color Quality, choose “Medium (16 bit)”.
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To adjust the display in Windows Vista:

1. Position your mouse over your Desktop, right click,
and select Personalize. In the “Personalize
appearance and sounds” window click the “Display
settings” link.

The Display Settings dialog box appears.

2. If you have multiple monitors, select the one to
which the new setting should apply.

3. Under Colors, choose “Medium (16 bit)”.
The color setting affects only the display on the

computer monitor. Recorded sequences will appear in
full color and resolution at the video output.

Studio and computer animation

If you are editing computer animation with Studio or
wish to combine animation with digital video,
remember to create your animations using the same
frame size and image refresh rate as your original
video:

QuaJity| TV-Cropping| PAL | NTSC | Audio

DV | Yes | 720 x 576 | 720 x 480 | 44 kHz 16-hit stereo

Failure to do this will result in unnecessarily long
rendering times and the possibility of visible flaws
when the animation is played back.
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APPENDIX C:

Troubleshooting

Before you begin troubleshooting, take some time to
check your hardware and software installation.

Update your software: We recommend installing the
latest operating system updates for Windows XP and
Windows Vista. You can download these updates from:

windowsupdate.microsoft.com/default.htm

Make sure you have the latest version of the Studio
software installed by clicking the Help > Software
Updates menu from within the program. Studio will
use the Internet to check for possible updates.

Check your hardware: Ensure that all installed
hardware is functioning normally with the latest
drivers, and is not flagged as having a problem in the
Windows Device Manager (see below). If any devices
are flagged you should resolve the issue before starting
installation.

Get the latest drivers: We also highly recommend
installing the latest drivers for your sound card and
graphics card. During the Studio software launch
process we do verify that your sound card and video
card support DirectX. See “Update audio and video
drivers” on page 327 for help with this process.
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Opening Device Manager

The Windows XP and Windows Vista Device
Manager, which lets you configure your system’s
hardware, has an important role in troubleshooting.

The first step in accessing Device Manager is to right-
click on My Computer, then select Properties from the
context menu. This opens the System Properties dialog.
The Device Manager button is on the Hardware tab in
XP, and is listed on the left side panel in Vista.

Ensure that all installed hardware is functioning
normally with the latest drivers, and that nothing has
been flagged in the Device Manager with the yellow
exclamation mark icon indicating an error condition.

In the case of a driver problem that you cannot resolve
yourself, contact the device manufacturer or your
computer vendor for assistance.

© TECHNICAL HELP ON-LINE

The Pinnacle Support Knowledge Base is a searchable
archive of thousands of regularly-updated articles about
the most common questions and issues users have
regarding Studio and other Pinnacle products. Use the
knowledge base to find answers to any questions you
may have about installing, using or troubleshooting
Pinnacle Studio.
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Access the knowledge base with your web browser by
visiting:

http://www.pcle.com/selfhelp

The knowledge base home page will appear. You don’t
have to register to browse the knowledge base, but if
you want to send a specific question to technical
support staff you will need to create a knowledge base
account. Please read any knowledge base articles
relevant to your inquiry before contacting technical
support.

Using the knowledge base

In the Product dropdown, select “Studio Version 12”.
If appropriate, you can also select a Sub-Product, a
Category, or both. Selecting a sub-product or category
may reduce the number of irrelevant hits you will get
from your search, but may also eliminate helpful
articles of a more general nature. If you’re not sure
what category to pick, leave the selection at All
Categories.

To search for an article, type a short phrase or group of
keywords in the text box. Don’t get too wordy; the
search works best when given just a few words.

Search example

In the list below of common troubleshooting issues, the
first item is, “Studio crashes or hangs in Edit mode”.

Type “Crash in edit mode” in the search box and click
the Search button. You should get back somewhere
between 60 and 150 hits. The very first one, “Studio
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crashes in Edit”, lists the known causes for this issue
and their remedies.

If you search instead on the single keyword “Crash”,
you will get far fewer hits, all relating to crashes in
Studio.

If one search does not turn up an article that seems
relevant to your problem, try modifying the search by
choosing a different set of keywords. You can also use
the Search by and Sort by options to select for specific
or popular articles.

Searching by Answer ID

If you know the Answer ID number of the answer
you’re looking for, you can access the item directly.
For example, if you are getting a capture error when
you press the Capture button, someone might refer you
to knowledge base article 2687, “I am getting a capture
error with Studio”. In the Search by dropdown, select
“Answer ID”, enter the ID number in the text box, and
click Search.

® TOP SUPPORT ISSUES

The remainder of this chapter draws on some of the
knowledge-base articles most consulted by users. The
text presented here is generally less detailed than that
provided on-line. For the full text available under each
Answer ID, please refer to the on-line knowledge base.
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Errors or crashes during installation

Answer ID 13122

Errors during the installation of Studio may appear as a
dialog box with the title “CRC Error”, “Feature
Transfer Error” or “1/O Error”. In other circumstances,
the install routine may crash or appear to freeze. In all
such cases, try the following steps in turn until the
problem is resolved:

e Inspect the discs: Check each disc’s surface for dirt,
smudges and fingerprints. Clean off the disc with a
soft cloth if necessary. Avoid using paper towels or
any other material that could be abrasive and scratch
the disc. Wipe from the center of the disc to the outer
edge. Don’t use a circular motion. Once the disc is
clean, retry the installation.

If the disc is damaged with deep scratches or cracks
so that it won’t install, please contact Pinnacle
support for a replacement.

e Try another drive: If you have a second optical
drive of a compatible type, try installing from it.

e Prune your startup: If you are familiar with the
msconfig utility, follow the procedure to eliminate
programs run at Windows startup that could interfere
with the Windows installer. See “Editing startup
applications” on page 342 for details.

e Install from the hard drive: In this procedure, you
boot into Window Safe Mode, copy the contents of
the Studio installation disc onto your hard drive, then
execute the install from there. We recommend
consulting Answer ID 13122 on the Pinnacle web-
site for the latest advice on this approach.
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Studio crashes in Edit mode

Answer ID 6786

If Studio is crashing, the cause is most likely either a
configuration issue or a problem with a project or
content file. This type of issue can often be fixed with
one of the following methods:

e Uninstalling and reinstalling Studio.

e Optimizing the computer.

e Rebuilding a corrupt project.

e Recapturing a corrupt clip.

To help troubleshoot the problem, determine which of
the failure modes listed below best matches the
symptoms you are experiencing, then refer to the
corresponding set of instructions:

e Case 1: Studio crashes randomly. There doesn’t
seem to be any one thing that will cause the crash,
but crashes happen frequently.

e Case 2: Studio crashes every time you click on some
particular tab or button within Edit mode.

e Case 3: Studio crashes each time you carry out some
specific sequence of steps.

Case 1. Studio crashes randomly
Try each of the following solutions in turn:

Get the latest version of Studio: Make sure that you
have the latest version of Studio 12 installed. The latest
version can be found on our website at:

www.pinnaclesys.com/support/studiol2
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Be sure to close all other programs before installing a
new version.

Adjust Studio settings: Choose No background
rendering in the Rendering dropdown list, and clear the
Use hardware acceleration checkbox. Both options are
found on the Edit options panel (see page 290).

End background tasks: Close other applications and
unload any background processes before using Studio.

Press Ctrl+Alt+Delete to open the Task Manager. You
probably won’t see much under the Applications tab,
but the Processes tab will show you the software that is
currently running. It can be difficult to be sure which
processes should not be closed, but software utilities
are available that can assist with this procedure.

Defragment your hard drive: Over time, the files on
your hard drive can become fragmented (stored in
multiple parts in different areas of the drive), which
slows down access and may lead to performance
problems. Use a disk defragmenter utility like the one
supplied with Windows to prevent or correct this
problem. Access the built-in defragmenter with the
Disk defragmenter command on your Programs »
Accessories » System tools menu.

Update audio and video drivers: Make sure that you
have obtained the latest drivers for your sound and
video cards from their manufacturers’ web-sites. Even
a brand-new computer may be sold with outdated
drivers installed, and should be checked for updates.
You can see what sound and video cards you have in
the Windows Device Manager.

To determine what video card you have, click the plus
sign in front of Display Adapters in the Device
Manager list. The name of your video card is now
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displayed. Double-clicking the name opens another
dialog, where you choose the Driver tab. Now you can
view information about the driver’s manufacturer, and
the names of the driver’s constituent files.

The sound card is displayed in the Sound, video and
game controllers section of Device Manager. Again,
double-clicking the name lets you access the driver
details.

Go to the manufacturers’ web-sites to get the latest
drivers for your sound and graphics cards. Many users
have NVIDIA or ATI graphics cards, for which the
latest drivers are available at:

www.nvidia.com and www.atitech.com

Those with Sound Blaster audio cards can get updates
here:

us.creative.com

Update Windows: Make sure you have all the latest
Windows updates that are available.

“Adjust for best performance”: Use this system
option to turn off visual extras that consume additional
CPU time. Right-click My Computer, select Properties
from the context menu, then click on the Advanced tab.
Under Performance, click the Settings button to open
the Performance Options dialog. Select the Adjust for
best performance option and click OK.

Update DirectX: Update to the latest version of
DirectX. You can download it from Microsoft here:

www.microsoft.com/windows/directx

Open up space on your boot drive: Make sure you
have 10 GB or more free space on your boot drive for

paging.
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Uninstall, reinstall and update Studio: In case your
Studio installation has become corrupted, try this
procedure:

1. Uninstall Studio: Click on Start » Programs >
Studio 12 » Tools » Uninstall Studio 12, then
follow any on-screen instructions until the process
is complete. If the uninstaller asks whether you
want to delete a shared files, click Yes to all.
Disconnect the camera and cable from your DV
board, if you have one.

2. Reinstall Studio: Insert your Studio CD and
reinstall the software. Make sure you are logged in
as the Administrator (or as a user with Admin
privileges) when installing Studio. It is strongly
recommended that Studio be installed in its default
directory on the main OS drive.

3. Download and install the latest version of Studio:
Click the Help > Software Updates menu
command to check for updates. If a new version of
Studio is detected on our web-site, you will be
asked to download it. Download this patch file to a
location where you can find it easily (such as the
Desktop), then exit Studio. Finally, double-click the
downloaded file to update Studio.

Rebuild corrupt project: Try rebuilding the first few
minutes of your project. If no problems occur,
gradually add to the project, checking periodically to
ensure that system stability is maintained.

Fix corrupt video or audio: Sometimes the instability
may occur only when you manipulate certain audio or
video clips. In such cases, you should recapture the
audio or video. If the audio or video was created by
another application, recapture it with Studio if possible.
While Studio supports many video formats, the
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particular clip you have may be corrupt or in an
uncommon format. If you have a wav or mp3 file that
seems to be problematic, convert the file to the other
format before importing the file. Many wav and mp3
files on the Internet are corrupt or non-standard.

Reinstall Windows: This is quite a drastic step, but if
the previous steps have not helped, Windows itself may
be corrupt. Even though your other applications may
appear to be running properly, the size of the video
files used in Studio may well tax your system to the
point that a latent instability is revealed.

Case 2: Clicking a tab or button crashes Studio

Please start by trying the steps given above for Case 1.
This kind of problem often means that Studio was not
installed properly or has become corrupt. Uninstalling
Studio, reinstalling it, and patching to the latest version
will generally solve the difficulty.

Otherwise, try creating a new project called
“test01.stx” to try to determine if the failure is specific
to a particular project. Open the demo video file and
drag the first few scenes onto the Timeline. Now click
on the tab or button that seems to cause the failure. If
this test project does not crash, it may be that the
problem is with the project you are working on rather
than with Studio or your system. If the test project does
fail, please contact our support staff and provide us
with details on the exact failure mode. We will try to
recreate and solve the problem.

Case 3: Performing certain steps crashes Studio

This is just a more complicated version of Case 2, and
the same troubleshooting steps apply. Since it may be
quite difficult to determine the exact sequence of steps
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that produces the failure, you will need to be
methodical in your approach. Creating a small test
project, as described for Case 2, helps eliminate
variables that may confuse your test results.

“Video Device Not Found” error
appears in Capture mode

Answer ID 13618

This error dialog tells you that Studio “is unable to
connect to your video device”, then provides basic
instructions for both digital and analog capture devices.
The two subtopics below provide details on
troubleshooting this error for both device types.

Digital capture devices

If you are capturing from a digital source (DV, Digital
8, HDV), work through these steps until the issue is
resolved:

1. Set the Studio capture source to 1394: Under
Capture Devices in the Capture source options
panel, make sure that both video and audio are set
to DV Camcorder — Pinnacle 1394, and click OK.
Studio is now set to capture using the 1394 port.

Capture saurce | Capture farmat ] Project preferences
Capture devices
Widea
|D\n' Camcorder - Pinnacle 1394 j

Audio
|D\n' Camcorder - Pinnacle 1394 ﬂ
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If no DV Camcorder option is listed, Windows is
not loading the driver for the 1394 Host Controller.
Skip to the “Device Manager” step below to
troubleshoot this problem. Once the driver is loaded
properly, verify that capture in Studio is successful.

DV, Digital 8 or HDV camcorder checklist:

e Ensure the camera is in play mode. Some
camcorder vendors may use different
terminology such as VTR or VCR. They all mean
the same thing, that the camcorder is going to
play from the tape. The camcorder cannot be in
Camera mode.

e The camcorder must be turned on. It should be
powered by AC power. Do not run off battery
power.

e The camcorder should be connected to the
computer via a 1394 cable to the Firewire port.

e Disconnect and reconnect the 1394 cable to both
the camcorder and the computer, making sure
that both ends are properly seated. If you have
more than one 1394 port, try all of them. Studio
will not capture from a DV or Digital 8
camcorder unless it is connected via the
DV/Firewire/1394 port (not a USB port).

Device Manager: Check Device Manager to verify
that both the 1394 controllerand the Digital
camcorder drivers are loaded.

e Click on Start » Control Panel. In the Control
Panel window, click on System.

e In the System Properties window that appears,
click the Hardware tab.

o Click the Device Manager button.
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e The driver for the 1394 card is listed under the
heading “IEEE 1394 Bus Host Controller” as a
“Texas Instruments OHCI-IEEE 1394 Host
Controller”. The chip on your card may be from
a different vendor so there may be a different
name listed than Texas Instruments. If this device
has an exclamation mark error icon, the device is
not loaded properly.

e The driver for the camcorderis listed under
Imaging devices as a “brandname DV
camcorder”  (substituting “Sony”, *“Canon”,
“JVC”, etc. for brandname). If this device has an
exclamation mark error icon, it is not loaded

properly.

 If you cannot get either device to install properly,
you should contact the support department of the
company concerned.

Note: When the camcorder is turned on and off the
camcorder driver will load and unload. You should
see your cursor turn to an hourglass as the device is
detected and Windows loads the driver. Also,
Windows (XP and Vista) will typically give a
“Found New Hardware” message when the
camcorder is turned on as the device is detected.

If your 1394 port is on a separate card (not part of
your motherboard), shut down the computer and
move the 1394 card into another PCI slot. If you
don't have an available slot, swap places with
another PCl card. Restart the computer. The
hardware wizard should detect the new hardware
automatically. Follow any on-screen instructions to
finish loading the driver if any appear. If Device
Manager now reports that the card is loaded
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properly, return to Studio to verify that capture now
succeeds.

AM Capture (often shortened to “AmCap”): If
both the 1394 controller and DV camcorder drivers
are listed properly in Device Manager and Studio
will still not capture from the device, then try to
capture using AM Capture, a small, basic, capture
utility from Microsoft that can capture from DV
devices.

e Click  Start » Programs » Pinnacle  Studio
12 > Tools > AM Capture.

e Select the Device » Microsoft DV Camera and
VCR menu command.

e Run through the checklist in Step 2 above to
verify that your camcorder is ready.

e Press play on the camcorder. Video should play
in AmCap. If the video does not play, check Step
2 again.

e While the video is playing, click Capture > Start
Capture.

If AmCap is unable to capture from the DV device,
something is evidently wrong with either the 1394
driver or the DV driver, both of which are part of
Windows XP. Please contact either Microsoft or
your computer vendor for assistance. If you are
familiar with the XP Repair procedure, some
customers have had success running it to fix 1394
driver problems.

If AM Capture does work, we recommend you
uninstall and reinstall Studio. As a workaround, you
can capture your video in AmCap then import it
into Studio for editing.
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Analog capture devices

If you are capturing from an analog source (8mm or Hi-
8 camcorder, VCR, etc), make sure that both video and
audio are set to the analog device you are using. Select
your hardware on the lists provided under Capture
Devices in the Capture source options panel:

Capture source | Capture format] Project preferences
Capture devices
Wideo
|Dazzle D 150b |

Audio
|Dazzle D 150b =]

Some analog capture devices have no audio input. In
that case:

e Set the Audio Capture device in Studio to your
sound card's Line In; then,

e Cable the analog audio source (VCR or analog
camcorder) to the Line in on the sound card.

Note: If you now get a different error when capturing:
“A valid signal has not been detected”, please continue
to the topic below.

“Input signal not detected”
error during Capture

Answer ID 13420

The full error message reads: “A valid Input Signal has
not been detected. Please check your cables.” This is an
analog capture message. Its purpose is to alert you that
capturing cannot proceed because Studio cannot detect
a video signal.
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Work through the following troubleshooting steps
in turn until you solve the problem:

Cabling: As the error message suggests, an obvious
first step is to verify that your cables are properly
plugged in. The “video out” connector of your video
source (camcorder, VCR) must be connected to the
“video in” connector of your capture device, using
either a composite (RCA) cable or an S-Video cable.

Capture source settings: In Studio, click on
Setup » Capture Source and verify that the Capture
device setting for both video and audio is set to the
correct device (such as “Pinnacle 500-USB”). While
you are there, turn on the VCR Input option, and
make sure that your TV standard is set correctly: for
example, to NTSC in North America, and to PAL in
Europe.

Video input setting in Studio: The video input on
the slide-out panel on the Diskometer must be set
correctly for the cables and connectors you are using,
either composite or S-Video.

The video source must be playing: Turn on your
camcorder or VCR and press play, making sure you
are not at the end of the tape. On many camcorders
and VCRs, “input signal not detected” can appear if
the device is paused or stopped. Ensure that the
device is playing video before pressing the Start
Capture button.

Preview window: Video should be playing in the
preview window after you complete the previous
steps. If the preview is not working, continue to the
next step now.

Leave and return to Capture mode: After
verifying that your video source is playing, click first
on the Edit tab in Studio, then switch back to the
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Capture tab. This simple fix has been reported to
help in some instances.

e Other USB devices: If your capture device is
connected to the computer using USB, try
disconnecting all other USB devices, then retry the
capture. If this is still unsuccessful, shut down the
Studio program, disconnect and immediately
reconnect the capture device, then relaunch Studio.

e Reinstall capture driver: Shut down Studio and
reinstall the capture driver. If the capture device is
not a Pinnacle device, contact the manufacturer for
assistance.

Studio hangs when rendering

Answer ID 6386

With this type of problem, Studio “gets stuck” during
rendering (preparing your video for output in Make
Movie mode). To identify the solution in a particular
case, try the troubleshooting steps for whichever of the
following failure modes best matches your situation:

e Case 1: Rendering stops immediately after it starts.

e Case 2: Rendering stops randomly in a project. It
typically does not stop in the same spot if rendering
Is attempted multiple times.

o Case 3: Render stops at the same spot in a project no
matter how many times rendering is attempted.

Case 1: Rendering stops immediately

If the hang occurs immediately upon clicking the
Create button, there is some configuration problem on
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your system. Try rendering the supplied demo video. If
this fails, the problem is confirmed as a system issue,
since we have not been able to reproduce a render
problem with the demo file during our in-house testing.

Possible solutions:

Uninstall and reinstall Studio.

Uninstall other software that might conflict with
Studio (other video editing software, other video
codecs, etc.).

Try rendering to other file or disc types in Studio.
Try creating MPEG 1 and MPEG 2 files, and an AVI
file in DV format. Can you create VCDs and DVDs?
Knowing what works, and what does not, may be
crucial in identifying and solving the problem.

Make sure that you have installed any available
Windows service packs.

Reinstall Windows over itself (that is, without
uninstalling first). In Windows XP, this procedure is
called Repair.

Case 2: Rendering stops randomly

If the render hangs at random points even within the
same project, the failures may be due to background
tasks, power management or a thermal problem in the
computer.

Possible solutions:

Check your hard drive for errors and defragment it.

End any background tasks, such as virus checkers,
drive indexers and fax modems.

Turn off any power management.
Install cooling fans in the computer case.
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Case 3: Render always stops at the same point

If rendering always hangs at the same spot in a
particular project, see if other projects have the same
problem. If not, the problem project could be corrupt; if
they do, try to isolate a common factor.

Finding a solution to this type of failure is much easier
if you can identify a particular item in the project that is
causing the rendering to stop. Removing the item or
trimming it may allow the rendering to complete,
though in some cases the failure may simply turn up
elsewhere in the project.

Other possible solutions and workarounds:

e Look at the clips in the project for corrupt video
frames. These may show up as gray, black, blocky or
distorted frames. If you find any, trim the clip to
exclude the offending frames. You could also try
recapturing the footage.

e Defragment your hard drive.

e Ensure that you have ample free space — preferably
tens of gigabytes — on the hard drive you use for
video. Rendering may use large amounts of storage,
and can be disrupted if space is insufficient.

e If you have a separate capture drive, make sure to
move the auxiliary files folder to that drive.

o Copy the section where the render stops and paste it
into a new project. Include 15 to 30 seconds on
either side of the error. Try rendering this excerpt to
an AVI file and, if successful, use the file to replace
the offending section of the original project.

e |If you are creating a DVD or other optical disc type,
remove all menus from the project and render the
rest to an AVI. If this succeeds, create a new project,
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import the AVI file, and add your menus. Rendering
will now consume fewer resources, and thus be more
likely to succeed.

Studio hangs on launch
or does not launch

Answer ID 1596

Problems on launch can manifest in various ways.
Studio may give an error message when launching, or it
may freeze in mid-launch, or it may “hang” - fail to
return control to you — after what had seemed an
uneventful launch.

In all such cases, try any or all the following:

o Restart the computer. After the reboot, double-click
the Studio icon.

e Wait a few minutes to confirm that the application is
really hung. Even when you suspect Studio has
failed to launch, wait a few minutes more just in
case. On some computers, the launch process may
take longer to complete than you anticipate.

e Uninstall and reinstall Studio. (See page 329 for
instructions.)

e Start Windows in Safe mode. If Studio still won’t
launch under Safe mode, your installation may be
corrupt. An uninstall and reinstall of Studio should
deal with this.

If Studio does launch under Safe mode, the issue
probably relates to a faulty device driver or an
application conflict. Try to narrow it down further:
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o Disconnect capture hardware. Start with Pinnacle
external devices such as Dazzle and MovieBox. If
Studio now launches, reconnect the device and
reopen Studio. If it fails, continue to the next step.

 |If you have a webcam, try launching Studio with the
device unplugged, and again with it plugged in. If
the launch succeeds in one of these states but not the
other, make sure to use the same set-up whenever
you launch Studio in the future.

e Next, investigate capture cards mounted in your
computer. To see what capture devices are present,
use the AM Capture utility (Start > All Programs
» Studio 12 > Tools » AM Capture), and click
on the Devices pull-down menu. One by one, try
physically disconnecting the devices listed. You can
also try uninstalling the applicable drivers.

e Download and install the latest drivers for your
sound and graphics cards from the manufacturers’
web-sites. Both must support DirectX. Many users
have either NVIDIA or ATI graphics cards, for
which the latest drivers are available at
www.nvidia.com and www.atitech.com.

e If you have a sound card (rather than a motherboard-
based sound device), try removing it from the
system. Some older sound cards may not work well
with newer versions of Windows. This can be
verified by shutting down the computer, removing
the sound card and restarting. If Studio launches, you
probably need to replace the sound card.

e End background tasks. You can use either the End
Process button in the Windows Task Manager, or
one of the available software utilities designed to
assist with this procedure. Alternatively, you can
prevent unnecessary (and possibly conflicting) tasks
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from ever being run by editing your list of startup
programs.

Editing startup applications

To keep applications from loading when your PC is
started (or rebooted):

1. Click on Start > Run
2. In the Open box, type: msconfig
3. Click OK

In the System Configuration Utility window, click
on the far right tab called Startup. Remove all
checks from the boxes except for Explorer and
System Tray (SysTray.exe).

“Burning failed” error
appears in Make Movie

Answer ID 13438

If Studio reports “Burning failed” when you are trying
to create an optical disc such as a DVD, try each of the
following in turn until the problem is resolved.

e Update to the latest patch: Use the Help »
Software Updates menu command to make sure you
have the latest updates to the Studio program.

e Use the Safe mode burn option in Make Disc
settings: In Studio, click on Setup » Make Disc.
Under the box marked Burn Options, select “Safe
mode: create disc content and then burn”, by clicking
first on the radio button for the setting, then OK.
Stay with this setting until finished troubleshooting.
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¢ Restart Studio: Shut down Studio, then relaunch it.
Now try to create the disc again using the safe mode
setting as above.

e Restart the computer: Try opening the door of the
DVD burner. If it won’t open, shut down Studio,
then restart the computer. After relaunching Studio,
try to create the DVD using the safe mode setting.

o Verify media: Make sure that there blank, write-
once media or rewriteable media in the DVVD burner,
and that your DVD burner supports the media type
you are using. During troubleshooting we normally
recommend using rewriteable media to reduce the
number of wasted discs. However, if you have only
used rewriteable media (RW), we would also
recommend experimenting with write-once (-/+ R)
DVDs. For dependability, Pinnacle suggests using a
name brand of DVD, such as Sony, Apple or
Memorex. When troubleshooting, we recommend
trying a DVD from one or more different
manufacturers.

e Edit the registry: This step should only be
attempted if all of the following are true: You have
backed up your registry before making any changes
and know how to restore the registry to the previous
state; you have successfully edited the registry
before; and you are comfortable with the risks
associated with editing the registry. If you wish to
proceed, delete the Recorder key in the following
registry path (capitalization may vary):

HKEY_LOCAL_MACHINE\Software\VOB\CDRApp\
Recorder

This change will force the burn engine to completely
redo the drive scanning.
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DVDs created by Studio do not
play back, or appear blank.

Answer ID 13092

In some cases, a DVD created by Studio may not play
back in your DVD player. These steps will help to
resolve that problem.

e Check the disc for cleanliness. Ensure that there are
no obvious smudges or scratches on the disc surface.

o Verify that the expected folders and files have
actually been created on the burned DVD. Insert the
DVD into a DVD ROM drive. Under My Computer,
right-click on the drive that the disc is in and choose
Explore. See if there are folders on the disc. There
should be two folders on the DVD, named
“AUDIO_TS” and “VIDEO_TS”. The audio folder
should be empty. The video folder should contain
Jbup, .ifo and .vob files. If the disc is in fact blank,
you are dealing with a burn problem rather than a
playback problem. In that case, please check out
Answer ID 13874 in the on-line knowledge base.

e Try playing back the DVD on your computer. The
disc should play back in a software DVD player like
PowerDVD or WIinDVD, as well as in applications
like Windows Media Player and RealPlayer.

e Ensure that your DVD player is designed to play the
type of media you are using. Not all DVD players
will play every DVD disc format. The DVD player
manufacturer’s web-site should list the types of disc
formats your particular device supports. Another
good place to check for compatibility is:

http://www.videohelp.com/dvdplayers
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Tip: While troubleshooting burn or playback issues,
using rewritable media will prevent wasting discs.

No video or poor quality video
in the Capture preview window

Answer ID 14008

There are several possible causes for video being either
absent or of poor quality in the Capture preview
window. If you encounter such an issue, work through
this list of possible corrective steps until it is solved:

e Minimum requirements: Verify that the computer
being used meets the minimum system requirements
for Studio as described in the Getting Started section
of your user manual. Remember that some features
(such as HD video editing) have more demanding
requirements than others.

e Update the Studio software: Check on-line for
possible Studio updates by clicking the Help >
Software Updates menu from within the program.

o Verify that the capture device is detected: Ensure
that your capture device is being properly detected
by checking in the Windows Device Manager. If
installed correctly, the capture device will be
displayed in Device Manager. If it is not displayed
there, or if it has an error icon (a yellow exclamation
mark), please check Answer ID 13932 in the
Pinnacle on-line knowledge base.

o Capture preview option: Make sure that the Capture
preview option is turned on in the Capture source
options panel.
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e VCR input option: If the video displayed in the

preview window is of very poor quality when
capturing from a Pinnacle device (Studio 500-USB,
Studio 700-USB, or MovieBox Deluxe), it is likely
that the VCR Input checkbox has not been checked.
Rectify this in the Capture source options panel.

Graphics card hardware acceleration: Try
lowering the hardware acceleration for the graphics
card. After closing the Studio software, open the
Display Settings dialog from the Windows Control
Panel, and click the button to open the Advanced
Settings dialog. On the Troubleshoot tab of that
dialog, there is typically a horizontal slider that
allows the adjustment of the hardware acceleration
setting of the graphics card (not all drivers allow this
adjustment). If the setting is available, try adjusting
it downward by one level, then restart Studio and see
if the performance has improved. If it has not, close
Studio again and move the slider one more notch to
the left. Repeat until the problem is solved or all
hardware acceleration settings have been tried.

Update drivers: Make sure that you have obtained
the latest drivers for your sound and video cards
from their manufacturer’s web-sites. See page 327
for details on how to do this.

Adjust display settings: Sometimes with higher
graphics card display settings selected, the Studio
video preview window may not perform as expected.
Close Studio and open the Display Settings dialog
from the Windows Control Panel. You can try
changing either or both of the Screen Resolution and
Color Quality settings. Try different resolutions,
such as 800x600 or 1024x768, with 32-bit color
selected. At each setting, start Studio and look for
improved performance in the preview window.
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Use a single monitor: If multiple monitors are being
used, try using only one monitor and see if
performance improves.

Run the DirectX Diagnostic Tool: Open the
Windows Run dialog (Windows+R), type “dxdiag”,
and press Enter. To check for errors in the DirectX
Diagnostic Tool, look at the Notes section in the
various tabs of the tool. Any problem found should
be referred to the vendor of the device displaying it.

Background processes: Try reducing the load on
your system by ending background processes that are
not needed. See page 327 for more information.

Suspend virus scanners and other continuously-
scanning applications: Although it serves a vital
purpose, virus scanner software can hinder
performance in computationally intensive video
operations. As a test, try disabling the virus scanner
and see if it helps. (To ensure the continued well-
being of your system, Pinnacle recommends
disconnecting from the Internet while your virus
scanner is off-line.) Other candidates for suspension
include popular indexing tools or services such as
Google Desktop Search, Yahoo Desktop Search and
Adobe Photoshop Album Importer.

e Increase the priority of Studio: In some cases it
can be helpful to increase the priority of the Studio
application in the Windows Task Manager. In the list
of processes, right-click Studio.exe and select Set
Priority. Try setting the priority to “AboveNormal”
or “High”. Click Yes when Task Manager asks you
to confirm the change, then retry capturing in Studio.
If the priority change appears to have any
undesirable result, simply it back to “Normal”.

e Reinstall Studio: If none of the previous steps have
helped, try uninstalling and reinstalling Studio.
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APPENDIX D:

Videography tips

To shoot good video, then create from it an interesting,
exciting or informative movie, is something anyone
with a little basic knowledge can achieve. Starting from
a rough script or shooting plan, the first step is to shoot
your raw video. Even at that stage, you should be
looking ahead to the editing phase by making sure you
will have a good set of shots to work from.

Editing a movie involves juggling all your fragments of
footage into some kind of harmonious whole. It means
deciding on the particular techniques, transitions and
effects that will best express your intent.

An important part of editing is the creation of a
soundtrack. The right sound - dialog, music,
commentary or effect — can work with the visuals to
create a whole greater than the sum of its parts.

Studio has the tools to create professional-quality home
video. The rest is up to you — the videographer.

Creating a shooting plan

It is not always necessary to have a shooting plan, but it
can be very helpful for large video projects. The plan
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can be as simple or as complex as you like. A simple
list of planned scenes might be enough, or you might
also want to include some notes regarding detailed
camera directions or prepared dialog. The really
ambitious can go all the way to a full-fledged script in
which every single camera angle is described in detail

along with notes about duration, lighting and props.

Title: “Jack on the kart track”

No. Camera angle Text / Audio Duration | Date

1 |Jack's face with helmet, | “Jack is driving his
camera zooms out first race...” 11 sec Tue.

S 06/22
Noise of engines in
the background.

2 |On the starting line, Music is played in 8 sec Tue.
driver's perspective; low | the hall, noise of 06/22
camera position. engines.

3 |Man with a starting flag is | “Let's go...”.
accompanied into the Carry out the start, 12 sec Tue.
scene to the start add starting signal. 06/22
position. Camera stays,
man goes out of the
scene after start.

4 |Jack on the start position | Music from the hall
from the front, camera no longer audible, 9 sec Tue.
follows, shows Jack up to | fade up same music 06/22
the bend, now from from CD over noise
behind. of engines.

5

Draft of a simple shooting plan

00|
Editing

Using varying perspectives

An important event should always be shot from varying
perspectives and camera positions. Later, during
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editing, you can use the best camera angles alone or in
combination. Make a conscious effort to tape events
from more than one camera angle (first the clown in the
circus ring, but then also the laughing spectator from
the clown’s point of view). Interesting events can also
take place behind the protagonists or the protagonists
may be seen in a reverse angle. This can be helpful
later when trying to establish a sense of balance in the
movie.

Close-ups

Don’t be stingy with close-ups of important things or
persons. Close-ups usually look better and more
interesting than long shots do on a television screen,
and they work well in post-production effects.

Long shots / Semi-long shots

Long shots provide the viewer with an overview and
establish the scene of the action. However, these shots
can also be used to tighten longer scenes. When you cut
from a close-up to a long shot, the viewer no longer
sees the details, and it is thus easier to make a
chronological jump. Showing a spectator in a semi-long
shot can also provide visual relief from the main action,
and the opportunity of a transition away from the action
if desired.

Complete actions

Always shoot complete actions with a beginning and an
end. This makes editing easier.

Transitions

Cinematic timing requires some practice. It is not
always possible to film long events in their entirety,
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and in movies they often have to be represented in
severely abbreviated form. Nonetheless, the plot should
remain logical and cuts should almost never call
attention to themselves.

This is where the transition from one scene to the next
is important. Even if the action in neighboring scenes is
separated in time or space, your editorial choices can
make the juxtaposition so smooth that the viewer
bridges the gap without conscious attention.

The secret to a successful transition is establishing an
easily-felt connection between the two scenes. In a
plot-related transition, the connection is that of
successive events in an unfolding story. For example, a
shot of a new car might be used to introduce a
documentary about its design and production.

A neutral transition doesn’t in itself imply a story
development or a change of time or place, but can be
used to smoothly connect different excerpts from a
scene. For example, cutting away to an interested
audience member during a podium discussion lets you
then cut back unobtrusively to a later point in the same
discussion, omitting the part between.

External transitions show something apart from the
action. For example, during a shot inside the marriage
registry, you might cut to the exterior of the marriage
registry, where a surprise is already being set up.

Transitions should underscore the message of the film
and must always fit the respective situation, in order to
avoid confusing viewers or distracting from the actual
storyline.

Logical sequence of action

The shots strung together during editing must interact
appropriately in relation to the action. Viewers will be
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unable to follow the events unless the storyline is
logical. Capture viewer interest from the very
beginning with a fast-paced or spectacular start and
maintain that interest until the very end. Viewers can
lose interest or become disoriented if scenes are strung
together in a manner that is illogical or chronologically
false, or if scenes are too hectic or short (under three
seconds). There should be some continuity of motif
from one scene to the next.

Bridging the gaps

Make an effort to bridge the gaps from one filming
location to another. You can use close-ups, for
example, to bridge chronological jumps, zooming in on
the face, then back out after a few seconds onto a
different scene.

Maintain continuity

Continuity — consistency of detail from one scene to the
next — is vital in providing a satisfying viewing
experience. Sunny weather does not fit with spectators
who opened their umbrellas.

Tempo of cuts

The tempo at which a film cuts from one scene to the
next often influences the message and mood of the
film. The absence of an expected shot and the duration
of a shot are both ways of manipulating the message of
the film.

Avoid visual disjunctions

Stringing together similar shots in succession may
result in visual disjunctions. A person may be in the left
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half of the frame one moment and in the right half of
the frame the next, or may appear first with and then
without eyeglasses.

Do not string together pan shots

Pan shots should not be strung together unless they
have the same direction and tempo.

00|
Rules of thumb for video editing

Here are some guidelines that may be helpful when you
come to edit your movie. Of course, there are no hard
and fast rules, especially if your work is humorous or
experimental.

e Do not string together scenes in which the camera is
moving. Pans, zooms, and other moving shots should
always be separated by static shots.

e Shots that follow one another should be from
different camera positions. The camera angle should
vary by at least 45 degrees.

e Sequences of faces should always be shot alternately
from varying angles of view.

e Change perspectives when shooting buildings. When
you have similar shots of the same type and size, the
picture diagonal should alternate between front left
to rear right and vice versa.

e Make cuts when persons are in motion. The viewer
will be distracted by the ongoing motion and the cut
will go almost without notice. In particular, you can
cut to a long shot from the middle of the motion.
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e Make harmonious cuts; avoid visual disjunction.

e The less motion there is in a shot, the shorter it
should be. Shots with fast movements can be longer.

e Long shots have more content, so they should also be
shown longer.

Ordering your video sequences in a deliberate manner
not only permits you to produce certain effects, but
even enables you to convey messages that cannot or
should not be shown in pictures. There are basically six
methods of conveying messages through cuts. Let’s
look at each in turn.

Associative cuts

Shots are strung together in a certain order to trigger
associations in the mind of the viewer, but the actual
message is not shown. Example: A man bets on a horse
race and, in very next scene, we see him shopping for
an expensive new car at a car dealership.

Parallel cuts

Two actions are shown in parallel. The film jumps back
and forth between the two actions; making the shots
shorter and shorter until the end. This is a way of
building suspense until it peaks. Example: Two
different cars drive from different directions at high
speed toward the same intersection.

Contrast cuts

The film purposely cuts unexpectedly from one shot to
another, very different shot, in order to point up the
contrast to the viewer. Example: A tourist lying on the
beach; the next shot shows starving children.
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Substitutionary cut

Events that cannot or should not be shown are replaced
by other events (a child is born, but instead of
childbirth, the blossoming of a flower bud is shown).

Cause and effect cuts

Shots are related by virtue of cause and effect: without
the first shot, the second would be incomprehensible.
Example: A man fights with his wife and, in the very
next shot, winds up sleeping under a bridge.

Formal cuts

Shots that vary in content can be strung together if they
have something in common — the same shapes, colors,
or motions, for example. Examples: A crystal ball and
the earth; a yellow raincoat and yellow flowers; a
falling skydiver and a falling feather.

0|
Soundtrack production

Soundtrack production is an art, but it is an art one can
learn. Of course, it is no easy task to create a superb
narration, but short, informative comments are often
very helpful for the viewer. Whatever narration there is
should sound natural, expressive and spontaneous, not
wooden or stiff.

Keep comments brief

A general rule applicable to all commentary is that less
is more. Pictures should speak for themselves, and
things that are evident to viewers from the pictures
require no comment.
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Preserve original sounds

Spoken commentary should be mixed with both the
original sounds and the music in such a way that the
original sounds can still be heard. Natural sound is part
of your video footage and should not be cut away
altogether if at all possible, because video without
natural sound can easily seem sterile and lacking in
authenticity. Frequently, however, the recording
equipment captures noises from aircraft and cars that
do not appear in the scene later. Sounds such as these,
or loud wind noises, which can be distracting or
annoying, should be masked, filtered or replaced with
appropriate narration or music.

Select appropriate music

Appropriate music adds a professional finishing touch
to your movie and can do a lot to reinforce the message
of a video. The music selected, however, should always
be appropriate to the message of the film. This is
sometimes a time-consuming matter and a challenge,
but greatly appreciated by the viewer.

Title

The title should be informative, describe the contents of
the movie, and arouse interest. With the Title Editor
there are no limits to how creative you can be. As a
rule, you can let your fancy run free when designing a
title for your video.

Use a short, clear title
Titles should be short and in a large, legible font.
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Title colors

The following combinations of background and text are
easy to read: white with red, yellow with black, and
white with green. Exercise caution with very white
titles on a very black background. Some video systems
are unable to handle contrast ratios in excess of 1:40
and are unable to reproduce such titles in detail.

Time on screen

As a rule of thumb, a title should be displayed long
enough to be read twice. Allow about three seconds for
a title with ten letters. Allow an additional second of
on-screen time for every five additional letters.

“Found” titles

Besides postproduction titles, natural titles like
directional signs, street signs or title pages of local
newspapers also create interesting possibilities.
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APPENDIX E:

Glossary

Multimedia terminology contains computer and video
terminology. The most important terms are defined
below. Cross-references are indicated by L.

720p: A high-definition (HD) video format with a
resolution of 1280x720 and progressive (non-
interlaced) frames.

108i: A high-definition (HD) video format with a
resolution of 1440x1080 and interlaced frames.

ActiveMovie: Software interface by Microsoft for the
control of multimedia devices under Windows.
DirectShow, DirectMedia

ADPCM: Acronym for Adaptive Delta Pulse Code
Modulation, a method of storing audio information in a
digital format. This is the audio encoding and
compression method used in CD-I and CD-ROM
production.

Address: All available saving positions in a computer
are numbered (addressed). By means of these addresses
each saving position can be occupied. Some addresses
are reserved for the exclusive use of particular
hardware components. If two components are using the
same address, this is called an “address conflict”.
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Aliasing: An inaccurate display of an image due to the
limitations of the output device. Typically, aliasing
appears in the form of jagged edges along curves and
angled shapes.

Anti-aliasing: A method of smoothing out jagged
edges in bitmap images. This is usually accomplished
by shading the edges with pixels intermediate in color
between the edge and the background, making the
transition less apparent. Another method of anti-
aliasing involves wusing higher resolution output
devices.

Aspect ratio: The ratio of width to height in an image
or graphic. Keeping the aspect ratio fixed means that
any change to one value is immediately reflected in the
other.

AVI: Audio Video Interleaved, a standard format for
digital video (and [ Video for Windows).

Batch capture: An automated process that uses an
edit decision list to locate and recapture specific
clips from a videotape, usually at a higher data rate
than the clip was originally captured.

BIOS: Acronym for Basic Input Output System, which
refers to basic input and output commands saved in a
ROM, PROM or EJ EPROM. The essential task of
the BIOS is the control of input and output. When the
system is started, the ROM-BIOS carries out some
tests. 4 Parallel port, IRQ, 1/0

Bit: Abbreviation of “Blnary digiT”, the smallest

element of a computer’s memory. Among other things,

bits are used to store the color values of pixels in an

image. The more bits used for each pixel, the

greater the number of available colors. For example:
1-bit: each pixel is either black or white.

4-bit: allows 16 colors or gray shades.
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8-bit: allows 256 colors or gray shades.
16-bit: allows 65,536 colors.
24-bit: allows about 16.7 million colors.

Bitmap: An image format made up of a collection of
dots or “pixels” arranged in rows. LLJ Pixel

Blacking: The process of preparing a videotape for
insert editing by recording video black and continuous
control track on the entire tape. If the recording deck
supports timecode, continuous timecode will be
recorded simultaneously (also called “striping”).

Brightness: Also “luminance”. Indicates the brightness
of video.

Byte: One byte corresponds to eight L1 bits. With one
byte, exactly one alphanumeric character can be
displayed (i.e. a letter, number).

CD-ROM: Mass storage media for digital data, such as
digital video. CD-ROMs can be read from but not
written (recorded) onto: ROM is an acronym for
Read-Only Memory.

Channel: Classifications of information within a data
file to isolate a particular aspect of the file. For
example, color images use different channels to classify
the color components in the image. Stereo audio files
use channels to identify the sounds intended for the left
and right speakers. Video files use combinations of the
channels used for image and audio files.

Clip: In Studio, any media type that goes on the Movie
Window Storyboard or Timeline, including video
images, trimmed video scenes, images, audio files and
disc menus.

Clipboard: A temporary storage area shared by all
Windows programs, used to hold data during cut, copy,
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and paste operations. Any new data you place onto the
clipboard immediately replaces the existing data.

Closed GOP: GOP

Codec: Contraction of compressor/decompressor — an
algorithm that compresses (packs) and decompresses
(unpacks) image data. Codecs can be implemented in
either software or hardware.

Color depth: Number of bits delivering the color
information for each pixel. A 1-bit color depth allows
2'=2 colors, an 8-bit depth allows 22=256 colors, and a
24-bit depth allows 2%*=16,777,216 colors.

Color model: A way to mathematically describe and
define colors and the way they relate to each other.
Each color model has its own strengths. The two most
common color models are [ RGB and £4 YUV.

Color saturation: Intensity of a color.

Complementary color: Complementary colors are
opposite in value to primary colors. If you were to
combine a color with its complement, the result would
be white. For example, the complementary colors of
red, green and blue are cyan, magenta and yellow
respectively.

COM Port: A serial port located on the back of your
computer for attaching a modem, plotter, printer or
mouse to the system.

Composite video: Composite video encodes luminance
and chrominance information into one signal. VHS
and 8mm are formats that record and play back
composite video.

Compression: A method for making files smaller in
size. There are two types of compression: lossless and
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lossy. Files compressed with a lossless scheme can be
restored unchanged from their original state. Lossy
schemes discard data during compression, so some
image quality is sacrificed. The loss of quality may be
negligible or severe depending on the amount of
compression.

Cropping: Choosing the area of an image to be
displayed.

Data rate: The quantity of data transmitted per unit
time; for example, the number of bytes read from or
written to a hard drive per second, or the amount of
video data processed per second.

Data transfer rate: The measurement of the speed at
which information passes between the storage device
(e.g. LLJ CD-ROM or hard drive) and the display device
(e.g. monitor or MCI device). Depending on the
devices used, some transfer rates may offer better
performance than others.

DCT: Discrete Cosine Transformation — part of
O JPEG image data compression and related
algorithms. The brightness and color information is
saved as a frequency coefficient.

DirectShow: System extension by Microsoft for
multimedia applications under Windows.
ActiveMovie

DirectMedia: System extension by Microsoft for
multimedia applications under Windows.
ActiveMovie

DirectX: A bundle of several system extensions
developed by Microsoft for Windows 95 and its
successors to make possible video and game
acceleration.
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Dissolve: A transitional effect in which the video is
faded from one scene to the next.

Dithering: Increasing the number of apparent colors in
an image by the application of color patterns.

Decibel (dB): A unit of measurement of the loudness
of sound. An increase of 3 dB doubles the loudness.

Digital8: Digital videotape format that records L DV-
coded audio and video data on Hi8 tapes. Currently
sold only by Sony, Digital8 camcorders and VCRs can
play both Hi8 and 8mm cassettes.

Digital video: Digital video stores information bit
by bit in a file (in contrast to analog storage media).

DMA: Direct Memory Access.

Driver: A file containing information needed to
operate peripherals. The video capture driver operates a
video capture board, for example.

DV: Digital videotape format for recording digital
audio and video on Y4”-wide metal evaporated tape.
Mini-DV tapes hold up to 60 minutes of content, while
standard DV tapes can hold up to 270 minutes.

ECP: “Enhanced Compatible Port”. Enables
accelerated bi-directional data transfer via the
parallel port. L EPP

Edit decision list (EDL): A list of clips and effects in a
particular order that will be recorded onto your output
tape, disc or file. Studio allows you to create and edit
your own edit decision list by adding, deleting and
reordering clips and effects in the Movie Window.

EPP: “Enhanced Parallel Port”. Enables accelerated bi-
directional data transfer via the parallel port;
recommended for Studio DV. ECP
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EPROM:  “Erasable Programmable Read-Only
Memory”. Memory chip that after programming retains
its data without power supply. The memory contents
can be erased with ultraviolet light and rewritten.

Fade to/from black: A digital effect that fades up from
black at the beginning of a clip or down to black at the
end.

Field: A frame of video consists of horizontal lines
and is divided into two fields. The odd lines in the
frame are Field 1; the even-numbered lines are Field 2.

File format: The organization of information within a
computer file such as an image or word processor
document. The format of a file is usually indicated by
its “file extension” (e.g. doc, avi or wmf).

Filters: Tools that alter data to produce special effects.

FireWire: Apple Computer’s trademarked name for
the L IEEE-1394 serial data protocol.

Frame: A single image in a video or animation
sequence. If using full NTSC or PAL resolution, one
frame consists of two interlaced fields. NTSC, PAL,
field, resolution

Frame rate: The frame rate defines how many frames
of a video sequence are played in one second. The
frame rate for L.J NTSC video is 30 frames per second.
The frame rate for PAL video is 25 frames per
second.

Frame size: The maximum size for displaying image
data in a video or animation sequence. If an image
intended for the sequence is larger than the frame size,
it must be cropped or scaled to fit.

Frequency: The number of repetitions in a periodic
process (like a sound wave or an alternating voltage)
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per unit of time. Usually measured in repetitions per
second, or Hertz (Hz).

GOP: In MPEG compression the data stream is
first divided into “Groups Of Pictures” — sections of
several frames each. Each GOP contains three types of
frames: I-Frames, P-Frames (pictures) and B-Frames.

GOP size: The GOP size defines, how many I-Frames,
B-Frames and P-Frames are included in one GOP.
For example, current GOP sizes are 9 or 12.

Hardware codec: Compression method that uses
special hardware to create and play back compressed
digital video sequences. A hardware codec may offer
better encoding speed and image quality than a codec
implemented completely in software. Codec,
Software codec

HD: High Definition video. Most HD formats in use
have a resolution of either 1920x1080 resolution or
1280x720 resolution. A substantial difference exists
between the 1080 and 720 standards: the larger format
uses 2.25 more pixels per frame. This difference
substantially increases requirements for processing
1080 content in terms of encoding time, decoding
speed, and storage. The 720 formats are all progressive.
The 1080 format has a mixture of progressive and
interlaced frame types. Computers and their displays
are inherently progressive, whereas television
broadcasting has been based on interlaced techniques
and standards. For HD terminology, we indicate
progressive with the letter "p" and interlaced with the
letter "i"

HDV: A format for the recording and playback of
high-definition video on a DV cassette tape. has been
established as the "HDV" format". Instead of the "DV"
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codec, HDV uses a flavor of MPEG-2 . There are two
varieties of HDV: HDV1 and HDV2. HDV1 is
1280x720 resolution with progressive frames (720p).
The MPEG transport stream is 19.7 Mbps/s. HDV?2 is
1440x1080 resolution with interlaced frames (1080i).
The MPEG transport stream is 25 Mbps/s.

Hi8: Improved version of L Video8 using [EJ S-Video
recorded on metal particle or metal evaporated tape.
Because of higher luminance resolution and wider
bandwidth, the result is sharper pictures than Video8.

HiColor: For images, this normally means a 16-bit
(5-6-5) data type that can contain up to 65,536 colors.
TGA file formats support images of this type. Other file
formats require prior conversion of a HiColor image
into X TrueColor. For displays, HiColor normally
refers to 15-bit (5-5-5) display adapters that can display
up to 32,768 colors. L Bit

Huffman coding: Technique used in EJ JPEG and
other data compression methods in which seldom
occurring values receive a long code, while frequently-
occurring values receive a short code.

IDE: “Integrated Device Electronics” — a hard-drive
interface that combines all drive control electronics on
the drive itself, rather than on the adapter connecting
the drive to the expansion bus.

IEEE-1394: Developed by Apple Computers and
introduced as FireWire, this is a serial data
transmission protocol with rates up to 400 Mbits/sec.
Sony offers a slightly modified version for transmitting
DV signals named i.LINK, providing transmission
speeds up to 100 Mbits/sec.

Image: An image is a reproduction, or picture of
something. The term is often applied to digitized
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pictures, consisting of pixels, that can be shown on a
computer display and manipulated by software.

Image compression: Method of reducing the amount
of data required to store digital image and video files.

Interlaced: The screen refresh method used by
television systems. The L PAL TV image consists of
two interleaved image halves (£ fields) of 312% lines
each. The NTSC TV image consists of two image
halves of 242% lines each. The fields are displayed
alternately to produce a blended image.

Interleave: An arrangement of audio and video to
promote smoother playback and synchronization or
compression. The standard [EJ AVI format equally
spaces audio and video.

1/0O: Input/Output.

IRQ: “Interrupt Request”. An “interrupt” is a
temporary break in the main processing stream of a
computer so that housekeeping or background tasks can
be performed. Interrupts can be requested by either
hardware (e.g. keyboard, mouse) or software.

JPEG: Joint Photographic Experts Group, and the
standard developed by them for compressing digital
frames based on [ DCT.

Kbyte (also KB): One Kbyte (kilobyte) contains 1024
bytes. The “K” here stands for the number 1024
(29), and not 1000 as in the metric prefix.

Key color: A color whose display is suppressed so that
a background image can show through. Most
commonly used when overlaying one video sequence
on top of another, allowing the underlying video to
display wherever the key color appears.
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Key frames: In some compression methods, such as
MPEG, the video data of certain frames — the key
frames — is stored completely in the compressed file,
while any intervening frames are only partially saved.
On decompression these partial frames reconstruct their
data from the key frames.

Laser disc: Medium that stores analog video.
Information on laser discs cannot be modified.

LPT: L Parallel port
Luminance: Brightness

M1V: (File extension for) an MPEG file that contains
video data only. £ MPA, MPEG, MPG

Mbyte (also MB): One Mbyte (megabyte) corresponds
to 1024 L1 Kbytes — 1024 x 1024 bytes.

Mark In / Mark Out: In video editing, the mark in
and mark out times refer to the starting and ending
timecodes that identify the portions of clips to be
included in the project.

MCI: Media Control Interface. Programming interface
developed by Microsoft recording and playing back
audio and video data. It is also used to connect a
computer to an external video source such as a VCR or
laser disc.

Modulation: The encoding of information upon an
empty carrier signal.

Motion-JPEG (M-JPEG): A Video for Windows
format, specified by Microsoft, for encoding video
sequences. JPEG compression is used to compress
each frame individually.

MPA: (File extension for) an MPEG file that contains
audio data only. 2 M1V, MPEG, MPG

Appendix E: Glossary 369



370

MPEG: Motion Picture Experts Group, and the
standard developed by them for the compression of
moving images. Compared to M-JPEG, it offers 75-
80% data reduction with the same visual quality.

MPG: (File extension for) an MPEG file that contains
both video and audio data. L M1V, MPEG, MPA

MPV: (File extension for) an MPEG file that contains
video data only. £ MPA, MPEG, MPG

Non-interlaced: Describes an image refresh method in
which the complete image is generated as a single field
without skipping lines. A non-interlaced image (most
computer monitors) flickers much less than an
interlaced image (most TVs).

NTSC: National Television Standards Committee, and
the color TV standard created by them in 1953. NTSC
video has 525 lines per frame and 60 image fields per
second. It is used in North and Central America, Japan
and other countries. £ PAL, SECAM

PAL: “Phase Alternation Line”, a color TV standard
developed in Germany and used throughout most of
Europe. PAL video has 625 lines per frame and 50
image fields per second. L NTSC, SECAM

Parallel port: Parallel port data is transmitted via an
8-bit data line. This means that eight bits (one
(D byte) can be transmitted at once. This kind of
transmission is much faster than serial transmission,
but is not appropriate for long-distance connections.
Parallel ports are often named “LPTn”, where n is a
number (e.g. “LPT1”). LI Serial port

Pixel: The smallest element of a monitor image. The
word is an abbreviation of “picture element”.
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Port: Electrical transfer point for the transmission of
audio, video, control or other data between two
devices. LI Serial port, Parallel port

Primary colors: The colors that are the basis of the
RGB color model: red, green, and blue. It is possible to
create most other colors on a computer screen by
varying the blend of these primaries.

QSIF: Quarter Standard Image Format. An MPEG-1
format specifying a resolution of 176 x 144 under PAL
and 176 x 120 under NTSC. MPEG, SIF

Quantization: One part of the JPEG image data
compression strategy. Relevant details are represented
precisely, while details that are less relevant for the
human eye are represented with less precision.

Raster: The area of a video display that is covered by
sweeping the electron beam of the display in a series of
horizontal lines from upper left to lower right (from the
viewer’s perspective).

Redundancy: This trait of images is exploited by
compression algorithms. Superfluous information can
be eliminated during compression and restored without
loss during decompression.

Resolution: The number of pixels that can be displayed
on the monitor horizontally and vertically. The higher
the resolution, the more details can be displayed.
Pixel

RGB: Red, Green and Blue: the primary colors in
additive color mixing. RGB designates the method
used in computer technology of encoding image infor-
mation in pixels, each containing some combination of
the three primaries.
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ROM: Read Only Memory: Memory storage that,
having been programmed once, retains its data without
requiring electrical power. EPROM

Run Length Encoding (RLE): A technique used in
many image compression methods, including
JPEG. Repeating values are not stored separately
but with a counter to indicate how many times the
value occurs in succession — the length of the “run”.

Scaling: Adaptation of an image to a desired size.

SCSI: Small Computers System Interface. SCSI was
long preferred as the hard drive interface for some
high-performance PCs because of its high data rate. Up
to eight SCSI devices can be connected to a computer
at the same time.

SECAM: “Séquentiel Couleur a Mémoire”, a color TV
transmission system used in France and Eastern
Europe. Like PAL, SECAM video has 625 lines per
frame and 50 image fields per second. L NTSC, PAL

Serial port: Data transmitted via a serial port is
processed one bit at a time; that is, “serially” — one
after another. The transmission rate is much slower
than that of a parallel port, where parallel data lines
allow multiple bits to be sent simultaneously. Serial
ports are named “COMN”, where n is a number (e.g.
“COM2”). [ Parallel port

SIF: Standard Image Format. An MPEG-1 format
specifying a resolution of 352 x 288 under PAL and
352 x 240 under NTSC. 4 MPEG, QSIF

Single frame: A single frame is part of a series or
sequence. When this series is viewed at sufficient
speed, the illusion of a “moving picture” is created.
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Software codec: Compression method that can create
and play back compressed digital video sequences
without special hardware. The quality of the sequences
depends on the performance of the complete system.
Codec, Hardware codec

Still video: Still images (or “freeze-frames”) extracted
from video.

S-VHS: Improved version of VHS using S-Video and
metal particle tape to deliver higher luminance
resolution, resulting in sharper pictures than VHS.
VHS, S-Video

S-Video: With S-Video (Y/C) signals, the brightness
(luminance or “Y”) and the color (chrominance or “C”)
information are transferred separately using multiple
wires, avoiding modulating and demodulating the video
and the resulting loss of picture quality.

Timecode: Timecode identifies the position of each
frame in a video sequence with respect to a starting
point (normally the beginning of the shot). The usual
format is H:M:S:F (hours, minutes, seconds, frames),
e.g. “01:22:13:21”. Unlike a tape counter (which can be
“zeroed” or reset at any point in a tape), timecode is an
electronic signal written onto videotape, and is
permanent once it is assigned.

Transition: The visual connection between adjacent
video clips, ranging from a simple “cut” to a showy
animated effect. The common transitions like cuts,
fades, dissolves, wipes and slides are part of the visual
language of film and video. They can convey passages
of time and changes of viewpoint concisely — and often
subliminally.

TrueColor: The name indicates an image with enough
color resolution to appear “true to life”. In practice,
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TrueColor normally refers to 24-bit RGB color, which
allows about 16.7 million combinations of the red,
green and blue primary colors. Bit, HiColor

TWAIN driver: TWAIN is a standardized software
interface allowing graphics and capture programs to
communicate with devices that supply graphical data. If
the TWAIN driver is installed, the capture function of a
graphics application can be used to load images directly
from your video source into the program. The driver
supports 32-bit programs only and captures images in
24-bit mode.

VCR: “Video cassette recorder”.

VHS: “Video Home System” — Popular video standard
for home VCRs. Half-inch tape is used to store
“composite” signals incorporating both brightness and
color information.

VISCA: Protocol used with certain devices for control-
ling external video sources from computers.

Video8: Analog video system using 8mm tape. Video8
recorders generate composite signals.

Video CD: CD-ROM standard that uses MPEG
compressed videos.

Video decoder: Converts digital information into
analog video signals.

Video encoder: Converts analog video signals into
digital information.

Video for Windows: A Microsoft Windows system
extension that can record digital video sequences to
files on a hard drive and subsequently play them back.

Video scan rate: Frequency with which the video
signal is scanned onto an image display. The higher the
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video scan rate, the higher the image quality and the
less noticeable the flicker.

WAV: (File extension for) a popular file format for
digitized audio signals.

White balance: In an electronic camera, this is the
adjustment of the amplifiers for the three color
channels (red, green and blue) so that white areas of the
scene do not show a color cast.

Y/C: YIC is a color signal with two components:
brightness information (Y) and color information (C).

YUV: The color model of a video signal where Y
delivers the brightness information and U and V the
color information.
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APPENDIX F:

License agreement

Pinnacle End User License Agreement

This End User License Agreement (“License") is a legal agreement
between you and Pinnacle Systems, Inc. ("Pinnacle”) regarding
Pinnacle’s  software and the accompanying documentation
(collectively, the "Software"). CAREFULLY READ THE
FOLLOWING LICENSE. BY CHOOSING THE “I ACCEPT THE
TERMS IN THE LICENSE AGREEMENT” OPTION YOU ARE (1)
REPRESENTING THAT YOU ARE OVER THE AGE OF 18 AND
HAVE THE CAPACITY AND AUTHORITY TO BIND
YOURSELF TO THE TERMS OF THIS LICENSE AND (2)
CONSENTING TO BE BOUND BY THIS LICENSE. IF YOU DO
NOT ACCEPT OR UNDERSTAND THE TERMS OF THIS
LICENSE, OR YOU DO NOT REPRESENT THE FOREGOING,
YOU SHOULD NOT DOWNLOAD, INSTALL, ACCESS OR USE
THE SOFTWARE AND SHOULD PROMPTLY RETURN THIS
PRODUCT TO THE PLACE OF PURCHASE WITH PROOF OF
PURCHASE TO OBTAIN A REFUND FOR THE AMOUNT PAID.
Any use of the Software other than pursuant to the terms of this
License is a violation of U.S. and international copyright laws and
conventions.

1. License Grant. Subject to the restrictions set forth below, this
License grants you a non-exclusive, perpetual license to (a) install the
Software on only one computer; (b) use or authorise use of the
Software on only one computer; (c) make one copy of the Software, in
machine-readable form, solely for backup purposes; provided you
include all copyright and other proprietary rights notices on the copy;
and (d) transfer the Software and this License to another party if the
other party agrees to accept the terms and conditions of this License.
If you transfer the Software, you must at the same time either transfer
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all copies to the same party or destroy any copies not transferred. If
you transfer possession of any copy of the Software to another party,
your License is automatically terminated. Some features of the
Software may be locked and require that you activate, either for free
or subject to payment of additional license fees, the features before
you may use them. Additionally, Pinnacle may, either for free or
subject to payment of additional license fees, grant you a license for
plug-ins to the Software produced or distributed by Pinnacle (the
"Plug-ins"). Your use of any such features and any of the Plug-ins
shall be subject to the terms of this Agreement, unless accompanied
by another license agreement, in which case the Plug-ins license
agreement shall prevail.

2. License Restrictions and Notices. You may not, or allow any third
party to, (a) distribute, rent, lease, sell, or loan the Software or any of
your rights and obligations under this License; (b) install the Software
on a network for use by multiple users, unless each user has purchased
a license; (c) reverse-engineer, decompile or disassemble the Software
or hardware in whole or in part, unless it is necessary to obtain the
information required to achieve the interoperability of the Software
with other programs and applicable law requires that Pinnacle permit
such reverse-engineering, decompiling or disassembly for such
purposes; (d) remove or destroy any copyright notices or other
proprietary markings of the Software or any third-party software; (e)
modify or adapt the Software, merge the Software into another
program or create derivative works based on the Software; (f) make
copies of or distribute, for profit or otherwise, the Software, except as
expressly provided above; (g) make any alteration, modification,
connection, disconnection, improvement or adjustment of any kind to
or use the Software except as explicitly contemplated in the enclosed
documentation and in this License; and (h) sublicense, transfer or
assign this License or any of the rights and obligations granted under
this License, except as explicitly contemplated in this License. Any
purported transfer or assignment will be void.

License Restrictions for Dolby Digital 5.1 Creator. You may not use
the Dolby Digital 5.1 Creator technology to encode content that you
intend to distribute commercially.

MPEG-2 Notice. ANY USE OF THIS PRODUCT OTHER THAN
CONSUMER PERSONAL USE IN ANY MANNER THAT
COMPLIES WITH THE MPEG-2 STANDARD FOR ENCODING
VIDEO INFORMATION FOR PACKAGED MEDIA IS
EXPRESSLY PROHIBITED WITHOUT A LICENSE UNDER
APPLICABLE PATENTS IN THE MPEG-2 PATENT PORTFOLIO,
WHICH LICENSE IS AVAILABLE FROM MPEG LA, L.L.C., 250
STEELE STREET, SUITE 300, DENVER, COLORADO 80206.
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MPEG-4 Notice. THIS PRODUCT IS LICENSED UNDER THE
MPEG-4 VISUAL PATENT PORTFOLIO LICENSE FOR THE
PERSONAL AND NON-COMMERCIAAL USE OF A CONSUMER
FOR (i) ENCODING VIDEO IN COMPLIANCE WITH THE
MPEG-4 VISUAL STANDARD (“MPEG-4 VIDEO”) AND/OR (ii)
DECODING MPEG-4 VIDEO THAT WAS ENCODED BY A
CONSUMER ENGAGED IN A PERSONAL AND NON-
COMMERCIAL ACTIVITY AND/OR WAS OBTAINED FROM A
VIDEO PROVIDER LICENSED BY MPEG LA TO PROVIDE
MPEG-4 VIDEO. NO LICENSE IS GRANTED OR SHALL BE
IMPLIED FOR ANY OTHER USE. ADDITIONAL
INFORMATION INCLUDING THAT  RELATING TO
PROMOTIONAL, INTERNAL AND COMMERCIAL USES AND
LICENSEING MAY BE OBTAINED FROM MPEG LA, LLC. SEE
HTTP://WWW.MPEGLA.COM. THIS PRODUCT IS LICENSED
UNDER THE MPEG-4 SYSTEMS PATENT PORTFOLIO
LICENSE FOR ENCODING IN COMPLIANCE WITH THE MPEG-
4 SYSTEMS STANDARD, EXCEPT THAT AN ADDITIONAL
LICENSE AND PAYMENT OF ROYALTIES ARE NECESSARY
FOR ENCODING IN CONNECTION WITH (i) DATA STORED
OR REPLICATED IN PHYSICAL MEDIA WHICH IS PAID FOR
ON A TITLE BY TITLE BASIS AND/OR (ii) DATA WHICH IS
PAID FOR ON A TITLE BY TITLE BASIS AND IS
TRANSMITTED TO AN END USER FOR PERMANENT
STORAGE AND/OR USE, SUCH ADDITIONAL LICENSE MAY
BE  OBTAINED FROM MPEG LA, LLC. SEE
HTTP://WWW.MPEGLA.COM FOR ADDITIONAL DETAILS.

3. Export Restrictions. You will not transfer, export, or re-export the
Software, any related technology, or any direct product of either
except in full compliance with the export controls and economic
sanctions administered by the United States and other countries and
any applicable import and use restrictions. You agree that you will not
export or re-export such items to anyone on the U.S. Treasury
Department’s list of Specially Designated Nationals or the U.S.
Commerce Department's Denied Persons List or Entity List, as the
same may be revised from time to time, or to any country prohibited
by the United States Export Administration Act and the regulations
thereunder, which are currently Cuba, Iran, North Korea, Sudan,
Syria, or for use with chemical or biological weapons, sensitive
nuclear end-uses, or missiles. You represent and warrant that you are
not located in, under control of, or a national or resident of any such
country or on any such list. “Export” includes among other things an
actual shipment, transfer or transmission of the Software outside of
the United States or Canada (including downloading the Software to a
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location outside of the United States or Canada or making the
Software available to persons outside of the United States or Canada
via the Internet or other electronic means). You understand that the
foregoing obligations are U.S. legal requirements and agree that they
shall survive any term or termination of this License.

4. Ownership. The Software is licensed, not sold. The license granted
hereunder does not constitute a transfer or sale of ownership rights in
or to the Software. Except for the license rights granted above,
Pinnacle and its third party suppliers retain all rights, title and interest
in and to the Software including all intellectual property rights therein.
All rights not expressly granted to You are reserved solely to Pinnacle
or its third party suppliers. The Software is protected by applicable
intellectual property laws, including United States copyright laws and
international treaties.

5. Third Party Proprietary Property. This Software may contain
the proprietary property of others, which has been licensed to
Pinnacle. Your use of the Software is expressly subject to your
agreement not to remove any copyright notices or other proprietary
markings of the third party software.

6. Security. You acknowledge and agree that in order to protect the
integrity of certain third party content, Pinnacle and/or its licensors
may provide for Software security related updates that will be
automatically downloaded and installed on your computer. Such
security related updates may impair the Software (and any other
software on your computer which specifically depends on the
Software) including disabling your ability to copy and/or play
"secure™ content, i.e. content protected by digital rights management.
In such an event, Pinnacle and/or its licensors shall use reasonable
efforts to post notices promptly on Pinnacle’s web site explaining the
security update and providing instructions to end-users for obtaining
new versions or further updates of the Software that restore access to
secure content and related features.

7. Updates. You acknowledge and agree that Pinnacle may
automatically check the version of the Software and/or its components
that you are using and may provide updates or fixes to the Software
that may be automatically downloaded to your computer, and you
expressly authorize Pinnacle to do so. Updates provided after the
expiry of the Limited Warranty period set forth in Section 9 below are
not covered by any warranty, express, implied, or statutory.

8. Term and Termination. This License shall be effective upon
installation of the Software and shall terminate upon the earlier of (a)
your failure to comply with any term of this License; (b) return,
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destruction or deletion of all copies of the Software in your possession
or (c) transfer of the Software and this License to another party in
accordance with Section 1(d). Pinnacle’s rights and your obligations
shall survive termination of this License.

9. Limited Warranty. Pinnacle warrants to the original licensee that
the Software, as delivered, will perform in accordance with the
accompanying documentation for a period of 30 days from the date of
the original purchase ("Limited Warranty"). Pinnacle’s entire liability
and your exclusive remedy for breach of the preceding Limited
Warranty shall be, at Pinnacle’s sole option, repair or replacement of
the Software that does not meet the warranty set forth herein and that
is returned to Pinnacle. This limited warranty shall be void if failure
of the Software has resulted from any accident, abuse, misuse or
misapplication by you. Any replacement Software will be warranted
for 30 days.

10. NO OTHER WARRANTIES. EXCEPT AS EXPRESSLY SET
FORTH IN SECTION 9 ABOVE, THE SOFTWARE IS PROVIDED
ON AN "AS IS" BASIS. YOU ASSUME ALL RESPONSIBILITIES
FOR THE QUALITY AND PERFORMANCE OF THE
SOFTWARE. TO THE MAXIMUM EXTENT PERMITTED BY
APPLICABLE LAW, PINNACLE DISCLAIMS ALL
WARRANTIES, EITHER EXPRESS OR IMPLIED, INCLUDING
BUT NOT LIMITED TO IMPLIED WARRANTIES OF
MERCHANTABILITY, NON-INFRINGEMENT, TITLE AND
FITNESS FOR A PARTICULAR PURPOSE. PINNACLE DOES
NOT WARRANT THAT THE FUNCTIONS CONTAINED IN THE
SOFTWARE WILL MEET YOUR REQUIREMENTS, BE
UNINTERRUPTED OR ERROR FREE. SOME JURISDICTIONS
DO NOT ALLOW THE EXCLUSION OR LIMITATION OF
IMPLIED WARRANTIES, SO THE ABOVE EXCLUSION AND
LIMITATION MAY NOT APPLY TO YOU.

11. LIMITATION OF LIABILITY. TO THE MAXIMUM
EXTENT PERMITTED BY LAW, YOU AGREE THAT IN NO
EVENT WILL PINNACLE BE LIABLE FOR ANY
CONSEQUENTIAL, SPECIAL, INDIRECT, INCIDENTAL OR
PUNITIVE DAMAGES WHATSOEVER, EVEN IF PINNACLE
HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH
DAMAGES. IN NO EVENT SHALL PINNACLE’S LIABILITY
EXCEED THE TOTAL AMOUNT OF THE FEES PAID FOR THE
SOFTWARE. Certain jurisdictions may limit Pinnacle’s and its
licensors’ ability to disclaim their liability to you, in which case, the
foregoing disclaimer shall be construed to limit Pinnacle’s and its
licensors’ liability to the maximum extent permitted by applicable
law.
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12. General. This License is governed by the laws of the country in
which you purchased your copy of the Software. Pinnacle shall be
entitled to seek, in addition to any other remedy available to it,
equitable relief, including injunctive relief, without the posting of any
bond and in addition to all other remedies provided under this License
or available at law. You and Pinnacle specifically exclude the United
Nations Convention on Contracts for the International Sale of Goods
from this License and any transaction between you and Pinnacle that
may be implemented in connection with this License. This License is
the entire agreement between you and Pinnacle and supersedes any
other communication with respect to the Software. If any provision of
this License is held invalid or unenforceable, the remainder of this
License will continue in full force and effect. Pinnacle’s failure to
exercise or delay in exercising any of its rights under this License will
not constitute or be deemed a waiver or forfeiture of those rights.

13. United States Government End Users. The Software is a
“commercial item,” as that term is defined in 48 C.F.R. 2.101 (Oct.
2005), consisting of “commercial computer software” and
“commercial computer software documentation,” as such terms are
used in 48 C.F.R. 12.212 (Sept. 2005). Consistent with 48 C.F.R.
12.212 and 48 C.F.R. 227.7202-1 through 227.7202-4 (June 2005), all
U.S. Government End Users acquire the Software with only those
rights set forth herein.

14. Respect Copyright: This product is intended for use with content
that you own, license, or obtain from the public domain. You are not
licensed to use this product to violate any law, including copyright
laws. Please respect the rights of content owners when using this
product.
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APPENDIX G:

Keyboard shortcuts

The terms Left, Right, Up and Down in this table refer
to the arrow (cursor) keys.

Main Studio interface

Space bar
J

X or Ctrl+Up

Y or Ctrl+Down
Aorl

SorO
Ctrl+Left
Ctrl+Right
Alt+Left
Alt+Right
Alt+Ctri+Left

Alt+Ctrl+Right
G

D

F

E or Home

Play and stop

Fast reverse (hit multiple times for
faster playback)

Halt playback

Fast forward (hit multiple times for
faster playback)

Step forward 1 frame
Step back 1 frame

Mark in

Mark out

Trim in point by -1 frame
Trim in point by +1 frame
Trim out point by -1 frame
Trim out point by +1 frame

Rolling trim out point by -1 frame
(trims following clip too)

Rolling trim out point by +1 frame
Clear mark in and mark out

Go to mark in (in trimmer tool)
Go to mark out (in trimmer tool)
Go to start
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R or End

Left

Right

Delete

Insert

Page up

Page down
Numeric pad +
Numeric pad -
C

V

M

Ctrl+Page up
Ctrl+Page down

Title Editor

Alt+Plus
Alt+Minus
Ctrl+Plus
Ctrl+Minus
Ctrl+0
Ctrl+1
Ctrl+2
Ctrl+3
Ctrl+4
Ctrl+5
Ctrl+6
Ctrl+7
Ctrl+8
Ctrl+9
Ctrl+K
Ctrl+M
Shift+Left
Shift+Right

Go to end

Select previous clip

Select next clip

Delete selected clip(s)

Split clip at scrubber position

Go to next page in Movie Window
Go to previous page in Movie Window
Zoom in the Timeline

Zoom out the Timeline

Set menu chapter

Clear menu chapter

Set return to menu

Go to previous menu chapter

Go to next menu chapter

Bring to front

Send to back

Bring forward one layer

Send back one layer

Text justification off

Text justification: bottom left
Text justification: bottom center
Text justification: bottom right
Text justification: middle left
Text justification: middle center
Text justification: middle right
Text justification: top left

Text justification: top center
Text justification: top right
Kern, leading and skew

Move, scale and rotate

Expand character selection left
Expand character selection right
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Ctrl+Left

Ctrl+Right

Ctrl+Down

Ctrl+Up

Shift+Ctrl+Left
Shift+Ctrl+Right
Shift+Ctrl+Down
Shift+Ctrl+Up
Alt+Left

Alt+Right

Shift+Alt+Left
Shift+Alt+Right

Reduce horizontal scale of, or
squeeze (kern), text selection
depending on current edit mode
(move/scale/rotate or
kern/skew/leading)

Increase horizontal scale of, or stretch
(kern), text selection

Reduce scale or leading of text
selection depending on current edit
mode

Increase scale or leading of text
selection

Same as Ctrl+Left (coarse)
Same as Ctrl+Right (coarse)
Same as Ctrl+Down (coarse)
Same as Ctrl+Up (coarse)

In text selection: Move characters
left. No selection: Move left all text
from cursor to end of line.

In text selection: Move characters
right. No selection: Move right all
text from cursor to end of line.

Same as Alt+Left (coarse)
Same as Alt+Right (coarse)
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2
2D editor (video effect), 144

A

AJ/B editing, 153
Abbreviations, xiv
Activate
Explained, 13
Album
Aspect ratio, 85
Clipboard operations, 82
Disc Menus section, 59, 196
Drag-and-drop editing, 82
Filled during capture, 19
Image sections, 180
Interface features, 43
Introduced, 19
Menu usage, 43
Music section, 62
Overview, 37
Previewing, 5, 39
Selecting video scenes, 49
Sound Effects section, 61
Source folders, 39
Still Images section, 59
Themes section, 57, 112, 113, 114
Title Editor. See Title Editor
Album
Titles section, 58

Index

Index

Transitions section, 55, 169
Video Scenes section, 41, 81
Album menu
Combine Scenes, 52
Comment view, 51
Details view, 50
Find Scene in Project, 43, 88
Icon view, 50
Scene detection commands, 55
Select By Name, 51
Set Thumbnail, 46
Subdivide Scenes, 53
Thumbnail view, 51
Alpha Magic transitions, 171
Analog
Capture quality options, 31
Levels during capture, 31
Outputting to, 278
Anatomy of a theme, 118
Animated pan-and-zoom, 185
Animation, 320
With themes, 111
Answer IDs (technical support),
324
Aspect ratios (frame formats), 24,
47
Capture option, 285
Mixing, 84
Audio
Adjusting on Timeline, 245
Background music, 232
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Insert editing, 102
Muting, 70
Original, 232
Overlay, 152
Overlay, original, 232
Scrubbing, 64
Settings (for File output), 307
Sound effects, 232
Surround, 248
Synchronized with video, 98
Synchronous, 68, 174, 232
Tracks on Timeline, 232
Transitions, 174, 247
Uses of, 229
Using in Studio, 230
Using without video, 83
Voice-overs, 232
Volume and mixing, 242, 248
Audio clips, 67
Interface details, 243
Trimming, 240
Audio compression, 307
Audio effects, 255
Applied to theme clips, 118
ChannelTool, 258
Chorus, 258
DeEsser, 259
Equalizer, 259
Grungelizer, 260
Icons, 255
In Studio Plus, 258
Leveler, 260
Noise reduction, 256
Reverb, 261
Standard vs. Plus, 256
Stereo Echo, 261
Stereo Spread, 262
Tool, 255
Unlocking, 127
Audio levels
Changing during capture, 20
In analog capture, 32
In DV capture, 30
Audio scrubbing button, 64
Audio toolbox, 78
Audio track
Linked to video track, 100
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Audio tracks, 233

Auto color correction (video
effect), 138

Automatic scene detection. See
Scene detection

AVCHD
Output movie to, 266
AVI files, 61
B
Background

In Title Editor, 223
Background music, 66, 67

CD, 234

Formats, 232

ScoreFitter, 235

Tool, 79, 235
Background rendering, 84

Enabling and disabling, 174

Of Hollywood FX, 174

Of moving menu thumbnails, 205

Of video effects, 135
Backgrounds section

Of Title Editor Album, 223
Balance

Adjusting on Timeline, 246
Balance and volume, 79, 242
Black and white (video effect),

146

Blur (video effect), 141
Blu-ray

Output movie to, 266
Buttons

Add Marker, 71

Audio scrubbing, 64

Chapter. See Disc menus

Clip, 64

Clip delete, 65

Clip marker, 64

Clip split, 64

Delete Marker, 71

DVD toggle, 5

Edit menu, 77

Highlighting, 227
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Mode, 2

Playback, 8

Razorblade, 97

Reset (pan-and-zoom), 184

Split clip, 97, 101

Split clip/scene, 64

Start/stop capture, 21

Tool selector, 75

Toolbox, 74

Track-locking, 99

Undo, Redo, Help, Support and

Activate, 2

View selection, 64
Buttons section

Of Title Editor Album, 226

C

Camcorder Controller, 19, 20, 22,
190
Capture, 17
Analog quality options, 31
And the Album, 19
Audio and video levels, 31
Change directory, 21
Device selection, 24
Devices, 284
Digital vs. analog, 20
Directory, 21
Drive-speed, 29
Format options, 287
From analog sources, 30
From DV, 28, 30
From DVD, 33
From HDV, 30
Hardware, 23
MPEG options, 290
Preparing hard drive, 317
Scene detection, 26
Source options, 284
Sources, 23
Step-by-step, 24
To multiple files, 83
Capture mode
Interface, 18
Introduced, 1

Index

Capture settings, 20
Captured video
Folders, 44
Opening file, 44
CD audio clips
Properties of, 241
CD audio tool, 79, 234
ChannelTool (audio effect), 258
Chapter links. See Links
Chapters
On menu track, 200
Chorus (audio effect), 258
Chroma key
Background cloth for, 166
Tips, 165
Tool, 160
Video effect, 164
Clip markers, 71
Adding, deleting, naming, 71
Controls, 73
Clip properties
Duration, 182
Name, 182
Clip properties tool, 71, 76, 78
For audio clips, 240
For disc menus, 202
For still images, 182
For transitions, 177
For video clips, 95
Trimming with, 94, 177
Clipboard
With Album and Movie Window,
82
Clips
Audio, 67
Changing name, 94
Combining, 98
Deleting, 65
Splitting, 64, 97
Theme, 113, 115, 117
Trimming on the Timeline, 89
Trimming tips, 93
Video, 67
Close-ups, 351
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Color correction (video effect),
147
Color effects
White balance, 149
Color map (video effect), 147
Colors
Selecting, 167
Combine Clips menu command,
98
Compression
Audio, 307
Video, 305, 306
Configuration. See Options
Content
Importing, 14
Continuity (videography tip), 353
Controls
Clip marker, 64
Conventions, xiv
Counter, 10
Cross fade
In audio, 174
Cut (transition), 171
Cuts
Associative, 355
Cause and effect, 356
Contrast, 355
Formal, 356
Parallel, 355
Substitutionary, 356
Tempo of (videography tip), 353

D

DeEsser (audio effect), 259
Delete clip button, 65
Deleting clips, 65
Deleting scenes, 65
Devices
Capture, 24, 284
Dialog boxes
Main Options, 283
Make Movie Options, 283
Options, 283
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DirectX, xii
Disc
Image on hard drive, 265
MPEG encoding, 28
Previewing, 198
Saving movie to, 265
Disc chapter command, 198
Disc menu tool, 77, 207
Disc menus, 193
Automatic link creation, 197
Button captions, 197
Chapter editing, 206
Creating, 209
Described, 193
Editing, 209
Editing links, 202
Editing on Timeline, 200
Link numbers during editing, 203
Loop during playback, 194
Menus vs. titles, 196
Motion backgrounds, 224
Motion Thumbnails option, 205
Name and duration, 202
Obtaining, 60
Opening in Title Editor, 202
Placing on Timeline, 197
Sample movie layout, 194
Section (of Album), 59, 196
Setting thumbnail, 205
Supplied, 196
VCD, S-VCD limitations, 197
Discs
Authoring, 1, 38, 59, 179, 195,
226, 242
Diskometer, 19, 20
Dissolve (transition), 172
Drag-and-drop
Editing, 82
From Album, 82, 169
Setting menu links, 206
Drive space
For DV capture, 29
Drive speed
For video capture, 29
Drop zones
Adding effects, 124
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Aligning subclips, 123
Clearing, 123
Muting, 123

Durations (of transitions etc.), 292

DV, xiv
Capturing, 28, 30
Outputting to, 277
Storage calculation, 29
DVD
Image on hard drive, 265
Importing video from, 33
Menus, 59, See Disc menus
MPEG encoding, 28
Output movie to, 266
Playback controls, 5, 10, 195
Player control, 198
Previewing, 198

E

Earthquake (video effect), 144
Edit

Video clips, 81
Edit line

Clips inserted at, 82
Edit menu button, 77
Edit mode

Interface, 4

Introduced, 1
Edit Theme command, 114
Editing, 350

A/B, 153

Advanced, 69, 151

Disc menus, 200

Insert, 100

Split, 102

Still images, 181
Editing photos and other images,

183

Editor, Menu and Title, 209
Effects

Audio. See Audio effects

Video. See Video effects
Emboss (video effect), 142
Equalizer (audio effect), 259

Index

Equipment requirements, Xii
External devices
Importing media from, 34

F

Fade
Adjusting balance on Timeline,
246
Fade (transition), 172
Fades
Default duration of, 292
File
Saving movie to, 270
File name
Project, 64
File type
3GP, 271
AVI, 272
DivX, 273
Flash Video, 274
iPod compatible, 274
MP2, 272
MP3, 272
MPEG, 275
Real Media, 276
Sony PSP compatible, 276
WAV, 272
Windows Media, 277
File types
AVI, 61
Image, 59
MP3, 61
Music, 62
Sound, 61
WAV, 61
Find Scene in Album command,
43
Find Scene in Project command,
43
Flags
Placing on menu track, 201
Folders
Music, 62
Still images, 59
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Titles, 58
Fonts, 220
Frame formats. See Aspect ratios
Frame grabber, 189
Tool, 77, 180
Tool, described, 189
With HDV, 190
Full-screen images
Described, 180

G

Glossary, 359
GOP
Closed, 362
Size, 366
Grab frames tool
Described, 189
Graphics
Editing, 183
Groups
Temporary, In Title Editor, 218
Grungelizer (audio effect), 260

H

Hard drive
Preparing for capture, 317
Space for video capture, 29
Speed for video capture, 29
Hardware
Capture, 23
HD, 366
HD DVD
Output movie to, 266
HDV, xv, 367
Capturing, 30
Help button, 2
Highlighting
Of menu buttons, 227
Hollywood FX
And background rendering, 174
Editing, 173, 177
Previewing, 174
Transitions, 171, 173
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Icons for effects

Audio, 255

Video, 88
IEEE-1394, xv

Cable, 277
Images. See Still images
Import

From external devices, 34
Importing content from past

versions, 14
Importing media from external
devices, 34

Importing video from DVD, 33
Insert edit

A/B, 153
Insert editing, 100

Audio, 102

Introduced, 100

Method, 100
Internet

Saving movie to, 279
Invert, 147

J-cut
A/B, 154
Defined, 102
Explained, 105
Jog buttons, 9

K

Ken Burns, 183

Keyboard conventions, xv

Keyframing (of video effects
parameters), 130, 133

Knowledge base, 322

L

Layers
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In Title Editor, 213
L-cut
A/B, 154
Defined, 102
Explained, 102
Lens flare (video effect), 144
Letterboxing, 85
Leveler (audio effect), 260
Levels, Audio and video
In analog capture, 31
In DV capture, 30
Lighting, 148
Links
Adjusting, 201
Automatic creation of, 197
Creating, 201
Deleting, 202
Editing, 202
In disc menu tool, 206
On disc menus, 193
Repositioning, 202
Return to menu, 201
Setting with drag-and-drop, 206
Show numbers while editing, 203
Locked content
Activating, 11
Locking tracks, 70
Indication of, 99
Long shots (videography tip), 351
Luma key (video effect), 143

M

Magnify (video effect), 145
Make Movie mode, 263
Introduced, 1
Making movies, 263
Markers. See Clip markers
Media Player, 277
Menu and Title Editor, 209
Menu buttons
Highlighting, 227
Menu commands, xv
Menu Editor. See Title Editor
Menu links. See Links

Index

Menu track, 200
Editing, 201
Flags, 200
Menus, Disc. See Disc menus
Microphone
Connecting, 239
Modes
Capture, 18
Edit, 4
Introduced, 1
Make Movie, 263
Setting, 2
Monitors
Dual, 294
Montage. See Themes
Motion blur (video effect), 145
Movie
Previewing, 5
Movie Window, 63
Clipboard operations, 82
Drag-and-drop editing, 82
Find scene in Album, 43, 88
Interface features, 87
Positioning, 66
Status message area, 64
Trimming on the Timeline, 89
Views, 67
MP2 files, 272
MP3 files, 61, 272
MPEG
Capture options, 290
Captures from DV, 29
Encoding of DV captures, 28
For DVD etc., 28, 29
Quality options, 29
Rendering for output, 265
Multiple capture files
Using, 83
Multiple selection
In Title Editor, 218
Multitrack editing, 151
With themes, 111
Music, 229, See Background
music
Folder, 62
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Section (of Album), 62

Selecting (videography tip), 357
Music video. See SmartMovie
Muting audio tracks, 70

N

Names
In Text and Storyboard view, 94
Of clips - changing, 94
Noise reduction (audio effect), 256
Noise reduction (video effect), 139
NTSC, 285

O
Obijects
In Title Editor, 212
Obtaining

Disc menus, 60

Sound effects, 61

Themes, 57

Transitions, 56
Old film (video effect), 142
Optical disc. See Disc

Image on hard drive, 265
Optical disc summary, 269
Options, 283

Aspect ratio for analog capture,

285

Audio for file output, 307

Capture devices, 284

Capture format, 287

Capture source, 284

Data rate and quality, 307

Frame rate, 306

Include audio, 307

Include video, 305

List all codecs, 305

Main dialog, 283

Make audio file, 304

Make AVI file, 304

Make Disc, 299

Make Movie, 283

Make MPEG file, 304

Make Real Media file, 308
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Make tape, 313

Make Windows Media file, 311

MPEG capture, 290

Organization of, 283

Output to VGA display, 315

Preview during capture, 285

Project preferences, 290

Scene detection, 285

Setting, 3

TV standard, 285

VCR input checkbox, 285

Video and audio preferences, 294

Video compression, 306

Video for file output, 305

Video preview, 294
Original audio

Properties, 241

Synchronized with video, 98
Original sounds

Preserving (videography tip), 357
Other devices

Importing media from, 34
Output

Audio only, 272

Browser, 263

Media type, 263

To 3GP file, 271

To AVl file, 272

To DivX file, 273

To file, 270

To Flash Video file, 274

To iPod compatible file, 274

To MPEG file, 275

To optical disc, 265

To Real Media file, 276

To Sony PSP compatible file, 276

To Tape, 277

To videotape, 279

To Windows Media, 277

To world-wide web, 279
Overlay effects, 151
Overlay images

Described, 180
Overlay track, 151

Always show option, 152

Audio, 232

Audio, original, 152
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Displaying, hiding, 152

Introduced, 151

Opening, 151
Overlays track

And still images, 179

P

PAL, 285
Pan and scan, 85
Pan and zoom
Video effect, 188
Pan-and-zoom
Animated, 185
Complex animations, 186
Photos, 184
Tool, 183
Parameters for effects
Resetting, 129
Parameters for plug-in effects
Presets, 129
Parameters for video effects
Editing, 128
Passport, 13
Perspectives
Varying, 350
Photos
Editing, 183
Panning and zooming, 184
Red-eye reduction, 184
Rotating, 184
Picture-in-picture
Tool, 154
Video effect, 159
Playback controls, 5
DVD, 5, 10, 195
Fast forward/reverse, 8
Go to beginning, 8
Jog buttons, 9
Loop, 9
Play/Pause, 8
Standard, 5, 8
Playback speed
Changing, 140
Player, 19

Index

During Timeline trimming, 89

Introduced, 5

Previewing transitions, 56, 174

Scrubber, 9
Player control

DVD, 198
Plug-in effects

Unlocking, 127, 137
Plus audio effects pack, 258
Plus RTFX video effects pack, 140
Posterize (video effect), 148
Premium button, 2
Premium content and features, 14
Presets for effects, 129
Preview

During capture, 285
Preview window, 5, 92
Preview Window, 6
Previewing

Discs, 198

Hollywood FX, 174

Menus, 5

Transitions, 56, 174

Video effects, 135
Problems and solutions, 321
Product names, xiv
Progressive encoding (advanced

output setting), 301
Project. See Movie
Project preferences (options
panel), 290

Project video format, 84
Push (transition), 172

R
Razorblade button, 64
Real Media
Files, 276

RealNetworks® RealPlayer®, 276
RealNetworks® RealPlayer®
Viewing files with, 271
Recording voice-overs, 237
Quality, 239
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Red-eye reduction

Explained, 184

Removing, 185
Redo button, 2
Rendering, 265
Reordering objects

In three dimensions, 213
Requirements, equipment, Xii
Return to menu link, 201
Reverb (audio effect), 261
RGB color balance (video effect),

148

Ripple transition, 175, 181, 196
Rotate (video effect), 145

S

Save to disc, 265
Save to file, 270
3GP, 271
Audio only, 272
AVI, 272
DixX, 273
Flash Video, 274
iPod compatible, 274
MPEG, 275
Real Media, 276
Sony PSP compatible, 276
Soundtrack, 272
Windows Media, 277
Save to tape, 277
Save to world-wide web, 279
Scanning, progressive Vvs.
interlaced, 301
Scene detection, 26, 46
Menu commands, 55
Options, 285
Scenes. See Video scenes
Scenes (videography tip), 354
ScoreFitter
Clip properties, 242
Duration of clips, 240
Scrubber, 9
Scrubbing audio, 64
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SCSil, xiii
SECAM, 285
Sepia (video effect), 149
Set Thumbnail menu command, 46
Settings. See Options
Setup menu, 3
Setup options, 283
Slide (transition), 172
Slideshow, 175, 181, 196
Slow motion, 140
Soften (video effect), 143
Sound effects, 67, 229
Obtaining, 61
Properties, 241
Section (of Album), 61
Sound files, 61
Speed (video effect), 140
Split Clip menu command, 97
Split clip/scene button, 64, 97
In insert editing, 101
Split edit
A/B, 154
Split editing
Introduced, 102
Splitting clips, 97
Restoring from, 97
Stabilize (video effect), 139
Stained glass (video effect), 143
Start/stop capture button, 21
Stereo
Adjusting balance on Timeline,
246
Stereo Echo (audio effect), 261
Stereo Spread (audio effect), 262
Still images
Creating, 180
Default duration of, 292
Described, 179
Editing, 183
Folder, 59
Full-screen, 180
Full-screen vs. overlay, 179
Overlay, 180
Section (of Album), 59
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Trimming, 182
Trimming and editing, 181
Types, 179
Still Images
Rotating, 184
Storyboard view, 67
Studio Plus, 151
Audio effects, 256, 258
Keyframing, 130, 133
Video effects, 140
Subclips
Adding effects, 124
Aligning to drop zone, 123
Exporting to Movie Window, 123
Muting, 123
Support button, 2
Surround sound, 248
S-VCD
Menus, 59, See Disc menus
MPEG encoding, 28
Output movie to, 266
Synchronization (of video and
audio)
Overriding, 98

T

Tape

Saving movie to, 277
Technical support, 322
Templates. See Themes
Text editing

Advanced, 215
Text view, 67, 74, 94
Theme clips

Creating, 115

Insert vs. replace, 115

Track selection, 115

Transitions and effects, 118

Trimming and editing, 117
Theme Editor

Mini-Album, 114
Theme Editor tool, 76, 121
Themes

Adding to movie, 113

Index

Anatomy, 118
Clips. See Theme clips
Customizing, 112
Drop zones, 123
Introduced, 111
Obtaining, 57
Section (of Album), 57, 113, 114
Subclips, 123
Templates, 111, 113, 114, 118,
122
Thumbnail frames
In Album, 46
Setting in disc menus, 205
With moving video, in menus, 205
Timeline
Adjusting volume on, 245
Audio tracks, 232
Editing disc menus on, 200
Locking tracks, 99
Overlay video, 151
Placing disc menus on, 197
Tracks, 67
Trimming clips on, 89
Timeline view, 67
Advanced editing in, 98
Insert editing, 100
Splitting clips in, 97
Timescale, 67
Title
Choosing (videography tip), 357
Colors (videography tip), 358
Title Editor, 209
Advanced text editing, 215
Introduced, 75
Launching, 210
Multiple selection in, 218
Title Editor Album, 221
Backgrounds section, 223
Buttons section, 226
Looks Browser, 221
Pictures section, 225
Title Editor controls
Clipboard and delete buttons, 219
Mode selection buttons, 215
Object layout buttons, 217
Object toolbox, 212
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Selection tool, 212
Text styling, 219
Title-type buttons, 211
Title Editor objects, 212
Reordering layers, 213
Text, 214
Title track
Locking, 99
Titles
Crawls, 211
Creating, 209
Editing, 209
Folder, 58
Rolls, 211
Section (of Album), 58
Titles and overlays track
And still images, 179
Titles tool, 77
Toolbox, 63
Audio, 78
Video, 76
Toolboxes, 74
Tools
Audio effects, 80, 255
Automatic background music, 79
Background music, 235
CD audio, 79, 234
Chroma key, 160
Clip properties, 71, 76, 78, 94,
202, 240
Disc menu, 77, 207
Frame grabber, 77
Pan-and-zoom, 183
Picture-in-picture, 154
PIP and chroma key, 77
SmartMovie, 77, 106
Theme Editor, 76, 114, 121, 122
Titles, 77
Video effects, 78, 125
Voice-overs, 79, 237
Volume and balance, 79, 242, 248
Track lock buttons, 99
Tracks
Audio, 232, 233
Background music, 232
Indication when locked, 99
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Locking, 70
Menu, 200
Muting and hiding, 70
Original audio, 232
Overlay, 151
Sound effect and voice-over, 232
Title, 99
Video, 69, 98
Video linked to audio, 100
Transitions
Adding to movie, 169
Alpha Magic, 171
Criteria for selecting, 171
Cut, 171
Default duration of, 292
Described, 169
Displaying type, 56
Dissolve, 172
Effect on clip duration, 170
Fade, 172
Groups, 55
Hollywood FX, 171, 173
In audio, 174
Looping in preview, 178
Naming, 177
Obtaining, 56
On audio tracks, 247
On theme clips, 118
On Timeline, 169
Previewing, 56, 174, 178
Reversing direction, 177
Ripple transition, 175, 181, 196
Section (of Album), 55
Setting duration of, 177
Standard (2D), 171
Three-dimensional, 173
Trimming, 176
Types of, 171
Videography tip, 351
Wipe, slide, push, 172
Transport controls
On-screen, 20, 22
Trashcan button, 65
Trim scrubber, 71
Trimming
Audio clips, 240
Described, 89
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Introduced, 81

On the Timeline, 89

Still images, 181, 182

Tips, 93

Transitions, 176

Undoing, 96

Video clips, 89

With Ctrl key, 92
Troubleshooting, 321
TV set

Simultaneous output to, 278

U

UDMA, xiii

Undo button, 2

Unlocking
Plug-in effects, 127, 137
Premium content, 11

USB video camera
Capturing from, 30

Use keyframes (checkbox), 133

\

VCD
Menus, 59, See Disc menus
MPEG encoding, 28
Output movie to, 266
VGA
Output movie to, 315
Video
Aspect ratios. See Aspect ratios
Capture. See Capture
Frame format. See Aspect ratios
Hiding, 70
Options, 32
Output hardware, xiv
Settings (for File output), 305
Video and audio preferences
(options panel), 294
Video capture
Step-by-step, 24
Video clips, 67
Applying effects to, 125

Index

Changing name, 94

Changing playback speed, 140
Combining, 98

Editing, 81

Finding Album scene, 88
Interface features, 87
Properties tool, 95

Shortened by transition, 170
Splitting, 97

Synchronization with audio, 98
Trimming, 89

Trimming on the Timeline, 89
Trimming tips, 93

Undoing trim, 96

Using audio portion only, 83

Video compression, 305
Video effects, 125

2D editor, 144

Adding, 137

Adding and deleting, 126
Applied to theme clips, 118
Auto color correction, 138
Basic, 136

Black and white, 146
Blur, 141

Changing parameters, 128
Chroma key, 164
Cleaning effects, 138
Color correction, 147
Color map, 147
Earthquake, 144

Emboss, 142

Icons, 88

Invert, 147

Keyframing, 130, 133
Lens flare, 144

Lighting, 148

Luma key, 143

Magnify, 145

Motion blur, 145

Noise reduction, 139

Old film, 142

Pan and zoom, 188
Picture-in-picture, 159
Plus RTFX, 140
Posterize, 148

Presets, 129
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Previewing and rendering, 135
RGB color balance, 148
Rotate, 145
Sepia, 149
Soften, 143
Speed, 140
Stabilize, 139
Stained glass, 143
Standard, 138
The effects list, 126
Tool, 125
Unlocking, 127
Water drop, 146
Water wave, 146
Video formats, 84
Video levels
Changing during capture, 20
In analog capture, 32
In DV capture, 30
Video monitor
Simultaneous output to, 278
Video preview
External, 294
Full-screen, 294
Options, 294
Video scene catalog, 195
Video scenes
Adding to movie, 81, 82
Album interface features, 43
Combining and subdividing, 52
Comments, 51
Displaying length of, 50
Finding in Album, 43
Folders, 44
In-use indicator, 43, 87
Neighboring, 88
Order of, 41
Redetecting, 54
Section (of Album), 41
Selecting, 49
Splitting, 64
Thumbnail frames, 46
Viewing, 48
Video Scenes section
Views, 51
Video toolbox, 76
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Video track, 69, 83, 98
And still images, 179
Linked to audio track, 100
Videography, 349
Videotape
Output to, 279
Views, Movie Window
Storyboard, 67
Text, 67, 74
Timeline, 67
Voice-over tool, 237
Voice-overs, 67
Properties, 241
Recording, 237
Recording quality options, 239
Volume, 238
Voice-overs tool, 79
Volume
Adjusting on Timeline, 245
Fades, Default duration of, 292
Mixing, 242, 248
Voice-over levels, 238
Volume and balance tool, 79, 242,
248

W

Water drop (video effect), 146
Water wave (video effect), 146
WAV files, 61, 272
Web
Saving movie to, 279
White balance, 149
Windows Media
Files, 277
Player, 277
Windows Media Player
Viewing files with, 271
Wipe (transition), 172

Y

Yahoo! Video, 279
YouTube, 279

Pinnacle Studio





